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INTRODUCING MAGNIFI 5 

The EctaneTM instrument is operated by Magnifi, a powerful and easy-to-use acquisition and analysis 

software. It is designed for a wide range of nondestructive testing techniques dedicated to tubing and 

surface inspections and relies on intuitive wizards to configure setups. 

Magnifi has a graphical user interface (GUI) designed to simplify the inspection process and enhance your 

experience. Through the GUI, all the functions associated to inspection project management, the global 

settings, and the preferences are in what is referred to as the backstage view. All inspection work, 

calibration, acquisition, and analysis is in what is referred to as the front stage view. This is how Magnifi 

offers a streamlined and coherent interface that makes the learning process easy.  

 

BACKSTAGE OVERVIEW 

At the opening of Magnifi, the backstage view is displayed. It is composed of nine sections that supply 

different information.  

The default section and first section of the backstage view is the General section, which contains 

information about: 

• Probe currently connected to Ectane 

• Selected project and inspection folders 

• Currently loaded setup and data 
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This is also where you: 

• Create or open a project folder 

• Create, open or transfer an inspection sub-folder 

• Create or open a setup 

• Open data 

• Select the file naming format 

• Create or import a list of file names 

• Choose the report table profile and automatic screen capture option 

• Generate a report or export the defect table 

Under many circumstances, this is the only section that is needed to manage inspection projects. 

Other sections of the backstage are described below. 

 

FRONT STAGE OVERVIEW 

The front stage displays all the information about your current inspection. This is where you will find all 

the tools to acquire, save and analyze inspection data. 

Continue reading the following sections of the document for additional information on the available tools 

and functions. 

 

 

1. Backstage icon  7. Information 
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Click to access to backstage view. 

2. Quick access toolbar 

Customizable toolbar to provide access to 

the commands you use the most often. 

3. Ribbon-style menus 

These nine menus allow you to perform 

several inspection operations. 

4. Status icons 

These icons convey unit status 

information graphically. 

5. Data display area 

This area is where you will see the 

inspection data. 

6. File navigator 

Use the file navigator to open and display 

files in the data area. An alternative 

method would be to use the data tab 

(see 10). 

 

This area displays information about 

cursor position, measurements and 

acquisition parameters. 

8. Keyboard arrow mode selector  

Click to change the operational mode of 

the keyboard arrows. 

9. Information tabs  

Click on the tabs to display information, 

documentation, or report content. 

10. Notifications 

Click on the tabs to display the 

notifications.  

11. Data tabs 

Click on the tabs to display the list of 

data, DQV tool, Screening tool and 

notes.Views 

 

 

Views vary according to the type of probe or technology you are using. You can select layouts or set one 

up yourself. This section introduces the various elements of available views. 

Note that some elements of a view are automatically removed when the view is resized smaller. To display 

all the elements of a view, increase its size until they reappear. 
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STRIP CHART VIEW 

 

1. Link button 

Views with the same number are linked. 

Changing the channel/C-scan or 

frequency of a linked view also modifies 

all the other linked views. 

2. Global channel/C-scan selector 

Regroups the channel/C-scan and 

frequency selectors in a single button. 

3. Channel/C-scan group name selector 

4. Frequency selector 

5. Scale 

6. Signal component selector 

Vertical arrow for the vertical component 

of the Lissajous or horizontal arrow for 

the horizontal component of the 

Lissajous. 

7. Data area 

8. Cursor 

Only the data within the dashed cursors 

are displayed in a Lissajous.  

9. Information 

Operating frequency. 
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LISSAJOUS VIEW 

 

 

1. Link button 

Views with the same number are linked. Changing the channel/C-scan or frequency of a linked 

view also modifies all the other linked views. 

2. Global channel/C-scan selector 

Regroups the channel/C-scan and frequency selectors in a single button. 

3. Channel/C-scan group name selector 

4. Frequency selector 

5. Rotate 

Warning: Displayed number corresponds to the Lissajous’ rotation, not the signal’s phase angle 

measurement. 

6. Scale 

7. Data area 

Displays data located inside the cursor of the corresponding strip chart or C-scan. 

8. Sizing measurement 

Measurements available only when a sizing curve corresponding to the displayed channel has 

been created and calibrated. 

9. Report/Indication codes 

Click to add an indication corresponding to the selected code in the report. Long click to edit. 

10. Mini Strip Chart area 
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Displays two strip charts: Vertical (left) and horizontal (right) components of the Lissajous. When 

mini strip charts are used, data displayed in the Lissajous corresponds to the data within the 

mini cursors identified with blue dashed lines. 

11. Manual measurement 

Use the mouse to manually trace a measurement vector in the Lissajous. 

12. Two-points measurement 

Activates two additional cursors in the strip chart. The measurement vector in the Lissajous is 

based on the data located at the position of the two cursors. 

13. Invert phase angle measurement 

Invert the direction (± 180˚) of the measurement vector in the Lissajous.  

14. Phase angle measurement mode 

Phase measurement illustrated by the red dashed line. Automatic adjustment based on the 

measurement mode used. 

15. Amplitude measurement mode 

Amplitude measurement illustrated by the blue vector. Automatic adjustment based on the 

measurement mode used. 

16. Signal measurement result 

Based on the measurement modes used. 

17. Cursor position circle 

Red circle over data point corresponding to location of cursor in strip chart or C-scan. 

18. Null mark 

Center of the Lissajous where the two blue lines intersect. Corresponds to 0 V for both the 

horizontal and vertical axes. 

19. Information 

Operating frequency or array probe’s channel corresponding to cursor’s position on C-scan. 
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VOLTAGE PLANE VIEW 

 

 

1. Link button 

Views with the same number are linked. Changing the channel/C-scan or frequency of a linked 

view also modifies all the other linked views. 

2. Global channel/C-scan selector 

Regroups the channel/C-scan and frequency selectors in a single button. 

3. Channel/C-scan group name selector 

4. Frequency selector 

5. Scale 

6. Data area 

Displays data located inside the cursor of the corresponding strip chart. 

7. Cursor position circle 

Red circle over data point corresponding to location of cursor in strip chart or C-scan. 

8. Sizing measurement 

Measurements available only when a sizing curve corresponding to the displayed channel has 

been created and calibrated. 

9. Report/Indication codes 

Click to add an indication corresponding to the selected code in the report. Long click to edit. 

10. Mini Strip Chart area 
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Displays two strip charts: Vertical (left) and horizontal (right) components of the Lissajous. When 

mini strip charts are used, data displayed in the Lissajous corresponds to the data within the 

mini cursors identified with blue dashed lines. 

11. Save nominal 

Saves the current adjustment to the nominal value. 

12. Back to nominal 

Returns the signal back to the nominal point previously stored using the button “Save nominal”. 

13. Normalize signal 

Normalizes the displayed signal. Brings the cursor position circle data point to the (1,0) position. 

14. Manual measurement 

Use the mouse to manually trace a measurement vector in the Lissajous. 

15. Invert phase angle measurement 

Invert the direction (± 180˚) of the measurement vector in the Lissajous.  

16. Phase angle measurement mode 

Phase measurement illustrated by the red dashed line. Automatic adjustment based on the 

measurement mode used. 

17. Amplitude measurement mode 

Amplitude measurement illustrated by the blue vector. Automatic adjustment based on the 

measurement mode used. 

18. Signal measurement result + Circumferential extent of the indication 

Signal measurement result based on the measurement modes used. Circumferential extent 

based on flaw coverage curves (see 22). 

19. Angle correction 

Displayed with red font if angle correction is outside of accepted tolerance. 

20. Null mark 

Center of the Lissajous where the two blue lines intersect. Corresponds to 0 V for both the 

horizontal and vertical axes. 

21. Theoretical nominal point 

Corresponds to the intersecting point of the flaw coverage curves. 

22. Flaw coverage curves 

From bottom to top: 90˚, 180˚, 270˚ and 360˚. 

23. Information 

Operating frequency. 
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CODE VIEW 

 

1. Header 

No channel/C-scan/frequency selector in the header of a code view. It regroups together 

information coming from all the channels. Position of indications in the code view are directly 

related to positions in strip charts. 

2. Saturation 

Red background in the code view indicating that signal is saturated. Often happens when the 

probe gets in the air. 

3. Reported indications 

Position and width of the marks corresponding to position and width of the cursor when 

indications were added. Clicking on an indication in the code view automatically moves and 

resizes the cursor to match this indication. 

4. Detected indications 

Position and width of the marks corresponding to position and width of the detected 

indications. Clicking on an indication in the code view automatically moves and resizes the 

cursor to match this indication. 

5. Landmarks 

Blue triangles pointing at the position of the landmarks. Landmarks don’t have a width. 
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INFO VIEW 

The Info view displays information using large and easy to read numbers. It can be customized to display 

information such as: 

• Cursor position on the X or Y axis, in samples or units; 

• Cursor width (Δ) along the X or Y axis, in samples or units; 

• Acquisition rate; 

• Maximum probe speed; 

• Measured crack’s depth and length (SharckTM probes only); 

• Etc. 

The outputs provided by an Info view can be different during acquisition and analysis.  

The view is automatically divided into the appropriate number of individual boxes to display all the 

selected information. 
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C-SCAN AND 3D C-SCAN VIEWS 

 

 

 

1. Link button 

Views with the same number are linked. Changing the channel/C-scan or frequency of a linked 

view also modifies all the other linked views. 

2. Global channel/C-scan selector 

Regroups the channel/C-scan and frequency selectors in a single button. 

3. Channel/C-scan group name selector 

4. Frequency selector 

5. Signal component selector 

Vertical arrow for the vertical component of the Lissajous or horizontal arrow for the horizontal 

component of the Lissajous. 

6. Color palette 

Double-click or go to current view ribbon to edit. 

7. Data area 

8. Cursor 

Only the data within the 2D C-scan cursor are displayed in a Lissajous and in the 3D C-scan.  
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9. 3D C-scan orientation 

Click on the vertical or horizontal arrows to change the orientation of the 3D C-Scan. 

A-SCAN UT 

 

1. A-scan data area 

2. General tab 

Regroups general information that can be modified by the user, such as the scan duration, the 

tension, the filters, etc. 

3. Gates tab 

Regroups information about the positions and dimensions of the gates. Also, contains fields to 

adjust the TCG. Fields can be modified by the user. 

4. Envelop 

Click to activate the persistence of the data on the screen. To clear the cumulated data from the 

screen, disable the envelop option. 

5. A-scan back wall 

Zooms on the front wall and back wall portions of the data to make it possible to adjust the back 

wall. 

6. Show/Hide A-scan UT view 

 

7. Back wall gate 

Blue outlined box. Use the mouse to adjust the position and dimensions. Alternatively, the gates 

tab can be used. 

8. Front wall gate 

Red outlined box. Use the mouse to adjust the position and dimensions. Alternatively, the gates 

tab can be used. 

9. Pin gate 

Back outlined box. Use the mouse to adjust the position and dimensions. Alternatively, the gates 

tab can be used. 

10. Gain 
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Identified by the yellow line. Flat portion is the static gain. Angled portion is the Time 

Compensated Gain (TCG). Use the mouse to adjust the position and dimensions. Alternatively, 

the tabs on the right can be used.  

PROJECTION 

 

1. C-scan view 

For additional information, see the previous section dedicated to the C-scan view. 

2. Infofields 

Customizable infofields providing information such as the wall thickness, the wall loss, etc. Fields 

can be added/removed. 

3. Scale 

4. Circumferential projection view 

5. Cursor’s brackets 

Automatically adjust to the wall thickness at the location of the cursor. Can be manually 

adjusted using the mouse if necessary. 

6. Nominal 

Yellow portion showing the nominal dimensions of the tube. 

7. Cylindrical projection view 

8. Report/Indication codes 

 

Click to add an indication corresponding to the selected code in the report. Long click to edit. 

9. Show/Hide A-scan UT view 

10. ID/OD 
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Identification of the OD and the ID of the tube in the Circumferential and Longitudinal projection 

views. 

11. Longitudinal projection view 
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BACKSTAGE DETAILS 

The intent of the following pages is to highlight several key features and important details about each 

section of the backstage in order to provide guidance and helpful information to the users of Magnifi 5. 

GENERAL SECTION 

 

 

PROJECT AND INSPECTION 

 

 

Magnifi offers a two-level folders structure to stay organized. The higher-level folder is called the Project. 

The second-level folder, or sub-folder, is called the Inspection. The Project folder simply regroups 

together Inspection sub-folders that are related in some ways. 
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For instance, a Project folder could be created for all the inspections to be performed during a refinery 

shutdown. Each Inspection sub-folder could focus on a specific asset or component of the refinery. All the 

files used and produced for a given Inspection are stored within the Inspection sub-folder.  

 

 

The Project folder and Inspection sub-folder buttons open windows allowing you to add new folders or 

browse and select existing ones.  

A Default Inspection sub-folder gets automatically created when the Project folder is selected. This 

Default Inspection sub-folder can’t be deleted or renamed. 

         

Figure 1 Project / Inspection management windows 

The Transfer Inspection button is available only when an external drive is connected to the computer. 

This button allows you to transfer Inspection folders with all their content between the local drive and 

the external drive. The Inspections are transferred to the Project folder selected with the drop-down 
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menu. In the figure below, clicking on Export would copy the local Inspection called New inspection in the 

Project called Project ABC located on the external drive. 

 

 

Note that the Project folders that are detected and displayed in the Project drop-down menus must be 

located at the following directories: 
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SETUP AND DATA 

 

 

A new setup can be created by clicking on the Create Setup button, which will guide the user through a 

step-by-step process that differs for each inspection technique. 

The Open Setup button is used to retrieve an existing setup from different locations such as the Master 

List (user-configured), the Default Master List (installed with the software, can’t be modified) or from the 

Inspection sub-folders contained in the current Project folder. Another option is to click on the Select 

Other… button to browse on your computer. 

 

 

The Open Data button allows you to load a data file from the current Inspection sub-folder. It is also 

possible to browse on your computer to load a data file in a different location. The location of the loaded 

file will become the current Inspection sub-folder. 
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DATA LIST 

 

 

Four options are available to configure the file naming format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for heat exchanger tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for heat exchanger tubing 

inspections. 

5. Custom:  

Allow you to create a custom file format with other properties than the ones presented above. A 

new property can be customized by choosing its name, by adding a default prefix or a suffix or 

by selecting is type (Number or Text). All the parameters that can be changed are shown in the 

following figure. 

 

 

For improved productivity, the names of the files to be acquired can be generated prior to the inspection 

by using the Create New List button. Several different lists can be added in the same Inspection. 
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A complete List can be imported from a different Inspection folder by clicking on the Import List button. 

Note that the complete List of files of an Inspection is automatically stored in a file called 

FolderDescription.xml, located in the Inspection folder. 

 

 

It is also possible to import a List created in the TubeProTM software, which is directly available from 

EddyfiTM. 
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REPORT 

 

 

A selection of several defect table profiles to be displayed in the report can be selected from the Table 

Profile drop-down menu. The information displayed in each profile is adapted to a specific inspection 

technique. 

Once the analysis of a data set is completed, the Generate Report button can be used to produce a report. 

A few report parameters can be configured, such as the # of tube in component, which is used to show 

the percentage of tubes in each category. Additional customization of the report’s header, such as the 

company logo, can be done through other sections of the backstage. Continue reading for more 

information. 

           

 

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 

 

 

From the Backstage, the Export Report button allows you to export only the defect table in several 

formats such as Tubepro or CSV. 

Take screenshot with report entry option captures an image of the front stage every time an indication 

is added to the report. The screenshots are visible in the Data tab of the front stage and can be appended 

to the report. 
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INFORMATION 

When the computer has been connected to the Ectane through the Magnifi interface, probes with a 

configured chip-ID can be recognized when connected to the instrument. In that condition, the probe 

model will be displayed. The software will send a warning if the loaded setup is not compatible with the 

connected probe. Note that the appropriate setup is not automatically loaded when the probe is 

connected, it must be manually loaded by the user. 

     

 

Also, the message Unable to detect could simply mean that the probe being used does not have a 

functional chip-ID, but it can still be used for inspection. 

 

 

START / RESUME 

Click on the Start / Resume button or the blue arrow icon at the top-left of the backstage to switch to 

the front stage view.  

     

  



34 

 

ACQUISITION SUMMARY SECTION 

This section of the backstage allows you to specify information related to the inspection and the inspected 

items such as the component type, the service company, the operator, the serial number of the probe 

used for inspection, etc. This information remains attached to the data files, even if they are separated 

from the original Inspection folder. Therefore, the Acquisition Summary should be filled in before data 

acquisition.  

Note that the information can be updated at any time during an inspection to reflect the real conditions 

in which the data were acquired. For instance, a change of operator would ask for a modification in the 

Acquisition Summary. Therefore, all the files acquired by the new operator would be tagged correctly. 

The Acquisition Summary is also saved with the setup file. 

Fields can be added, removed and customized. Additional information can also be typed in the Comment 

section. The bottom portion of this section (Filename, Setup, Date, Version) is filled automatically. 

Note that it is possible to import/export the Acquisition Summary with all the information it contains for 

improved productivity. 
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REPORT SUMMARY SECTION 

This other section of the backstage allows you to specify information that will appear in the header of the 

reports, such as the client, the work order, the procedure, etc.  

Fields can be added, removed and customized. The fields that are grayed are linked to the Acquisition 

Summary and will be filled if the corresponding fields are filled in the Acquisition Summary section. 

Additional information can also be typed in the Comment section. 

The Report Summary is saved with the setup file. 

Note that it is possible to import/export the Report Summary with all the information it contains for 

improved productivity. 
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SAVE SECTION 

The Save section of the backstage proposes a few different saving options for the data files and the setup 

files: 

1. Save Setup:  

Saves the currently used setup in the current Inspection folder. 

2. Save Setup as…:  

Saves a new copy of the currently used setup and allows you to specify its name and location. 

3. Save Setup as Read-Only…:  

Saves a new copy of the currently used setup and allows you to specify its name and location. 

The file can’t be overwritten. Attention, it remains possible to apply modifications to the setup 

while using it, however, the modifications can’t be saved. 

4. Copy Setup in Master List…:  

Add the currently used setup to the Master List for a quick access from any Inspection folder. 
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MATERIAL DATABASE SECTION 

The Material Database section shows a list of materials and their properties.  

Three properties are associated to each material. The resistivity and the permeability are used by Magnifi 

to calculate the theoretical inspection frequency of the electromagnetic techniques. The ultrasonic 

velocity is used to preset the gates’ locations when using IRIS. 
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DOCUMENTATION SECTION 

This section of the backstage allows you to open PDF documents. A list of documents is automatically 

added during the installation of Magnifi. Other documents such as codes, procedures or drawings can be 

added to the list by saving a copy at the following location on your computer:  
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SYSTEM PREFERENCES SECTION 

 

 

 

 

 

The System Preferences section contains several options that are related to the user’s computer, meaning 

that the configurations will remain the same, independently of the loaded setup file. 
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The Select Company Logo button allows you to define the logo to be displayed in the header of the report. 

The button lets you browse your computer to select an image with any of the following 

formats: .bmp, .png, .jpg, .jpeg. 

The list of default keyboard shortcuts available during acquisition and analysis can be visualized and 

managed by clicking on the Keyboard… button. To modify a shortcut, simply select the action in the list 

and press the desired key.  

 

To integrate the TubePro software with Magnifi, check the TubePro box at the bottom of the System 

Preferences section. 

GENERAL PREFERENCES SECTION 

The General Preferences section contains several options that are related to the setup, meaning that the 

configurations are stored with the setup when it is saved and are retrieved when the setup is loaded. 

Additional information regarding some of the available options: 

1. Hide Raw Channel:  

Only the processed channels appear in the list of available channels to be displayed in the front 

stage, facilitating the analysis if the raw channels are not relevant. 

2. Automatic File Recording:  

Data recording is initiated as soon as the acquisition starts. When unchecked, a Record button 

will become available in the front stage during acquisition. After starting the acquisition, data is 

displayed on the screen, but it is not recorded until the Record button is pressed. 

3. Auto Create new file on Next:  

Automatically adds a new file name in the data tab of the front stage when clicking on the Next 

button. 

4. Automatic Next on Stop acquisition:  

Automatically skips to the next file in the list when stopping the acquisition, making the 

acquisition process faster.  
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DISPLAY PREFERENCES SECTION 

The Display Preferences section also contains several options that are related to the setup, meaning that 

the configurations are stored with the setup when it is saved and are retrieved when the setup is loaded. 

The Name Splitting options refer to the channel/C-Scan group name selectors displayed in the headers 

of the different views for easier navigation. By default, it is set to Automatic. The software automatically 

recognizes patterns in the names of the channels/C-scans and produces the appropriate selectors. 

 



42 
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ANALYSIS PREFERENCES SECTION 

The Analysis Preferences section also contains several options that are related to the setup, meaning that 

the configurations are stored with the setup when it is saved and are retrieved when the setup is loaded. 

 

 

The Measurement Methods portion shows all the possible measurement methods that can be used by 

Magnifi. Only the selected methods are available for analysis, defects reporting, sizing curves, calibration, 

etc. It is recommended to select only the methods that are relevant to facilitate the analysis. The methods 

are: 

1. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

2. Absolute Horizontal (AH):  

Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

3. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

4. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 

5. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 
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6. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

7. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Used only, and recommended, for absolute signals. 

8. Average Peak Horizontal (MPH):  

Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 

9. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

10. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

11. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

12. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

13. Peak to peak First Transition (PPF):  

Uses the combination of the vertical and horizontal component of the first transition of the 

signal to measure maximum amplitude. The firsts signal transition is from the base of an 

indication to its peak. 
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LICENCE SECTION 

Magnifi 5 integrates a cloud-based licensing system to activate, release and share a license key in seconds, 

worldwide, without requiring assistance from Eddyfi.  

To activate, manage or simply view the status and information associated with a license, launch Magnifi 

5 and open the License menu by clicking on the License tab button from the backstage interface. Note 

that an internet connection is required to perform operations on this menu. 

 

 

Once a license has been identified as valid, Magnifi can be used without any internet connection for a 

given period of time. Whenever an internet connection is established while using Magnifi, the software 

automatically contacts the cloud-based licensing system to confirm the validity of the license and reset 

the offline time period, without the need to access the Licence menu. 
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If the software remains offline for longer than the allowed time, the license will be temporarily 

deactivated, and it will no longer be possible to use Magnifi. To correct the situation, simply connect to 

the Internet and let the license system refresh.

 

 

It is important to keep the Contact Information section of the License menu up to date, as it can be used 

by Eddyfi staff for assistance. 

 

 

 

To Activate a license, click on the Manage... button to open the Manage License menu, type the license 

code in the designated field and click on the Activate button.  
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A given license code can only be activated on one (1) PC at a time. To assign a license to another PC, it 

must first be released from the original PC by clicking the Release button. Then the code becomes 

available and can be entered in the License Code field for activation in another PC. These steps make it 

easy to share a license between users, even if they are in different locations. They can also allow a switch 

to another type of license, for example from a data acquisition license to a standard analysis license. 
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The cloud-based licensing system offered with Magnifi 5 is not compatible with Magnifi 4. Therefore, 

moving to the most recent version of Magnifi requires an upgrade from an existing Magnifi 4 license keys. 

Once upgraded, the key can no longer be used with Magnifi 4 versions.  

If needed, Eddyfi can offer users the possibility to trying the newest 5.x version, while maintaining access 

to Magnifi 4.x using a transition license. A transition license is a Magnifi 5 key that is linked to a specific 

Magnifi 4 key. In this condition, Magnifi 5 will run only if both keys are connected to the computer 

simultaneously.  

Once the transition license user feels ready to fully upgrade, the previous license key needs to be 

deactivated. This operation can’t be reverted. A simple procedure must be followed. 

Please contact your sales representative to find out the best path forward to make the most out of this 

licensing system. 

 

HELP SECTION 

The last section of the backstage shows information about: 

• The version of the software; 

• The instrument currently connected to the computer; 
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• Eddyfi’s contact information. 

This is also where you can: 

• Edit the privacy options; 

• Get Assistance 

The Get Assistance button allows you to send information about a problem you encounter with the 

software. You can first fill in the form accessible through the Ask for help button. If relevant, you can also 

use the Export files button to send the file associated with the problem you want to report. This 

information will be used to analyze the problem. Following a request an expert will contact you. 
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ECT Application Guide 
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INTRODUCTION 

This document presents how to use an ECT probe with Magnifi 5 on an Ectane test instrument.  

Eddyfi offers four types of ECT bobbin probes. The following was made using a standard bobbin probe 

(ECT-BBST), but can also be applied to all other types of ECT bobbin probes. 

EQUIPMENT 

ECT probes use a 4-pin connector that can be connected to an Ectane with the ‘’E’’ option. The absolute 

and differential signal from the probe will provide Strip charts and Lissajous.  

As these probes need to fill an optimal portion of the tube inner diameter, a wide range of probe 

diameters are offered (see the tubing probe catalog for more details). A wide  range of frequencies is also 

available to allow inspections of tubes of different thickness and material.  

From the following tables, the best standard probe for your application can be selected. Note that Eddyfi 

also offers custom products that are not shown in these tables.  

 

Table 1 – ECT-BBST probes diameter selection table 
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Table 2 – ECT-BBST probe frequency range selection table 

 

 

Table 3 – ECT-BBST Frequency range 

 

 

The ECT calibration tube used in this document includes the following flaws: 

• Internal groove, 10% of wall loss 

• External groove, 20% of wall loss 

• Hole, 100% of wall loss 

• OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth 

• OD 4 x FBH 20% depth 

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.  

Note: Fill factor and selection tables may differ for other types of bobbin probes. Please refer to the tubing 

probe catalog on our website to find out more.  
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of files. The first level is the Project. It is meant to include different inspections 

that are related in some way. For instance, it can include all the inspections done at a refinery shutdown 

and be named Refinery_Shutdown_May_2018. The second level of file is the Inspection folder. Inspection 

folders are saved in the project file. An inspection folder can include the data specific to the inspection of 

a tube bundle with a specific technology and could be named SS316_075x0.065_ECT, for instance. This 

inspection folder groups the setup, the tube list, the data files and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage.  You can select an existing 

project/folder or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your project file. Select 

New, Folder and enter the chosen name. You can then select the newly created folder and click 

on Select Folder.  
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2. Click on Inspection Sub-folder in the backstage, then click on Add and enter the name of your 

inspection.  

 

 
3. Click Select. This will define the position where the setup(s) and data will be saved. 
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SETUP WIZARD 

In this section, we will show how to create a setup using the Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement 

for imperial units is inches.  When finished, click on Preferences again to go back to the General window.  

  

 

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to 

start the Setup Wizard. 
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COMPONENT DEFINITION 

The first page shown by the Setup Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is 

used to set IRIS parameters only, and doesn’t need to be set if an IRIS inspection is not performed on this 

material.  

It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 
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You will be back to the Component Definition window. If you added a new material, it will now be available 

in the material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube's outer diameter and length. 

These tube properties will help Magnifi to suggest the optimal scan parameters. 

Click Next when everything is set correctly. 
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PROBE SELECTION 

In the Probe Selection window, select the probe you will be using for your inspection. 

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu. 

More precise filtering can be done by using the Model drop-down menu.  You can then select your probe 

by its catalog number (PRBT-ECT-BBST) and then click Next. 
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SCAN DEFINITION 

The Scan Definition window is used to configure the axial position measurement method, the acquisition 

rate and the typical probe speed.  

 

The position along the tube can be defined by using either the internal clock of the system, or by using an 

axial encoder. If you use the internal clock, the default position will be given assuming that the probe is 

always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since 

the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder 

will give you the exact position of the probe. Note that the position can also be obtained by using the 

landmark tool, but this feature will be shown later.  

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate 

is set to 2000 Hz for ECT, but depending on the drive frequency used to inspect, the actual acquisition rate 
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may differ. The system will automatically readjust this value if needed. For standard eddy current probes, 

the acquisition rate can always be set at 2000 Hz.  

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an 

acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points per 

millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t be 

constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial 

resolution target.  The typical probe speed should be set as close as possible to the real value - this will 

help the algorithm that automatically detects landmarks (this will be explained in the Landmarks section). 

The recommended pulling speed for ECT is approximately 300mm/s. 

If you select to measure the position from Encoder, different fields will appear, and a second Scan 

Definition page will become available. 

  

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered. 

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the 

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition 

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a 

speed exceeding the Maximum probe speed, there will be gaps in the data.  

The second page includes the type of encoder and its resolution. A preset can also be specified if your 

acquisition doesn’t start at 0 mm.  

Click Next when you’re finished. 

  



63 

 

DATA DEFINITION 

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute 

and Differential channels. It is important to set these parameters correctly before acquiring the data since 

they are driven by the instrument and cannot be modified during the analysis.  

 

By default, Magnifi suggests four frequencies theoretically calculated with the parameters previously 

entered: 

 

 

Prefix Frequency 
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F1 2 x F90 

F2 F90 

F3 F90/2 

F4 F90/8 

 

The frequency and drive voltage can be changed by replacing their values in the Required frequencies 

table. Up to 4 frequencies can be set at the same time, and the sum of their amplitudes cannot exceed 

10V. 

Make sure that the frequencies are within the probe limits that you can find in Table 3. If one of the 

suggested frequencies is not within the recommended probe frequency range, you can either remove it 

by clicking on the X or change it within the recommended range.  

Click on Next when the desired parameters are entered.  

The next window is used to build mixed channels. Mixes are processed channels that are mainly used to 

detect indications close to support plates. They are built with 2 frequencies of the same channel type to 

attenuate the effect of the support plate and to be able to size an indication at this location more 

accurately.  
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If you do not wish to use mixed channels, click on Next.  

To add a mixed channel, click on the Add button. A new line will appear. Choose from which input you 

want to use the mixed channel. Note that Input Channel 2 must have a lower frequency than Input Channel 

1. Mixed channels can be built for both absolute and differential channels.  

You can rename the mixed channel output by modifying the Output Mixed Channel field. 

The Mixed Reference Signal (usually a support plate signal) will be used to calibrate the mix channel. The 

system will apply processes to the chosen input channels and will subtract them to eliminate the reference 

signal.  

Click on Next. 
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DATA PROCESSING 

The Data Processing window is used to configure the signal processing to apply to the channels.  

You can choose to configure every frequency individually or you can apply the same filters to every 

channel with the Individually configure all the channels check box.  

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can 

be changed without any problem during data analysis, while wrong parameter choice for the data 

acquisition can mislead the analysis. It is possible to change the filter parameters after data acquisition, 

so it is always possible to fine tune the filter parameters during analysis. 

 

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful 

when your defect signal has a lower frequency content than the background noise. In this case, using a 
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filter will remove part of the noise without removing the defect’s signal. This may help with data analysis. 

However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too 

low will filter out the defect’s signal.  

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of 

the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of 

the high-pass median filter should be set to at least three times the axial length of the longest flaw that 

may be encountered. Data should be examined in both its filtered and unfiltered states. It is important to 

keep in mind that the median high-pass filters can distort phase. More information about median filters 

for NDT analysis can be found on Eddyfi’s blog.  

Click Next when you are done.  
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CALIBRATION POINTS 

The Calibration Points page is used to define the points in your calibration tube. These indications will 

later be used to calibrate your probe and to build sizing curves.  

The units of measurement can be set in percentage or in depth (millimeters or inches).  

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and 

size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).  

Calibration points can also be imported with the Import button.  

 

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).  

CALIBRATION 

The Calibration page is used to define reference signal(s) that will be used to set the amplitude(s) and 

phase(s) of each channel using the selected measurement method.  
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By default, the calibration is performed on the Hole signal by adjusting it to 1V and 40° on both the 

absolute and the differential channels. However, the calibration can be done differently on each channel 

type. It can also be done individually for each frequency by selecting the Individually configure all the 

channels option. Different reference signals can be set to calibrate the phase and the amplitude 

independently.  

 

 

When you select the reference signal, the system will use the selected measurement method to apply a 

rotation and a gain. Here is a short description of the available options: 

14. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

15. Absolute Horizontal (AH):  
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Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

16. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

17. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 

18. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

19. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

20. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Only used and recommended for absolute signals. 

21. Average Peak Horizontal (MPH):  

Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 

22. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

23. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

24. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

25. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

26. Peak to peak First Transition (PPF):  

Uses the combination of the vertical and horizontal components of the first transition of the signal 
to measure maximum amplitude. The first signal transition is from the base of an indication to its 
peak. 

Click on Next went the parameters in the table are set according to your requirements. 
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SIZING CURVES 

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this 

table.  

 

The sizing curve will allow you to estimate the size of a defect based on the calibration point signals 

(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw 

size based on the built sizing curves. 

Sizing curve names are customizable. The channel source and measurement type can also be changed. 

You can add sizing curves by clicking on the Add button. 

Click Next when you are done. 
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For every sizing curve created in the last window, a window will appear to configure the curve properties. 

The name of the curve will be shown in the upper left corner of the page (ABS-F1 in the example below).  

 

The measurement method options are the same as what is described in the calibration section of this 

document. By default, the average peak option is set for absolute channels, and the peak-to-peak option 

is used for the differential channels.  

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of 

the available options: 

1. Best Fit (Dual linear) (for phase measurement only):  

A curve with two linear segments representing ID and OD (or Near and Far) side calibration 

points with respect to phase. 

2. Best Fit (Dual Slope) (for phase measurement only):  
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A curve with two segments representing ID and OD (or Near and Far) sides. The ID section is 

linear, and the OD section is polynomial. The OD side of the curve will need at least three points 

(including the hole) in order to trace a polynomial curve. 

3. Best Fit (Polynomial) (for phase and amplitude measurements):  

Best polynomial (degree 2) interpolation within the measured  calibration points (requiring at 

least three points). 

4. Connected Points (for phase and amplitude measurements):  

Simple, point-to-point curve. 

5. Best Fit (Linear) (for phase and amplitude measurements):  

Best linear interpolation within the measured calibration points 

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements): 

Polynomial (degree 2) interpolation with two segments for both ID and OD sides of the curve. 

Need at least three points.  

The linear options are mostly used when few data points are available, while the  Best fit (Dual Polynomial) 

option is a more precise method when your calibration tube has multiple defects. 

Once the measurement method and the interpolation curve shape are chosen, you can select the curve 

points for each sizing curve previously created. The order in which the points appear in the list may 

influence your sizing cure. Make sure that the measured values of the calibration points are in ascending 

order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking 

the box Report as remaining wall thickness. 

Click Next when you are done.  
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INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Next when you are done 
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DISPLAY 

The first Display window is used to set how the data is displayed during and after the acquisition.  

 

The scroll direction is the direction in which data appears on the screen. If you choose downward, the 

signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal 

will go from the bottom to the top of the screen.  

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box. 

The strip chart duration is the length of a Strip chart window when the data is acquired. 

Click Next. 
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The second Display window is used to set the layouts. Checking the tick boxes in this window will make 

the proposed layouts available in your setup. You will be able to switch from one to the another via the 

layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code indication zone.  

The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 

Layouts can be readjusted at any time.  

 

Click Next to complete the setup wizard process. 
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SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the 

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change.  

 

 

This will open one of the windows previously described, where you can change the values you originally 

entered If applicable, go through the process by clicking on Next, and then click on the Finish button. This 

will apply the modification to the setup.  

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed 

using the advanced settings, the information shown using the Setup tab may not match your actual setup.  

SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 

 

The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 
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The following table shows the possible icons and their meaning: 

Icon Description Meaning 

(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 

 

 

Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 

detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 
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Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 

WIZARD 

AI-ECT detection of landmarks and indications can be enabled through the SMART Setup tab. 

To configure this tool, click the Wizard button. 

 

Before the Wizard is displayed, a warning message appears: 
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When AI is added to your setup, Magnifi applies minor changes for the detection algorithms to work: 

1. Channels will be copied and renamed with the prefix “AA_.” These are additional channels that 

the AI engine will use for processing. The original channels in your setup will not be modified. 

2. If conventional landmark detection was previously set up, it will be disabled and replaced by the 

AI landmark detection. 

3. If conventional region detection was previously configured, it will be replaced by a set of read-

only regions that are required for AI detection. 

Once AI is added to a setup, it cannot be reverted. Make a copy of your installation before continuing if 

you want to keep a backup. 

AI PACKAGE 

The first window of the wizard gives the option of choosing the appropriate algorithm for the type of 

equipment being inspected. In version 5.0, only one algorithm is available. 

 

If the setup for the acquisition was done with the Setup Wizard, the probe configuration will automatically 

be selected. For legacy setups, the Technique, Model and Probe must be selected from the drop-down 

menus. 
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AI LANDMARKS 

The second window allows you to set the landmark detection parameters. Landmarks are important to 

detect defects. They allow the system to automatically create regions (e.g., tube sheet, support plates, in 

tube) in the tube. This allows the detection of defects in these pre-defined regions. 

 

The fields in the upper right corner of the window allows one to enter the morphology of the exchanger 

and the way it is inspected. This information will be expected by the AI during its analysis. 

The type of bundle inspected must be selected. The AI supports three configurations: 

Straight: The tubes are straight and tube sheet signals can be acquired. 
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Straight restricted: A restriction is present which prevents the sensors of the probe from coming out of 

the tube completely. Select this inspection type if the exit is restricted on some of the tubes or all of them. 

 

U-bend: Inspection of the straight parts only, so the scan includes only one tube sheet signal. 

 

Tube length value is optional and does not affect the AI detection performance. This information is 

relevant if an estimate of the axial location of indications is expected. Entering the appropriate length will 



83 

 

result in more accurate values and a better-quality report, especially if you are using TubePro™ 5.X with 

3D models to visualize the defect location. 

Names for the types of detected landmarks can be customized if required. Here are the abbreviation 

descriptions for each type: 

AI INDICATIONS 

The last window allows one to enable AI indication detection and customize the label of these detected 

indications. The label will be displayed in the Code view as well as in the Indications pane of the Front 

Stage interface. 

Type Description 

AIRI 
AIR In: Only used for detection in calibration tube data. Signal acquired by the probe 

when it leaves the air and enters the tube. 

TSI 
Tube Sheet In: Signal acquired by the probe when it leaves the air and enters the 

bundle. 

LSP 

Last Support Plate: Only used with Straight Restricted and U-Bend One Leg inspection 

types. 

LSP replaces TSI when a restriction prevents the probe from acquiring the full TSI 

signal. 

SP Support Plate signal. 

TSO 
Tube Sheet Out: Signal acquired by the probe when it leaves the bundle and is then in 

the air. 

AIRO 
AIR Out: Only used for detection in calibration tube data. Signal acquired by the probe 

when it leaves the tube and is then in the air. 
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Data processing such as filtering can induce a spatial or temporal delay in the data, meaning that the 

whole signal in the strip charts can be slightly shifted up or down. Since the AI channels and user’s channels 

don’t necessarily have the same data processing, there can be some misalignment between them. This 

could translate into detected indications, represented as red marks in the Code view, appearing slightly 

offset compared to the indication signals observed in the strip charts of the user’s channels. This is where 

the Position correction channel option is applicable. This parameter realigns the indications shown by the 

AI with the user’s channel signals by applying a position correction to the AI channels. 

The applied correction is calculated automatically when calibrating on the through-wall hole. This 

compensation is applied on every tube. If the filters are modified during the analysis, it is recommended 

to calibrate again to readjust the compensation. 

Typically, the most used channel for reporting indications should be selected as the reference for the 

position correction. 

LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools 

(not AI). This function is not accessible if you are using the AI landmark detection tool that is set with the 

AI wizard. 
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The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can however give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 

 

Three landmarks are created if you press on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position) or on the place you stop to record (usually the 

operator side). 
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In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 

Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. And the Threshold is the voltage amplitude threshold. 

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the right position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates don’t need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tubesheets). 

 

When using the AI Wizard, the parameters of the Region Detection window are set automatically and 

most of them cannot be modified. You will only be able to change the thickness of the landmark and the 
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number of support plates. Changing these values will modify the schematic in the regions page to help 

visualize the exchanger. 

 

If you are using the conventional detection tools (not AI-based), you can set up the regions according to 

the automatic analysis tools you will use with the Indications and DVQ buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view (described later). 
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There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

And seven waveform types: 
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 Up 

 Down 

 Down-up 

 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 

 

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 
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Note that conventional indication detection boxes can be used along AI detection tools. It is 

recommended to configure them after AI activation to have access to regions automatically defined when 

going through the AI Wizard. 

DATA QUALITY VALIDATION (DQV) 

Data Quality Validation (DQV) allows defining tests to validate the quality of the data. 

 

Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 

 

• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-length of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 
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• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows group a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together for which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 

 

 

 

GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications. This tool is compatible with the AI-based detection engine as well as 

with conventional rule-based and user-defined indication detection boxes or waveforms. 
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The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 

 

The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 
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Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 

 

It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 
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Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUT 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 

DATA LIST 

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.  

This list can be created in the Data List of the General tab of the Backstage. 

 

 

Four options are available to set the filename format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

 

Click on the Create New List button. The displayed window will be different depending on the chosen 

filename format. 
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For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 

then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 

generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 

list.  

 

The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the Data window of the Frontstage. 

The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software 

(available from Eddyfi).  
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PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button. 

2. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect, and 

then click Connect. 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To download 

a matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  

 

 

Two (2) acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used 

to scan your calibration tube and make the necessary adjustments on your setup without saving the data 

automatically. Acquisition mode is used for the inspection - in this mode, the software automatically saves 

the acquired data using file names based on the tube list.  
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

4. Plug the bobbin probe on the Ectane 4-pin connector.  

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

6. Push the probe head all the way through the tube so that it exits the tube. 

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

8. Pull the probe at approximately 12’’/s (300 mm/s) 

9. When it’s done, press the Stop button or F2 again on your keyboard. 

 

 

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually 

the case when your probe is out of the tube.  

VISUALIZING THE DATA 

Multiple options are available to select your data and to measure it. The following describes useful 

functions to do so: 
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DISPLAYED CHANNEL 

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons 

are used for the channel selection. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 

are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 

channel.  

 

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 

desired channel to select it. Right-click or Left-click on this button to switch to the following or 

previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential). 

4. Same principle as 2., but for the frequencies only. 

STRIP CHART AXIS ORIENTATION 

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis 

to another, click on the box showing an arrow at the upper right corner of the Strip chart.  
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ZOOMING 

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this 

section.  

 

 
  

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent. 
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ADJUSTING THE CURSOR LENGTH 

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and 

the full line is the center of what you have selected.  

Only the portion of data between the dotted lines  will be shown in the Lissajous.  

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse 

button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same 

operation, but with the right button of your mouse.  

ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  

 

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 

MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method. 

A short description of the measurement methods can be found in the above calibration section of the 

setup wizard.  

 

1. Clicking on the corner with the black triangle gives the list of measurement method for the 

amplitude of the signal. Click on the desired method to select it. Right- or left-click on this 

button to select the next or the previous method in the list.  

2. Same as 1., but for the phase measurement. 

3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure 

the phase with the right orientation.  

4. Take the same two points in time to take the measurement in the other Lissajous. 

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 

a vector on your Lissajous.  
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LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotation applied, by definition. Also, rotating the 

signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.  

The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   

DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and use the spacebar on the keyboard.  

 

CALIBRATION AND SIZING CURVES 

CALIBRATION 

The following section describes how to calibrate your probe. 

1. Go to the Calibration tab and click on the System icon. 

2. Select Channel in the calibration window. 

3. In the Strip chart, select the signal to calibrate and adjust the cursors to see only the desired 

signal.  

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you selected your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  
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4. Select the signal name in the list. 

5. Click on the green arrow button to associate the measured signal to the calibration point. 

6. If more than one calibration point is present in the list, repeat step 3, 4 and 5 for each one. 

7. When all your calibration points are check-marked, click on the Calibrate button. 

 

SIZING CURVES 

The following section describes how to build your sizing curves. 

1. Go the calibration tab and click on the Sizing curve button. 

2. Select Channel and Sizing Curves in the Calibration window. 

3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal. 

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you selected your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to 

show the defect size. To have the correct interpolated point, the measurement method also needs to be 

the same as the one used for the sizing curve. To change the measurement method, click on the icons at 

the bottom left of the Lissajous. 

4. Select the signal name in the list. 

5. Click on the green arrow. 

6. Redo the previous steps for all the other indications in the list. 

7. Click on the Calibrate button. 
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Error messages after creating the phase sizing curves may appear. The main cause of these errors is the 

measurement direction.  

The image below shows two different measurements. On the left, you can see that the measurement 

arrow is pointing towards the liftoff signal. In this case, the measured phase is rotated of 180˚ from the 

right value. When one or more points were measured in the wrong direction, Magnifi cannot build the 

sizing curve and will generate an error message. Note that you won’t have this issue with an absolute 

channel if you’re using the average peak measurement method.  

In the image on the right, the arrow is pointing from the liftoff signal to the defect signal, which is correct. 

However, in this picture, the arrow starts quite far from the middle of the liftoff variation signal, which 

will cause an error in the measurement. In this case, we suggest you move the cursors until your 

measurement is taken from a point near the base of the signal.  
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To adjust your sizing curves and remove the error messages, go the Calibration tab, and click on View 

Curves.  
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The sizing curve window will appear. Each sizing curve you asked Magnifi to create will be listed in the 

drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t 

entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually, 

enter the value in the table.  

In the above example, the entered phase angle for the 40% defect is 300˚, but the correct phase angle for 

the 40% defect is 120˚. The 40% defect has an 180˚ bias due to an incorrect measurement direction. In 

this case, we can simply change the angle value from 300˚ to 120˚ in the table to fix the sizing curve. 

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the 

Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not 

appear, it means that you are not in a channel where a sizing curve was set.  

LANDMARKS 

The following section describes how to calibrate your landmarks. 

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks 

window the same way you calibrated the sizing curve(s) points. You can use the Land channel to do so.  

The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside 

tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside 

tubesheet). 

 

Once the landmarks are calibrated properly, the system should be able to recognize them automatically.  

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far 

end of the tube is needed.  
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SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file. Note that when 

data is saved, the setup is also saved with it.  

You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  

INSPECTION 

STANDARD ACQUISITION 

The following section describes how to perform an inspection. 

1. Connect Magnifi to your instrument. 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the bobbin probe into the Ectane 4-pin connector.  

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard.  

5. Push the probe all the way through the tube until it exits the far end.  

6. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

7. Pull the  probe towards you at a constant speed until it exits the tube. 

8. When finished, press the Stop button or again F2 on your keyboard. 

9. Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.  

MANUAL SEQUENCE 

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and 

can trigger the acquisition start/stop and the data recording automatically. At least two (2) landmarks are 

needed to use this feature. These landmarks can be created by using the Landmarks button under the 

SMART Setup tab.    

To set the manual sequence: 

1. Click on the Manual Sequence button under the Calibration tab.  

2. If a warning message is shown in this window, change the parameters until no warnings are 

shown. The system will progress through the different windows to guide you.  

3. Click on Settings … 
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4. Select Landmark in the Type section. 

5. In the drop-down menu, choose the Landmark that will initiate the data recording. If you keep 

the default landmarks, you can select the Exit landmark that will be triggered when the probe 

goes out of the tube when the probe is pushed.  

6. You can enter a delay to start the acquisition after the first landmark is detected (Start 

Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop 

Acquisition Delay).  

7. Two options are available to restart the acquisition: The user can either push a button or use a 

timer. Select the desired option in the Restart section.  

8. Click on OK. 

To use the manual sequence: 

1. Connect Magnifi to the instrument. 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the ECT probe into the Ectane 4-pin connector. 

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Open the Sequence window by clicking on the Manual Sequence button under the Calibration 

tab. 

6. Put your probe in the tube to inspect and click on the Launch button. This will start the data 

acquisition. 

7. Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the 

landmark and this will initiate the data recording.  
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8. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection 

that will stop the data recording. 

9. Acquisition restart: 

a. If you selected User Input in the settings of the Manual Sequence Configuration, the system 

will wait for the user to enter information on the tube to restart the acquisition. Click on 

NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition. 

Repeat steps 6, 7 and 8 for all the tubes to inspect. 

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown 

will trigger after the last tube acquisition was taken. The acquisition will start after this time 

has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.  

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is 

the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube. 

In this situation, you can click on the Target button in the Sequence window to start the data recording. 

DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Data list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage. 

  

The list of tubes is also shown in the Data window.  
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A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

go out of acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon. 

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A tube name can be changed by right-clicking on its name and by selecting the Rename option. 

LOADING A FILE 

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the 

Home tab. 

2. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  

To add an indications to the data: 

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  



116 

 

 

 

Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is 

explained in the SMART Setup section of this manual. 

Indications can also be added to a tube to indicate, for instance, that it has no flaws or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab 
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REPORT TABLE 

To access the list of indications entered: 

1. Make sure that the Report option is selected under the Layout tab.  

 

2. Click on the report ribbon at the bottom of the screen to make the list visible. 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  

2. Click on the Generate Report button under the Report section of the General tab. 

3. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tubes in each category.  
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4. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 

 

 

The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro. 
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INTRODUCTION 

This document presents how to set up and calibrate the DefHi® probe with Magnifi 5 on an Ectane test 

instrument using the Setup Wizard. Equipment 

The DefHi® probes use a 160-pin connector that can be connected to an Ectane with the ‘’E64’’ or 

‘’E128’’option (depending on the probe model).  

As this probe needs to be near the tube surface, a wide range of probe diameters are offered (see the 

tubing probe catalog for more details). A wide range of frequencies is also available to allow inspections 

of tubes of different thickness and material.  

From the following tables, the best probe for your application can be selected.  

 

Table 4 – Probe diameter selection table 

 

 

Table 5 – Probe frequency range selection table 
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Table 6 - Frequency range 

 

 

 

Table 7 – Total number of array channels 

 

 

Defhi® probes are available with one row or two rows pancake coils. The model with one row (ERBC) will 

allow the detection of circumferential cracks. The model with two rows (ERBCA) will allow the detection 

of both axial and circumferential cracks with the array part of the probe. 

Table 4 indicates the number of array channels for each standard probe. The total number of channels for 

a DefHi® probe equals the number of array channels plus two (one for the absolute and one the 

differential bobbin channels). Therefore, if the number of array channels is 63 or over, it means that an 

Ectane with the ‘’E64’’ option won’t have enough channel for this probe and that an Ectane with the 

‘’E128’’ option will be required to use this probe.  

The DefHi® calibration tube used in this document includes the following flaws: 

• Internal groove, 10% of wall loss 

• External groove, 20% of wall loss 

• Hole, 100% of wall loss 

• OD Flat Bottom Hole (FBH) at 40%, 60% and 80% depth 

• OD 4 x FBH 20% depth 

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.  
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of files. The first level is the Project. It is meant to include different inspections 

that are related in some way. For instance, it can include all the inspections done at a refinery shutdown 

and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder. 

Inspection folders are saved in the project file. An inspection folder can include the data specific to the 

inspection of a tube bundle with a specific technology and could be named SS316_075x0.065_ECT, for 

instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage.  You can select an existing 

project/folder or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your project file. Select 
New, Folder and enter the chosen name. You can then select the newly created folder and click 
on Select Folder.  
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your 
inspection.  

 

3. Click Select. This will define the position where the setup(s) and data will be saved. 

SETUP WIZARD 

In this section, we will show how to create a setup using the Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement 

for imperial units is inches.  When finished, click on Preferences again to go back to the General window.  
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To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to 

start the Setup Wizard. 
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COMPONENT DEFINITION 

The first page shown by the Setup Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is 

used to set IRIS parameters only, and doesn’t need to be set if an IRIS inspection is not performed on this 

material.  

It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 
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You will be back to the Component Definition window. If you added a new material, it will now be available 

in the material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube’s outer diameter and length. 

These tube properties will help Magnify to suggest the optimal scan parameters. 

Click Next when everything is set correctly. 
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PROBE SELECTION 

In the Probe Selection window, select the probe you will be using for your inspection. 

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu. 

More precise filtering can be done by using the Model drop-down menu.  You can then select your probe 

by its catalog number and then click Next. 
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SCAN DEFINITION 

The Scan Definition window is used to configure the axial position measurement method, the acquisition 

rate and the typical probe speed.  

 

The position along the tube can be defined by using either the internal clock of the system, or by using an 

axial encoder. If you use the internal clock, the default position will be given assuming that the probe is 

always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since 

the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder 

will give you the exact position of the probe. Note that the position can also be obtained by using the 

landmark tool, but this feature will be shown later.  

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate 

is set to 1500 Hz for DefHi, but depending on the drive frequency used to inspect, the actual acquisition 

rate may differ. The system will automatically readjust this value if needed.  

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an 

acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points per 

millimeter. If you do not use a pusher-puller device such as Probot, the pulling speed won’t be constant. 

Therefore, it is recommended to target a lower pulling speed to be able to reach your axial resolution 



132 

 

target.  The typical probe speed should be set as close as possible to the real value. This will help the 

algorithm that automatically detects landmarks (this will be explained in the Landmarks section). The 

recommended pulling speed for DefHi® is approximately 300mm/s (12in/s). 

If you select to measure the position from Encoder, different fields will appear, and a second Scan 

Definition page will become available. 

   

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered. 

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the 

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition 

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a 

speed exceeding the Maximum probe speed, there will be gaps in the data.  

The second page includes the type of encoder and its resolution. A preset can also be specified if your 

acquisition doesn’t start at 0 mm.  

Click Next when you’re finished. 
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DATA DEFINITION 

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute 

and Differential channels. It is important to set these parameters correctly before acquiring the data since 

they are driven by the instrument and cannot be modified during the analysis.  

 

Pages of this section are used to set the parameters of the array part of the probe (C-Scan) and others are 

used for the bobbin part of the probe (channels).  

By default, Magnifi suggests two frequencies for the array part of the probe and four frequencies the 

bobbin part. These frequencies are calculated with the parameters previously entered: 

Prefix Frequency Channels 

F1 2 x F90 Array & bobbin 

F2 F90 Array & bobbin 

F3 F90/2 bobbin 

F4 F90/8 bobbin 
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The frequency and drive voltage can be changed by replacing their values in the Required frequencies 

table. Up to 4 frequencies can be set at the same time, and the sum of their amplitude cannot exceed 10V. 

Make sure that the frequencies are within the probe limits that you can find in Table 3. If one of the 

suggested frequencies is not within the recommended probe frequency range, you can either remove it 

by clicking on the X or change it within the recommended range.  

Click on Next when the desired parameters are entered.  

DATA PROCESSING 

The next windows are used to build mixed channels. Mixes are processed channels that are mainly used 

to detect indication close to support plates. They are built with two frequencies of the same channel type 

to attenuate the effect of the support plate and to be able to size an indication at this location more 

accurately.  

 

If you do not wish to use mixed channels, click on Next.  

To add a mixed channel, click on the Add button. A new line will appear. Choose from which input you 

want to use the mixed channel. Note that Input Channel 2 must have a lower frequency than Input Channel 

1. Mixed channels can be built for C-Scans, absolute and differential channels.  
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You can rename the mixed channel output by modifying the Output Mixed Channel field. 

The mixed reference signal (usually a support plate signal) will be used to calibrate the mix channel. The 

system will apply processes to the chosen input channels and will subtract them to attenuate the 

reference signal.  

Click on Next to configure the signal processing to apply to the channels.  

You can choose to configure every frequency individually with the Individually configure all the 

channels/C-scans check box or you can apply the same filters to every channel/C-scans. 

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can 

be changed without any problem during data analysis, while a wrong parameter choice for the data 

acquisition can mislead the analysis. It is possible to change the filter parameters after the acquisition, so 

it is always possible to fine tune the filter parameters during the analysis. 

  

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful 

when your defect signal has a lower frequency content than the background noise. In this case, using a 

filter will remove part of the noise without removing the defect’s signal. This may help with data analysis. 

However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too 

low will filter out the defect’s signal.  

The median high pass filter is used to filter out low frequency noise such as lift-off variations of the probe 

within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of the high-

pass median filter should be set to at least three times the axial length of the longest flaw that may be 

encountered. Data should be examined in both its filtered and unfiltered states. It is important to keep in 

mind that the median high-pass filters can distort phase. More information about median filter for NDT 

analysis can be found on Eddyfi’s blog.  

CALIBRATION POINTS 

The Calibration Points page is used to define the points in your calibration tube. These indications will 

later be used to calibrate your probe and to build sizing curves.  

The calibration point units of measurement can be set in percentage or in depth (millimeters or inches).  
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You can add calibration points by clicking on the Add button. Specify the calibration point name, side and 

size. The side and size of the flaw will be used to position the calibration point in the sizing curve(s).  

Calibration points can also be imported with the Import button.  

 

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).  

CALIBRATION 

The Calibration pages are used to define reference signal(s) that will be used to set the amplitude(s) and 

phase(s) of each channel using the selected measurement method. There are two calibration pages: one 

for the array (C-Scans) and one for the bobbin (channels). 

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 40° on the C-scans, 

the absolute and the differential channel. However, the calibration can be done differently on each 

channel type. It can also be done individually for each frequency by selecting the Individually configure all 

the channels option. Different reference signals can be set to calibrate the phase and the amplitude 

independently.  
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When you select the reference signal, the system will use the selected measurement method to apply a 

rotation and a gain. Here is a short description of the available options: 

 

1. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

2. Absolute Horizontal (AH):  

Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

3. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

4. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 

5. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

6. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

7. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Only used and recommended for absolute signals. 

8. Average Peak Horizontal (MPH):  

Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 



138 

 

9. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

10. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

11. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

12. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

13. Peak to peak First Transition (PPF):  

Uses the combination of the vertical and horizontal component of the first transition of the signal 
to measure maximum amplitude. The first signal transition is from the base of an indication to its 
peak. 

 

Click on Next went the parameters in the table are set according to your requirements. 
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SIZING CURVES 

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this 

table.  

 

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals 

(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw 

size based on the built sizing curves. 

Sizing curve names are customizable. The channel source and measurement type can also be changed. 

You can add sizing curves by clicking on the Add button. 

Click Next when you are done. 

For every sizing curve created in the last window, a window will appear to configure the curve properties. 

The name of the curve will be shown in the upper left corner of the page (F1A in the example below).  
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The measurement methods options are the same as what is described in the calibration section of this 

document. By default, the average peak option is set for absolute channels, and the peak-to-peak option 

is used for the differential channels.  

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of 

the available options: 

1. Best Fit (Dual linear) (for phase measurement only):  

A curve with two linear segments representing ID and OD (or Near and Far) side calibration 

points in respect to phase. 

2. Best Fit (Dual Slope) (for phase measurement only):  

A curve with two segments representing ID and OD (or Near and Far) side. The ID section is 

linear, and the OD section is polynomial. The OD side of the curve will need at least three points 

(including the hole) in order to trace a polynomial curve. 

3. Best Fit (Polynomial) (for phase and amplitude measurements):  

Best polynomial (degree 2) interpolation within the measured calibration points (requiring at 

least three points). 

4. Connected Points (for phase and amplitude measurements):  

Simple, point-to-point curve. 
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5. Best Fit (Linear) (for phase and amplitude measurements):  

Best linear interpolation within the measured calibration points 

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements): 

Polynomial (degree 2) interpolation with two segments for both ID and OD sides of the curve. 

Need at least three points.  

 

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial) 

option is a more precise method when your calibration tube has multiple defects. 

Once the measurement method and the interpolation curve shape are chosen, you can select the curve 

points for each sizing curve previously created. The order in which the points appear in the list may 

influence your sizing cure. Make sure that the measured values of the calibration points are in ascending 

order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking 

the box Report as remaining wall thickness. 

Click Next when you are done.  
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INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Next when you are done 
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DISPLAY 

The first Display window is used to set how the data is displayed during and after the acquisition.  

 

The scroll direction is the direction in which data appears on the screen. If you choose downward, the 

signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal 

will go from the bottom to the top of the screen.  

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box. 

The strip chart duration is the length of a Strip chart window when the data is acquired. 

Click Next. 

The second Display window is used to set the layouts. Checking the tick boxes in this window will make 

the proposed layouts available in your setup. You will be able to switch from one the another via the 

layout tab. The " C " stands for code, " S " stands for Strip chart," L " for Lissajous, " CS " for C-scan and " CS-

3D " for 3D C-scan. 

The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 

Layouts can be readjusted at any time.  
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Click Next to complete the setup wizard process. 

 

SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the 

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change.  

 

This will open one of the windows previously described, where you can change the values you originally 

entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This 

will apply the modification to the setup.  

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed 

using the advanced settings, the information shown using the Setup tab may not match your actual setup.  
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SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 

 

The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 

 

The following table shows the possible icons and their meaning: 

Icon Description Meaning 
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(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 

 

 

Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 

detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 

 
Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 
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LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools. 

 

The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can however give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 

 

Three landmarks are created if you press on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position) or on the place you stop to record (usually the 

operator side). 
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In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 

Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. And the Threshold is the voltage amplitude threshold. 

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the right position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates don’t need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tubesheets). 
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If you are using the conventional detection tools, you can set up the regions according to the automatic 

analysis tools you will use with the Indications and DVQ buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view. 
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There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

 

And seven waveform types: 

 Up 

 Down 

 Down-up 

 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 
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Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 

 

 

DATA QUALITY VALIDATION (DQV) 

Data Quality Validation allows defining tests to validate the quality of the data. 

 

Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 
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• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-length of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 

• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows group a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together for which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 
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GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications.  

 

The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 
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The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 

Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 
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It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 

 

Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUT 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 

DATA LIST 

Magnifi will save a file for each inspected tube. The file names are defined by creating the list of tubes.  

This list can be created in the Data List section of the General tab of the Backstage. 

 

 

Four options are available to set the filename format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

Click on the Create New List button. The displayed window will be different depending on the chosen 
filename format. 

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 
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generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 
list.  

 

 

The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the Data window of the Frontstage. 

The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software 

(available from Eddyfi).   
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PERFORMING AN ACQUISITION 

5. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button. 

6. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect and 

then click Connect. 

 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X  icon will be shown in the Status field of the Instrument connection window. To download 

a matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  
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Two acquisition modes are available in Magnifi: Setup Mode and the Acquisition Mode. Setup Mode is 

used to scan your calibration tube and make the necessary adjustments on your setup without saving the 

data automatically. Acquisition mode is used for the inspection. In this mode, the software automatically 

saves the acquired data using file names based on the tube list.  

7. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

8. Plug the DefHi® probe on the Ectane 160-pin connector.  

9. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

10. Push the probe head all the way through the tube so that it exits the tube. 

11. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

12. Pull the calibration tube at the appropriate speed  

13. When it’s done, press the Stop button or F2 again on your keyboard 

 

 

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually 

the case when your probe is out of the tube.  
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VISUALIZING THE DATA 

Multiple options are available to select your data and to measure it. The following describes useful 

functions to do so: 

DISPLAYED CHANNEL 

There are four buttons at the upper right corner of the C-Scans, Strip charts and Lissajous windows. These 

buttons are used for the channel selection. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 

are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 

channel.  

 

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 

desired channel to select it. Right-click or Left-click on this button to switch to the following or 

previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential). 
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4. Same principle as 2., but for the frequencies only. 

STRIP CHART AXIS ORIENTATION 

The Strip charts are a projection of the Lissajous on the vertical or horizontal axis. To switch from one axis 

to another, click on the box showing an arrow at the upper right corner of the Strip chart.  

 

ZOOMING 

On the strip chart/or on a C-scan, hold the right button of your mouse and drag on the zone of interest to 

zoom in this section. This operation can be done in both axis for the C-scan.  

 

 

 

 

 

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.  

 

ADJUSTING THE CURSOR LENGTH 

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and 

the full line is the center of what you have selected.  
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Only the portion of data between the dotted line will be shown in the Lissajous.  

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse 

button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same 

operation, but with the right button of your mouse.  

ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  

 

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 
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MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method. 

A short description of the measurement methods can be found in the above calibration section of the 

setup wizard.  

 

1. Clicking on the corner with the black triangle gives the list of measurement method for the 

amplitude of the signal. Click on the desired method to select it. Right- or Left-click on this 

button to select the next or the previous method in the list.  

2. Same as 1., but for the phase measurement 

3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure 

the phase with the right orientation.  

4. Take the same two points in time to take the measurement in the other Lissajous 

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 

a vector on your Lissajous.  

LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the 

signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.  

The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   

DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and use the spacebar on the keyboard.  
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CALIBRATION AND SIZING CURVES 

SLEW 

The DefHi® probes include two bobbins that generate absolute and differential channels. It also includes 

a set of pancake coils that generates C-scan(s). Since the bobbins and the pancake coils are not physically 

located at the same position on the probe, there is a time delay between the channels (coils) and the C-

scan (pancakes coils).  To bring all the signals at the same position, the bobbin channels can be shifted in 

time to match the C-scan. This process is called Slew in Magnifi.  

To Slew: 

1. Click on the Slew button that can be found under the Calibration tab.  

 

2. Place your cursor over a flaw in your C-scan.  

3. Click on the button at the left in the Slew Calibration window. This will set the reference point at 

which the channels will move.  

4. Place your cursor over the same flaw but on the differential or absolute channel.  

5. Click on the button at the right in the Slew Calibration window 

6. Click on Apply. 

Note that this process will move the channels by a constant number of samples. Therefore, a probe pulling 

speed that was not constant won’t have a data alignment that is valid throughout the hole scan.   
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CALIBRATION 

The following section describes how to calibrate your probe. 

1. Go to the Calibration tab and click on the System icon 

2. Select Channel in the calibration window 

3. In the Strip chart, select the signal to calibrate and adjust the cursors to see only the desired 

signal.  

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

.  

1. Select the signal name in the list. 

2. Click on the green arrow button to associate the measured signal to the calibration point. 

3. If more than one calibration point is present in the list, repeat step 3, 4 and 5 for each one. 

4. When all your calibration points are check-marked, click on the Calibrate button 
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SIZING CURVES 

The following section describes how to build your sizing curves. 

1. Go the calibration tab and click on the Sizing curve button. 

2. Select Channel and Sizing Curves/or C-Scan and Sizing Curves in the calibration window. 

3. Select the signal in your Strip chart/ or C-scan and adjust the cursors to see only the desired 

signal. 

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If for some reason the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to 

show the defect size. To have the correct interpolated point, the measurement method also needs to be 

the same as the one used for the sizing curve. To change the measurement method, click on the icons at 

the bottom left of the Lissajous. 

1. Select the signal name in the list. 

2. Click on the green arrow. 

3. Redo the previous steps for all the other indications in the list. 

4. Click on the Calibrate button. 

The previous operations must be done for the channels and the C-scans.  

 

Error messages after creating the phase sizing curves may appear. The main cause of these errors is the 

measurement direction.  
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The image below shows two different measurements. On the left, you can see that the measurement 

arrow is pointing towards the liftoff signal. In this case, the measured phase is rotated of 180˚ from the 

right value. When one or more points were measured in the wrong direction, Magnifi cannot build the 

sizing curve and will generate an error message.  

In the image on the right, the arrow is pointing from the liftoff signal to the defect signal, which is correct. 

However, in this picture, the arrow starts quite far from the middle of the liftoff variation signal, which 

will cause an error in the measurement. In this case, we suggest you move the cursors until your 

measurement is taken from a point near the base of the signal.  
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To adjust your sizing curves and remove the error messages, go the Calibration tab, and click on View 

Curves.  

  
 

 

The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the 

drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t 

entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually, 

enter the value in the table.  

In the above example, the entered phase angle for the 40% defect is 300˚, but the correct phase angle for 

the 40% defect is 120˚. The 40% defect has 180˚ bias due to an incorrect measurement direction. In this 

case, we can simply change the angle value from 300˚ to 120˚ in the table to fix the sizing curve. 

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the 

Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not 

appear, it means that you are not in a channel where a sizing curve was set.  

LANDMARKS 

The following section describes how to calibrate your landmarks. 

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks 

window the same way you calibrate the sizing curve(s) points. You can use the Land channel to do so.  The 

positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the far side 

tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside 

tubesheet). 

Once the landmarks are calibrated properly, the system should be able to recognize them automatically.  
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Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far 

end of the tube is needed.  

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file. Note that when 

data is saved, the setup is also saved with it.  

You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  
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INSPECTION 

STANDARD ACQUISITION 

The following section describes how to perform an inspection. 

1. Connect Magnifi to the instrument 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the DefHi® probe into the Ectane 160-pin connector. The orange dot on the connector must 

be aligned with the orange dot on the Ectane. 

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Push the probe all the way through the tube until it exits the far end.  

6. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

7. Pull the tube towards you at a constant speed (approximately 12’’/s or 300 mm/s) until it exits 

the tube.   

8. When finished, press the Stop button or again F2 on your keyboard. 

9. Repeat steps 4,5 and 6 for all the tubes to inspect in your bundle.  

MANUAL SEQUENCE 

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and 

can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are 

needed to use this feature. These landmarks can be created by using the Landmarks button under the 

SMART Setup tab.    

To set the manual sequence: 

1. Click on the Manual Sequence button under the Calibration tab.  

2. If a warning message is shown in this window, change the parameters until no warning are 

shown. The system will progress through the different windows to guide you.  

3. Click on Settings … 
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4. Select Landmark in the Type section 

5. In the drop-down menu choose the Landmark that will initiate the data recording. If you keep 

the default landmarks, you can select the Exit landmark that will be triggered when the probe 

goes out of the tube when the probe is pushed.  

6. You can enter a delay to start the acquisition after the first landmark is detected (Start 

Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop 

Acquisition Delay).  

7. Two options are available to restart the acquisition: The user can either push a button or use a 

timer. Select the desired option in the Restart section.  

8. Click on OK. 

To use the manual sequence: 

1. Connect Magnifi to the instrument 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the DefHi® probe into the Ectane 160-pin connector. 

4. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Open the Sequence window by clicking on the Manual Sequence button under the Calibration 

tab 

6. Put your probe in the tube to inspect and click on the Launch button. This will start the data 

acquisition. 
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7. Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the 

landmark and this will initiate the data recording.  

8. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection 

that will stop the data recording. 

9. Acquisition restart: 

a. If you selected User Input in the settings of the Manual Sequence Configuration, the system 

will wait for the user to enter information on the tube to restart the acquisition. Click on 

NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition. 

Repeat steps 6, 7 and 8. for all the tubes to inspect 

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown 

will trigger after the last tube acquisition was taken. The acquisition will start after this time 

has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.  

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is 

the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube. 

In this situation, you can click on the Target button in the Sequence window to start the data recording. 
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DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  

 

The list of tubes is also shown in the Data window.  

 

A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

go out of acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon.  

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A tube name can be changed by right-clicking on its name and by selecting the Rename option.  
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LOADING A FILE 

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the 

Home tab. 

2. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  

To add an indication to the data: 

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  

 

Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is 

explained in the SMART Setup section of this manual. 
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Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab. 

 

REPORT TABLE 

To access the list of indications entered: 

1. Make sure that the Report option is selected under the Layout tab.  

  

2. Click on the report ribbon at the bottom of the screen to make the list visible 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  

2. Click on the Generate Report button under the Report section of the General tab. 

3. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tube in each category.  



181 

 

  
4. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 

 

The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 
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The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro. 
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RFT Application Guide 
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INTRODUCTION 

This document presents how to use an RFT probe with Magnifi 5 on an Ectane test instrument.  

Eddyfi offers four types of RFT probes. The following was made using a dual-driver probe (RFT-DDST) but 

can also be applied to all other types of RFT probes. 

EQUIPMENT 

The RFT probes use a 19-pin connector that can be connected to an Ectane with the ‘’ERNM’’ option. The 

absolute and differential signal from the probe will provide Strip charts, Lissajous and Voltage planes. 

A wide range of probe diameters are offered (see the tubing probe catalog for more details). A wide range 

of frequencies are also available to allow inspections of tubes of different thickness and material.  

From the following table, the best probe for your application can be selected.  

 

Table 8 – RFT-DDST probes diameter selection table 

 

Table 9 – RFT-DDST probe frequency range selection table 
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Table 10 – RFT-DDST Frequency range 

 

The RFT calibration tube used in this document includes the following indications: 

• External groove, 40% and 60% of wall loss 

• Hole, 100% of wall loss 

• OD Flat Bottom Hole (FBH), 60% depth 

• OD 4 x FBH, 20% depth 

• A support plate 

Other combinations can be used to calibrate the probe and to build sizing curves.  

Note: Fill factor and selection tables may differ for other types of RFT probes. Please refer to the tubing 

probe catalog on our website to find out more.  
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of files. The first level is the Project. It is meant to include different inspections 

that are related in some way. For instance, it can include all the inspections done at a refinery shutdown 

and be named Refinery_Shutdown_May_2018. The second level of file is the Inspection folder. Inspection 

folders are saved in the project file. An inspection folder can include the data specific to the inspection of 

a tube bundle with a specific technology and could be named CS_075x0.083_RFT, for instance. This 

inspection folder groups the setup, the tube list, the data files and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage.  You can select an existing 

project/folder or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your project file. Select 

New, Folder and enter the chosen name. You can then select the newly created folder and click 

on Select Folder.  
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your 

inspection.  

 

 
3. Click Select. This will define the position where the setup(s) and data will be saved. 
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SETUP WIZARD 

In this section, we will show how to create a setup using the Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement 

for imperial units is inches.  When finished, click on Preferences again to go back to the General window.  

 

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to 

start the Setup Wizard. 
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COMPONENT DEFINITION 

The first page shown by the Setup Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is 

used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on 

this material.  

It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 
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You will be back to the Component Definition window. If you added a new material, it will now be available 

in the material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube’s outer diameter and length. 

These tube properties will help Magnify to suggest the optimal scan parameters. 

Click Next when everything is set correctly. 
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PROBE SELECTION 

In the Probe Selection window, select the probe you will be using for your inspection. 

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu. 

More precise filtering can be done by using the Model drop-down menu.  You can then select your probe 

by its catalog number (PRBT-RFT-DDST) and then click Next. 
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SCAN DEFINITION 

The Scan Definition window is used to configure the axial position measurement method, the acquisition 

rate and the typical probe speed.  

 

The position along the tube can be defined by using either the internal clock of the system, or by using an 

axial encoder. If you use the internal clock, the default position will be given assuming that the probe is 

always pulled at the typical probe speed. If the typical probe speed is set to 200mm/s, and the time since 

the acquisition began started is 2 seconds, then the system will indicate a position of 400mm. Using an 

encoder will give you the exact position of the probe. Note that the position can also be obtained by using 

the landmark tool, but this feature will be shown later.  

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate 

is set to 800 Hz for RFT, but depending on the drive frequency used to inspect, the actual acquisition rate 

may differ. The system will automatically readjust this value if needed.  

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an 

acquisition rate of 800 Hz, the pulling speed needs to be less than 400mm/s to have at least 2 points per 

millimeter. If you do not use a pusher-puller device such as Probot, the pulling speed won’t be constant. 
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Therefore, it is recommended to target a lower pulling speed to be able to reach your axial resolution 

target.  The typical probe speed should be set as close as possible to the real value. This will help the 

algorithm that automatically detects landmarks (this will be explained in the Landmark section). The 

recommended pulling speed for RFT depends on the excitation frequency (set in the next step) and is 

shown in the table below: 

Excitation Frequency (Hz) Maximum  
pulling speed (in/s) Maximum Minimum 

20 100 4 

100 200 6 

200 350 8 

350 500 10 

500 1000 12 

1000 - 20 

If you selected to measure the position from Encoder, different fields will appear and a second Scan 

Definition page will become available.  

  

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered. 

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the 

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition 

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a 

speed exceeding the Maximum probe speed, there will be gaps in the data. 

The second page includes the type of encoder and its resolution. A preset can also be specified if your 

acquisition doesn’t start at 0 mm.  

Click Next when you’re finished. 
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DATA DEFINITION 

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute 

and Differential channels. It is important to set these parameters correctly before acquiring the data since 

they are driven by the instrument and cannot be modified during the analysis.  

 

By default, Magnifi suggests a frequency theoretically calculated with the tube parameters previously 

entered.  

The frequency and drive voltage can be changed by replacing their values in the Required frequencies 

table. Up to four frequencies can be set at the same time. And the sum of their amplitude cannot exceed 

10V. 

Make sure that the frequencies are within the probe limits that you can find in Table 3. If the suggested 

frequency is not within the recommended probe frequency range, it means that either the probe that you 

are using is not appropriate for your tube or that one of the tube parameters previously entered was not 

set correctly. 
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Another thing to consider when selecting the frequency is the frequency of the power outlet at the 

location where you are performing your inspection. Under a certain frequency, it is recommended to 

avoid the harmonics of the outlet frequency to prevent noise issues. The figures below indicate which 

frequency to avoid. 

 

Recommended frequencies for power outlet at 60Hz 

 

Recommended frequencies for power outlet at 50Hz 

Click on Next when the desired parameters are entered.  

The next window is used to build mixed channels. Mixes are processed channels that are mainly used to 

detect indication close to support plates. They are built with two frequencies of the same channel type to 

attenuate the effect of the support plate and to be able to size an indication at this location more 

accurately.  
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If you do not wish to use mixed channels, click on Next.  

To add a mixed channel, click on the Add button. A new line will appear. Choose from which input you 

want to use the mixed channel. Note that Input Channel 2 must have a lower frequency than Input Channel 

1. Mixed channels can be built for both absolute and differential channels.  

You can rename the mixed channel output by modifying the Output Mixed Channel field. 

The mixed reference signal (usually a support plate signal) will be used to calibrate the mix channel. The 

system will apply processes to the chosen input channels and will subtract them to attenuate the 

reference signal.  

Click on Next. 
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DATA PROCESSING 

The Data Processing window is used to configure the signal processing to apply to the channels.  

You can choose to configure every frequency individually or you can apply the same filters to every 

channel with the Individually configure all the channels check box.  

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can 

be changed without any problem during data analysis, while wrong parameters choice for the data 

acquisition can mislead the analysis. It is possible to change the filters parameters after data acquisition, 

so it is always possible to fine tune the filters parameters during analysis. 

 

The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful 

when your defect signal has a lower frequency content than the background noise. In this case, using a 

filter will remove part of the noise without removing the defects signals. This may help with data analysis. 

However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too 

low will filter out the defect’s signals.  

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of 

the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of 

high-pass median filter should be set to at least three times the axial length of the longest flaw that may 

be encountered. Data should be examined in both its filtered and unfiltered states. It is important to keep 
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in mind that the median high-pass filters can distort phase. More information about median filters for 

NDT analysis can be found on Eddyfi’s blog.  

Click Next when you are done.  

 

CALIBRATION POINTS 

The Calibration Points page is used to define the points in your calibration tube. These indications will 

later be used to calibrate your probe and to build sizing curves.  

The units of measurement can be set in percentage or in depth (millimeters or inches).  

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and 

size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s). 

However, it should be note that RFT doesn’t allow an indication side differentiation.  

Calibration points can also be imported with the Import button.  
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Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).  

CALIBRATION 

The Calibration page is used to define the calibration method that will be used to set the amplitude(s) and 

phase(s) of a channel using the selected measurement method.  

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 90° on the differential 

channel. The calibration can be done differently on each channel type. It can also be done individually for 

each frequency by selecting the Individually configure all the channels option. Different reference signals 

can be set to calibrate the phase and the amplitude independently.  

 

You can use a voltage plane for the absolute channel(s) by selecting the Use Voltage Plane representation 

for absolute (ABS) channels option. This option is selected by default. Voltage planes are polar plot in 

which theoretical curves show the effect of depth variation on the signal. They are used with RFT to 

estimate the depth and coverage of a flaw. More information on these views can be found in Appendix 1. 

The voltage plane option will allow you to use the functions offered by Magnifi to match the signal with 
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theoretical curves. With this option, calibration settings will be grayed because the calibration can’t be 

done with a single reference point when using a voltage plane.  

A second option can be selected if voltage planes are used (Link differential (DIF) channels rotation and 

gain to the absolute channel (ABS) normalization). This option links the absolute and the differential 

channel. When an inspection is performed, certain tubes can have properties that are different from the 

calibration tube. This will change the operation point position and the built sizing curves won’t be 

applicable to the inspected tube. Bringing back the operation point to a reference point makes the sizing 

curves compatible again. Automatic and manual functions can be used to do this operation. With the 

second option checked, the gain and phase rotation applied on the absolute channel will also be applied 

to the differential channel. If this second option is not selected, the adjustment of the differential channel 

will be done separately. The ways to perform these adjustments is explained in the Inspection section of 

this document.    

If the voltage plane option is not checked, the absolute channel will be calibrated with the reference 

signal(s) selected in the calibration page.   

When you select the reference signal, the system will use the selected measurement method to apply a 

rotation and a gain. Here is a short description of the available options: 

1. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

2. Absolute Horizontal (AH):  

Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

3. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

4. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 

5. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

6. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

7. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Only used and recommended for absolute signals. 

8. Average Peak Horizontal (MPH):  
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Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 

9. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

10. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

11. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

12. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

13. Peak to peak First Transition (PPF):  

Uses the combination of the vertical and horizontal component of the first transition of the signal 
to measure maximum amplitude. The firsts signal transition is from the base of an indication to 
its peak. 

 

Click on Next went the parameters in the table are set according to your requirements. 

 

SIZING CURVES 

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this 

table.  
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The sizing curve will allow you to estimate the size of a defect based on the calibration points signals 

(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw 

size base on the built sizing curves. 

Sizing curve names are customizable. The channel source and measurement type can also be changed. 

You can add sizing curves by clicking on the Add button. 

Click Next when you are done. 

For every sizing curve created in the last window, a window will appear to configure the curve properties. 

The name of the curve will be shown in the upper left corner of the page (ABS in the example below).  
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The measurement methods options are the same as what is described in the calibration section of this 

document. By default, the Peak to Peak First Transition (PPF) option is set for absolute channels, and the 

Peak to Peak (PP) option is used for the differential channels.  

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of 

the available options: 

1. Best Fit (Dual linear) (for phase measurement only):  

A curve with two linear segments representing ID and OD (or Near and Far) side calibration 

points with respect to phase. 

2. Best Fit (Dual Slope) (for phase measurement only):  

A curve with two segments representing ID and OD (or Near and Far) side. The ID section is 

linear and the OD section is polynomial. The OD side of the curve will need at least three points 

(including the hole) in order to trace a polynomial curve. 

3. Best Fit (Polynomial) (for phase and amplitude measurements):  

Best polynomial (degree 2) interpolation within the measured (requiring at least three points). 
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4. Connected Points (for phase and amplitude measurements):  

Simple, point-to-point curve. 

5. Best Fit (Linear) (for phase and amplitude measurements):  

Best linear interpolation within the measured calibration points 

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements): 

Polynomial (degree 2) interpolation with two segments for both ID and OD sides of the curve. 

Need at least three points.  

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial) 

option is a more precise method when your calibration tube has multiple defects. 

Once the measurement method and the interpolation curve shape are chosen, you can select the curve 

points for each sizing curves previously created. The order in which the points appear in the list will 

influence your curves. Make sure that the measured values of the calibration points are in the desired 

order. You can use the Reverse order points option to associate the deepest flaw with the smallest 

measured value. 

For the absolute channel(s), two additional extrapolated curves will be created by default for each sizing 

curve. These curves will give the depth of a flaw that is considered Long or Taper. A description of these 

types of flaws can be found in Appendix 1. 

 

You can set Magnifi to show the remaining wall instead of the defect size by checking the box Report as 

remaining wall thickness. 

Click Next when you are done.  
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INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Next when you are done 

DISPLAY 

The first Display window is used to set how the data is displayed during and after the acquisition.  
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The scroll direction is the direction in which data appears on the screen. If you choose downward, the 

signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal 

will go from the bottom to the top of the screen.  

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box. 

The strip chart duration is the length of a Strip chart window when the data is acquired. 

Click Next. 

The second Display window is used to set the layouts. Checking the tick boxes in this window will make 

the proposed layouts in your setup. You will be able to switch from one to the another via the layout tab. 

The " C " stands for Code, " S " stands for Strip chart, " L " for Lissajous and " V " for Voltage plane. 

The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 

Layouts can be readjusted at any time.  
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Click Next to complete the setup wizard process. 

 

SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the 

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change.  

 

This will open one of the windows previously described, where you can change the the values you 

originally entered. If applicable, go through the process by clicking on Next, and then click on the Finish 

button. This will apply the modification to the setup.  
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Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed 

using these advanced settings, the information shown using the Setup tab may not match your actual 

setup.  

 

SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 

 

The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 
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The following table shows the possible icons and their meaning: 

Icon Description Meaning 

(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 

 

 

Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 

detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 
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Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 

LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools. 

 

The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can however give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 
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Three landmarks are created if you press on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position) or on the place you stop to record (usually the 

operator side). 

 

 

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 

Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. And the Threshold is the voltage amplitude threshold. 



214 

 

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the right position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates don’t need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tubesheets). 
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If you are using the conventional detection tools, you can set up the regions according to the automatic 

analysis tools you will use with the Indications and DVQ buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view. 

 

 

There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

 

And seven waveform types: 

 Up 

 Down 

 Down-up 
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 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 

 

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 

 

 

DATA QUALITY VALIDATION (DQV) 

Data Quality Validation allows defining tests to validate the quality of the data. 
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Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 

 

• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-length of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 

• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows group a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together for which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 
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GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications.  

 

The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 
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The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 

Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 
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It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 

 

Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUT 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 
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DATA LIST 

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.  

This list can be created in the Data List section of the General tab of the Backstage. 

 

 

 

Four options are available to set the filename format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

Click on the Create New List button. The displayed window will be different depending on the chosen 

filename format. 

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 

then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 

generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 

list.  
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The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the Data window of the Frontstage. 

The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software 

(available from Eddyfi).  
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PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button. 

2. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect and 

then click on Connect. 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To download 

a matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  

 

 

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used to 

scan your calibration tube and make the necessary adjustments on your setup without saving the data 

automatically. Acquisition mode is used for the inspection. In this mode, the software automatically saves 

the acquired data using file names based on the tube list.  
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

4. Plug the RFT probe on the Ectane 19-pin connector.  

5. If you wish to balance, bring the probe head in a clear area in your standard and balance the 

probe by clicking on the Null button under the Home tab, or press F6 on your keyboard. 

6. Push the probe head all the way through the tube so that it exits the tube. 

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

8. Pull the calibration tube at the appropriate speed 

9. When it’s done, press the Stop button or F2 again on your keyboard 

 

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually 

the case when your probe is out of the tube.  

VISUALIZING THE DATA 

Multiple options are available to select your data and to measure it. The following describes useful 

functions to do so: 
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DISPLAYED CHANNEL 

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons 

are used for the channel selection. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 

are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 

channel.  

 

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 

desired channel to select it. Right-click or Left-click on this button to switch to the following or 

previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential) 

4. Same principle as 2., but for the frequencies only 

STRIP CHART AXIS ORIENTATION 

The Strip charts are a projection of the Lissajous on the vertical or horizontal axis. To switch from one axis 

to another, click on the box showing an arrow at the upper right corner of the Strip chart.  
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ZOOMING 

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this 

section. 

 

 

 

 

 

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.   
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ADJUSTING THE CURSOR LENGTH 

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and 

the full line is the center of what you have selected.  

Only the portion of data between the dotted lines will be shown in the Lissajous.  

To adjust your cursor length, hover your mouse over the dotted line, and click and the left mouse button. 

This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same operation, but 

with the right button of your mouse.  

ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  

 

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 

MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method. 

A short description of the measurement methods can be found in the above calibration section of the 

setup wizard.  

 

1. Clicking on the corner with the black triangle gives the list of measurement method for the 

amplitude of the signal. Click on the desired method to select it. Right- or left-click in this button 

to select the next or the previous method in the list.  

2. Same as 1., but for the phase measurement 
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3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure 

the phase with the right orientation.  

4. Take the same two points in time to take the measurement in the other Lissajous 

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 

a vector in your Lissajous.  

LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the 

signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.  

The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   

DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and use the spacebar on the keyboard.  
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CALIBRATION AND SIZING CURVES 

FREQUENCY VALIDATION 

The injection frequency (set in the Data definition section) will influence the phase angle separation 

between flaws of different depth. It can also affect the signal-to-noise ratio of certain flaws.   

If this frequency is too low, the phase angles of your flaws will be close to each other. Therefore, it will be 

difficult to build accurate sizing curves because a small variation of the phase will lead to a significant 

change of depth estimate.  

Multiple methods can be used to validate that the injection frequency was correctly set. Here’s two of 

them: 

• There is approximately 1° per percentage of wall loss between two grooves of different depth. 
The two grooves must not be too close in terms of depth.  

• There is approximately 65° between a through wall hole and a 4 x FBH 20% depth 

With Magnifi, the automatic calibration process can also recommend you the right injection frequency. 

You can go through these steps (described later) before adjusting your frequency.  

To adjust the injection frequency: 

1. Click on the Data button under the Setup tab.  

 

 

2. To increase the phase angle spread between your flaws, increase the injection frequency. 

Decrease the injection frequency to lower the phase angle spread. Refer to the figures below for 

the frequencies to avoid.  

3. Click on Next and then click on Finish 

4. Rescan your calibration tube  

5. Verify that your injection frequency is right 

6. Redo step 1 to 5 until you have an acceptable frequency 

CALIBRATION BASED ON SCALE PROCESS 

The following section describes how to calibrate the channels that don’t use a voltage plane. 

1. Go to the Calibration tab and click on the System icon. 

2. Select Channel in the calibration window. 

3. In the Strip chart, select the signal to calibrate and adjust the cursors to see only the desired 

signal.  
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Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

 

4. Select the signal name in the list. 

5. Click on the green arrow button to associate the measured signal to the calibration point. 

6. If more than one calibration point is present in the list, redo step 3, 4 and 5 for all of them. 

7. When all your calibration points are check marked, click on the Calibrate button. 

 

CALIBRATION BASED ON VOLTAGE PLANE PROCESS 

The following section describes how to calibrate the channels that use a voltage plane. Magnifi offers two 

methods to do this operation.  

MANUAL METHOD 

1. Put your cursor in a sound area of your calibration tube.  

2. Click on the normalize button in the voltage plane window. This should bring the operation point 

of the probe to the theoretical nominal point on the Voltage plane.  
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Since this operation depends on how the probe was built, it is possible that the operation point of the 

probe doesn’t reach the theoretical nominal point. If this is the case, right-click on the voltage, click on 

the Reset Nominal button and continue to the next step.  

3. To adjust the signal manually, Magnifi uses a vector drawn by the user that represents the effect 

of a completely blocked signal. This vector must start at the operation point of the probe and 

must go in the direction of the support plate. Its length must initially be set to twice the length 

of the support plate for a dual driver probe. For a single driver probe, it must be set to the 

length of the support plate. To draw this vector, click on the manual measurement button " M ", 

click on the operation point of the signal, hold the left button of the mouse and drag it to the 

desired location. Once the vector is correctly drawn, click on the normalise button again. 

Magnifi will put the origin of the vector to the theoretical nominal point. It will apply a gain of 

1/(vector amplitude) and a phase rotation of –(vector phase). If, for instance, the drawn vector 

as an amplitude of 0.8 and a phase angle of 10 deg, the system will apply a gain of 1.25 (1/0.8) 

and a rotation of -10 deg to the system.  

  
 

4. The signal may not be perfectly adjusted after the previous steps. You can adjust the signal again 

by drawing a new vector and by clicking on the normalization button until the signal is set 
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correctly. In the examples below, the calibration tubes included two 360° grooves and we can 

see that both grooves reach the theoretical 360° coverage line. This can be a relevant indication 

to determine if a voltage plane is calibrated correctly. 

 

 
Dual driver probe 

 
Single driver probe 

 

5. Save your calibration by clicking on the Save Nominal button 

 

You can go back to your calibration settings at any time by clicking on the Back to Nominal button. 

 

AUTOMATIC METHOD 

Another way to calibrate a voltage plane in Magnifi is to use the automatic calibration tool. This feature 

requires the following indications: 

• One point of type [360°, non-taper] or 

• Two points of types [360°, taper] or [non-360°, non-taper] 

• A support plate signal 

• A nominal point 

Also, one point must be 360° and one must be non-taper.  

To define the calibration point that will be used by the algorithm, go to the RFT tab and click on Calibration 

Settings.  
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1. Checkmark the raw channel(s) that will be used to calibrate the signal.  

2. Select from the drop-down menus the signal name that corresponds to your nominal point and 

to your support plate (If these signals were not created, you can go back to the Calibration 

Points window via the Setup tab). 

3. Click on Add and select the reference signals that will be use by the algorithm 

4. In order to make the algorithm work, the user must associate the calibration points to the real 

signal. This operation is done at the same time as the sizing curves calibration process. Go to the 

Sizing Curves section of this document and follow the steps using the signals entered previously. 

This will trigger the automatic calibration.  

Tip: For the calibration, when selecting the support plate with a dual-driver probe, it is recommended to 

take the straight part of the signal that goes from the nominal point to the first signal transition. 
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5. Once the automatic calibration process is done, the system may recommend you a drive 

frequency. If this is the case, you can change your frequency, rescan your calibration tube and 

repeat the previous steps. 
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The automatic calibration will give you access to the Frequency Check option that can recommend you 

another inspection frequency in case the inspected tube has properties that are too far from your 

calibration tube. This feature is shown in the inspection section of this document.  

Note that the automatic calibration tool doesn’t only adjust the signal to match theoretical curves, but it 

also dynamically compensates the change of tube properties by recalculating the theoretical curves. This 

increases the precision of the sizing.  

It is possible to use the automatic calibration and the manual calibration on the same setup. The automatic 

calibration process will create a new channel with which the calibration curves will be readjusted 

according to a theoretical model. The newly created channel(s) will have the letter " m " (for model) added 

at the end of the channel name (example: ABSm-F1 for absolute channel with frequency 1).  

NOMINAL POINT VARIATION TOLERANCE 

After scanning a tube, you can select a sound point in the data and click on the normalize button in a 

voltage plane. This will bring this point to the nominal theoretical point. The angle correction will then be 

shown at the lower left corner of the voltage plane window. It will become red If it’s not within an 

acceptable range. To set this range, click on the voltage plane window, go in the Current View tab and 

enter the value in the Tolerance parameter. 

 

SIZING CURVES 

The following section describes how to build your sizing curves. 

1. Go the calibration tab and click on the Sizing curve button 

2. Select Channel and Sizing Curves in the calibration window 

3. Select the signal in your Strip chart and adjust the cursors to see only the desired portion of the 

signal. 

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration points. This will allow you to see what the system is using to make its 

calibration. If for some reason the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to 

show the defect size. To have the correct interpolated value, the measurement method also needs to be 

the same as the one used for the sizing curve. To change the measurement method, click on the icons at 

the bottom left of the Lissajous. 
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4. Select the associated signal name in the list. 

5. Click on the green arrow. 

6. Redo the previous steps for all the other indications in the list. 

7. Click on the Calibrate button. 

 

 

Error messages after creating the phase sizing curves may appear. The main cause of these errors is the 

measurement direction.  

The image below shows two different measurements. On the left, you can see that the measurement 

arrow is pointing toward the liftoff signal. In this case, the measured phase is rotated of 180˚ from the 

right value. When one or more points were measured in the wrong direction, Magnifi cannot build the 

sizing curve and will generate an error message.  

In the image on the right, the arrow is pointing from the liftoff signal to the defect signal, which is correct. 

However, in this picture, the arrow starts quite far from the middle of the liftoff variation signal, which 

will cause an error in the measurement. In this case, we suggest you move the cursors until your 

measurement is taken from a point near the base of the signal.  
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To adjust your sizing curves and remove the error messages, go the Calibration tab, and click on View 

Curves.  
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The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the 

drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t 

entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually, 

enter the value in the table.  

In the above example, the entered phase angle for the 40% groove is 270˚, but the correct phase angle is 

90˚. The defect has an 180˚ bias due to an incorrect measurement direction. In this case, we can simply 

change the angle value from 270˚ to 90˚ in the table to fix the sizing curve. 

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the 

Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not 

appear, it means that you are not in a channel where a sizing curve was set.  

 

Built sizing curves can give you access to the phase-depth indications on the Lissajous and the Strip Charts. 

To activate this option, click on a window (Strip Chart, or Lissajous), go to the Current View tab and check 

the Depth-P. option.  
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LANDMARKS 

The following section describes how to calibrate your landmarks. 

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks 

window the same way you calibrate the sizing curve(s) points. You can use the Land channel to do so.  The 

positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside 

tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside 

tubesheet). 

Once the landmarks are calibrated properly the system should be able to recognize them automatically.  

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far 

end of the tube is needed.  

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file. Note that when a 

data is saved, the setup is also saved with it. 



245 

 

 

You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  

INSPECTION 

STANDARD ACQUISITION 

The following section describes how to perform an inspection. 

1. Connect Magnifi to your instrument. 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the RFT probe into the Ectane 19-pin connector.  

4. If you wish to balance, bring the probe head to a clear area in your standard and balance the 

probe by clicking on the Null button under the Home tab, or press F6 on your keyboard.  

5. Push the probe all the way through the tube until it exits the far end and start the acquisition by 

clicking on the Acquire button under the Home tab or by pressing the F2 on your keyboard. 

6. Pull the probe towards you at a constant speed until it exits the tube. 

7. When finished, press the Stop button or again F2 on your keyboard. 

8. Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.  
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MANUAL SEQUENCE 

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and 

can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are 

needed to use this feature. These landmarks can be created by using the Landmarks button under the 

SMART Setup tab.   

To set the manual sequence: 

1. Click on the Manual Sequence button under the Calibration tab.  

2. If a warning message is shown in this window, change the parameters until no warnings are 

shown. The system will progress through the different windows to guide you.  

3. Click on Settings … 

 

 

 

 

4. Select Landmark in the Type section. 

5. In the drop-down menu choose the Landmark that will initiate the data recording. If you keep 

the default landmarks, you can select the Exit landmark that will be triggered when the probe 

goes out of the tube when the probe is pushed.  

6. You can enter a delay to start the acquisition after the first landmark is detected (Start 

Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop 

Acquisition Delay).  
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7. Two options are available to restart the acquisition: The user can either push a button or use a 

timer. Select the desired option in the Restart section.  

8. Click on OK. 

To use the manual sequence: 

1. Connect Magnifi to the instrument 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. The 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the ECT probe into the Ectane 4-pin connector. 

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Open the Sequence window by clicking on the Manual Sequence button under the Calibration 

tab. 

6. Put your probe in the tube to inspect and click on the Launch button. This will start the data 

acquisition. 

7. Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the 

landmark and this will initiate the data recording.  

8. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection 

that will stop the data recording. 

9. Acquisition restart: 

a. If you selected User Input in the settings of the Manual Sequence Configuration, the system 

will wait for the user to enter information on the tube to restart the acquisition. Click on 

NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition. 

Repeat steps 6, 7 and 8a. for all the tubes to inspect 

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown 

will trigger after the last tube acquisition was taken. The acquisition will start after this time 

has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.  

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is 

the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube. 

In this situation, you can click on the Target button in the Sequence window to start the data recording. 

DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  
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The list of tubes is also shown in the Data window.  

 

A common practice is to rescan your calibration tube and balance the tube periodically. You can save this 

new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can go out 

of the acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration tab 

to save your data. You can then go back to acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon.  

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A TUBE NAME CAN BE CHANGED BY RIGHT-CLICKING ON ITS NAME AND BY SELECTING THE RENAME OPTION. 

FAST NORMALIZATION SETTINGS 

The opened data may not have been already adjusted to match your sizing curves. Magnifi offers a tool 

to do these adjustments in an efficient way.  
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Go the RFT tab and click on the Settings button. The displayed window will show the channels using 

voltage planes and standard scale process.  

 

The channels using a standard scale process will only be shown if the option to link the differential 

channels to the absolute was not selected in the Calibration part of the setup wizard. 

 

Keyboard shortcuts next to the channels can be customized to normalize the associated channel. To 

normalize the process using a voltage plane, select a sound area in the tube and push on the keyboard 

shortcut. To normalize the channels using a standard scale process, select the reference (normally a 

support plate) and click on the keyboard shortcut. The system will adjust the selected reference to the 

value set in the RFT Normalization Settings window (Amplitude and Angle). 
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LOADING A FILE 

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the 

Home tab. 

2. You can load a file by double-clicking on the file name in the Data window. It can also be done by 

selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  

To add an indication to the data: 

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is 

explained in the SMART Setup section of this manual. 

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab 

 

REPORT TABLE 

To access the list of detect entered: 

1. Make sure that the Report option is selected under the Layout tab.  

 

2. Click on the report ribbon at the bottom of the screen to make the list visible 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  

2. Click on the Generate Report button under the Report section of the General tab. 

3. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tube in each category.  
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4. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 

 

The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 
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The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro. 
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APPENDIX 1 – VOLTAGE PLANE 

The two following equations describe the through-wall transmission behavior of RFT: 

The phase lag equation shows that the signal is influenced by the tube properties (d, ) but  

 

also depends on the frequency (f) at which the tube is inspected. Given a tube of constant permeability 

and conductivity, and using a fixed inspection frequency, the phase lag will be proportional to the 

thickness of the tube.  

The magnetic field strength (B) will depend on this phase lag. For an infinite theoretical thickness, the 

resulting magnetic field will be null. The explanation being that the field is completely blocked and that 

nothing is caught by the receiver(s).   

The voltage plane is a graphical representation of these formulas. The curves built on a voltage plane show 

the effect of the thickness variation on the signal. There are four curves that represent a flaw coverage of 

90°, 180°, 270° and 360°. The point crossing the horizontal axis is the nominal point. This is the signal 

obtained when the probe is in a sound area of the tube. It has an amplitude of 1V and a phase of 0°.  
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When you first scan your calibration tube, this point doesn’t match the nominal point of your theoretical 

curve. You must calibrate the signal to match your probe signal to the theoretical curve(s). This operation 

is called normalization.  

A bundle of tube may include tubes that have different properties. The permeability, for example, may be 

different for some tubes. This will affect the nominal point position and the built sizing curves won’t be 

applicable to this tube.  

If the nominal point moved not too far from the theoretical nominal point, the common practice is to 

renormalize and to size the flaw with the built sizing curves.   

If the nominal point moved far from the theoretical value, it means that the tube properties are 

significantly different from the calibration tube. Therefore, the phase lag for a given flaw will also be 

significantly different and this will generate an error in the sizing that must be considered. In this case, it 

is recommended to change the drive frequency to put the nominal point back to the renormalization zone.  
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A common practice is to set the threshold angle at which the inspection frequency needs to be changed 

to 30°.  
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RFA Application Guide 
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INTRODUCTION 

This document presents how to use an RFA probe with Magnifi 5.1 on an Ectane 3 instrument. 

EQUIPMENT 

The RFA probes use a 41-pin connector that can be connected to an Ectane 3 with the ‘’E64RNM’’ or the 

‘’E128RNM ‘’ option.  

Magnifi acquisition and analysis software version 5.1 or greater must be used. A license allowing for tubing 

array techniques is required. 

Possible probe diameters are offered from 11.0 mm to 23.0 mm in 0.5 mm increments. It is recommended 

to use the largest diameter possible. This will decrease the lift-off and improve performance. You can refer 

to the table below for the recommended diameters depending on the size of the tube to be inspected.  

The center frequency of the probe is 300 Hz and it should be used with frequencies ranging from 50 Hz to 

2 kHz. 

From the following table, the best probe for your application can be selected.  

 

 

The RFA calibration tube used in this document includes the following machined defects and features: 

• External grooves, 20%, 40% and 60% of wall loss 

• Flat bottom hole, 60% of wall loss 

• Hole, 100% of wall loss 

• A support plate 

RFA PROBE DESCRIPTION & CHANNELS  

The RFA probe includes 2 drivers at each end of the probe head. The driver on the cable side is named the 

Lead since it is the first to pass under the defects and features when the probe is pulled through the tube. 

The second driver is called the Trail.  
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The probe includes 2 circumferential bobbin coils that create absolute and differential channels, referred 

to as “conventional bobbin channels”, similar to what is obtained with an RFT probe. The absolute and 

differential signals from the bobbin coils will produce Strip charts, Lissajous and Voltage planes. 

Next to these 2 coils is the array portion of the probe. It consists of 2 rows of sensors. The number of 

sensors per row depends on the diameter of the probe. The second row on the cable side is used to create 

the absolute array channels. The differential array channels are obtained by subtracting the signals of row 

1 from row 2. As with conventional channels, the absolute array is used to analyze large volumetric defects, 

such as taper defects for example, and the differential array is used to analyze smaller defects such as pits. 

The channels of the array component of the probe are combined to produce C-Scan imaging. 

 

Note that neither the conventional coils nor the array part is perfectly centered between the 2 drivers. 
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data, 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of files. The first file level is the Project. It is meant to include different 

inspections that are related in some way. For instance, it can include all the inspections done at a refinery 

shutdown and be named Refinery_Shutdown_May_2022. The second file level is the Inspection folder. 

Inspection folders are saved in the project file. An inspection folder can include the data specific to the 

inspection of a tube bundle with a specific technology and could be named CS_075x0.083_RFA, for 

instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

 
 

To create or open a project, click on Open/Add Project in the Backstage.  You can select an existing 

project/folder, or you can create a new folder. 

5. Create a folder by right-clicking on the location where you want to add your project file. Select 

New, Folder and enter the chosen name. You can then select the newly created folder and click 

on Select Folder.  
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6. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of 

your inspection.  

 

 
7. Click Select. This will define the location where the setup(s) and data will be saved. 

 

RFA SETUP WIZARD 

In this section, we will show how to create a setup using the RFA Setup Wizard in Magnifi. 

Before going further, you can select the appropriate measurement unit. To do so, click on Preferences. In 

the System tab, you can change the measurement units from metric to imperial and vice versa. For the 

metric units, you can choose to use meters, centimeters, or milimeters in the General tab. For imperial 

units, inches must be used.  When finished, click on Preferences again to go back to the General window 

of the Backstage menu.  
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To create a new setup, use the RFA Setup Wizard process. Go to the Frontstage by clicking on the blue 

triangle at the top left corner of the Backstage. Then, click on the New button under the Setup tab and 

select the RFA Setup option in the drop-down menu.  

 

PROBE SELECTION 

The first page shown by the RFA Setup Wizard is the Probe Selection page.  

In this window, the probe used for the inspection can be selected, the interaction between the bobbin 

and array channels can be set, and the display and settings for the absolute channel can be changed.  
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CALIBRATION OF C-SCAN IN CAL. TUBE 

In the software, the channels generated from the bobbin coils and the C-scans produced by the array are 

coupled, making the use of the RFA probe very similar to the RFT probe. Adjustments made to the 

conventional channels, such as the normalization of a support plate signal, are automatically propagated 

to the C-scans, allowing for easier analysis with a limited number of operations in the software. 

The Calibration of C-scans option offers 2 possibilities: 

 

 

• Automatic: With this option, the probe is used the same way as an RFT probe would be used. The 

initial calibration of the conventional channels made in the calibration tube is automatically 

applied to the C-scans. Calibration of the C-scans independently from the channels is not possible. 

• Manual: With this option, the C-scans must be calibrated independently from the conventional 

bobbin channels for the initial calibration in the calibration tube. It must be understood that once 
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the initial calibration has been performed, any subsequent change to the rotation or gain made 

to the conventional bobbin channels to adjust the nominal point, for instance, will be 

automatically applied to the C-scans as well. This is true for both options. 

These options will be explained in more detail in the calibration section of this document.  

 

REPRESENTATION FOR ABSOLUTE CHANNELS (ABS) 

The Representation for absolute channels (ABS) drop-down menu allows for the selection of either a 

standard Lissajous plot or a Voltage plane for the bobbin absolute channels. Note that this option does 

not affect the representation for the Absolute C-scans, which always use a Lissajous representation. The 

Voltage plane tool is explained in the appendix.  

 

PROBE SETUPS 

In the Probe Setups section of the window, select the probe model used for inspection. The numbers 

inside the parentheses correspond to the range of probe’s diameter covered with a specific setup. Refer 

to this information to find the appropriate model.  For example, if an 18.0 mm mid-frequency probe is 

used, the PRBT-RFA-DDSA-(180 to 190)MF setup should be selected. 

 

COMPONENT DEFINITION 

The second page shown by the Setup Wizard is the Component Definition page.  
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Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the inspected material is not on the list, go to Backstage and open the Material Database tab. To add a 

new material to the list, click on Add. A new line will appear in the list. Give the material a relevant name 

and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is used to 

set IRIS parameters only, and doesn’t need to be set if an IRIS inspection is not performed on this material. 

It is possible to add optional notes about the material to specify information such as its application or 

composition. 
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Also in the Component Definition page, adjust the tube wall thickness, outside diameter and length by 

entering the values in the designated fields. All the information filled in on this page will be used by the 

software when generating the analysis report. 

The tube length defined here is also used as a default suggestion when enabling the automatic detection 

of landmarks. 

Click Next when everything is set correctly. 

  

SCAN DEFINITION 

The Scan Definition window is used to configure the data acquisition rate of the instrument, the typical 

probe pulling speed, and the acquisition size.  
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The acquisition rate corresponds to the number of acquisition points, or samples, taken per second. By 

default, the acquisition rate is set to 500 Hz for RFA, but depending on the drive frequency used to inspect, 

the actual acquisition rate may need to be changed.  

 

The recommended probe pulling speed for RFA depends on the excitation frequency, as defined in the 

Data Definition page of the Wizard, and is shown in the table below: 

 

Excitation Frequency (Hz) Maximum pulling speed 

Minimum Maximum Imperial (in/s) Metric (mm/s) 

20 100 4 100 

100 200 6 150 

200 350 8 200 

350 500 10 250 

500 1000 12 300 

1000 - 20 500 
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The density, or axial resolution, is the number of samples per unit of distance. This field is non-editable as 

it is a direct result of the acquisition rate and pulling speed combined. Use this information to confirm 

that both parameters are defined adequately.  

A resolution of 2 points per millimeter is typically targeted. Given that the probe speed value is based on 

the excitation frequency, the acquisition rate can be edited to obtain the desired axial resolution. 

For instance, if the pulling speed was set to 300 mm/s, then the acquisition rate should be set to 600 Hz 

to reach a resolution of 2 points per millimeter. 

Note that if a probe pusher-puller mechanism is not used, the pulling speed will not be constant. Therefore, 

it is recommended to target a lower pulling speed to be able to reach the axial resolution target. 

These parameters also serve another purpose. When analyzing a data file where landmarks are not 

enabled or defined yet, the axial position of the cursor in a strip chart is defined assuming a constant 

pulling speed. Therefore, if the cursor is located at exactly 4.0 seconds, and a probe speed of 300 mm/s 

was used, then Magnifi will indicate a position of 1200 mm. This information can be used to axially locate 

features and defects in the tube. 

 

The last parameter that can be edited on this page is the Scan Size or scan duration, in units of time. The 

non-editable field below shows the same parameter in units of distance instead. The scan duration should 

be set to allow for acquisition of slightly longer than the tube length. This additional buffer time will ensure 

that the full tube length is captured even if there are some pulling speed variations and to provide enough 

time to insert the probe in the tube and completely pull it out in the air. For instance, if 30 seconds is 

needed to exactly capture the full 9 m length of tube, then a 40 second acquisition time could be set. 

It is important to note that the acquisition size should not be set more than what is needed, as this could 

result in software memory issues. 

Click Next when finished. 

 

DATA DEFINITION 

The Data Definition window is used to set the hardware gain, excitation frequencies and drive voltages 

(or amplitude). It is important to set these parameters correctly before acquiring the data, since they are 

driven by the instrument and cannot be modified during the analysis.  
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The hardware gain is applied to both the bobbin and the array portions of the probe. 

Two frequencies are always enabled with RFA setups. The table in this window can be used to edit the 

frequencies and drive voltages values. The sum of their amplitudes cannot exceed 10 V. 

 

Selecting an appropriate frequency can be aided with the following equation: 

𝑓 =
40.5 ⋅ 𝜌

𝜇𝑟 ⋅ 𝑡2
 , 

where 𝑓 is given in kHz, 𝜌 is the tube’s resistivity in 𝜇Ω ⋅ cm , 𝜇𝑟 is the relative permeability, and 𝑡 is the 

thickness in millimeters. It is important to make sure the frequency selected is within the probe limits 

found in the table above. Another point of consideration when selecting the operating frequency is the 

frequency of the power transmission lines and outlets in your global region of inspection.  It is 

recommended to avoid the harmonics of the outlet frequency to prevent noise issues. The figures below 

show the frequency ranges for 60 Hz and 50 Hz.  
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Recommended frequencies for power outlet at 60 Hz 

 

 

Recommended frequencies for power outlet at 50 Hz 

 

By default, the RFA probe operates as a dual-driver probe. However, it is possible to turn one driver off to 

use it as a single-driver probe. To do so, select the Lead or the Trail option in the Enabled Drivers drop-

down menu. The Lead corresponds to the driver that is close to the cable; this is the first driver to reach 

a feature when the probe is pulled. The Trail is the driver closest to the tip of the probe. 

If you choose to use the probe in single-driver mode, the Setup Wizard will automatically divide the drive 

voltage values in half for both frequencies, and the amplitudes will no longer be editable. A warning will 

also appear, indicating that these values were adjusted to generate approximately the same driver output. 
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This is done such that the driver signal has approximately the same amplitude, regardless of whether dual-

driver or single-driver mode is used. An example is given below, where the amplitudes of the driver signals 

have roughly the same amplitude (shown with the red dotted line) for both mode settings. Additionally, 

it can be noted that the amplitude of the receiver signal, when the defect passes right under the receiving 

coil, has decreased by half as expected. 
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Should you need to change the drive voltage in single-driver mode, select the option Both, edit the voltage 

value and then select the option Lead or Trail again. 

Click on Next when the desired parameters are entered.  

 

DATA PROCESSING 

The Data Processing section is where post-processing software filters can be activated on the channels of 

the RFA probe.  

The hardware parameters that were defined in the Data Definition page of the Wizard cannot be modified 

once the acquisition is completed. Therefore, it is crucial to validate those values before performing data 

acquisition. In the case of the Data Processing page, the available parameters allow you to enable and edit 

post-processing filters. Therefore, it is always possible to edit these parameters to fine tune the analysis 

after the data acquisition if needed. 

The first page of the Data Processing section presents the list of available C-scans and their filters.  

 

The following table describes each of the C-scans: 
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Name  Description 

F1ABSA-LargeSignal 

Frequency 1, Absolute Array, Large Signal. Dedicated C-scan that should be 

configured (filters values and color palette range) to optimize the analysis of 

large indications such as taper defects  

F1ABSA Frequency 1, Absolute Array, Trail row of sensors (farthest from the cable) 

F1DIFA Frequency 1, Differential Array 

F2ABSA-LargeSignal 

Frequency 2, Absolute Array, Large Signal. Dedicated C-scan that should be 

configured (filters values and color palette range) to optimize the analysis of 

large indications such as taper defects 

F2ABSA Frequency 1, Absolute Array, Trail row of sensors (farthest from the cable) 

F2DIFA Frequency 2, Differential Array 

 

Three types of filters are available. The low-pass filter eliminates part of the signal that is above a certain 

frequency. As an example, it is useful when a defect signal has a lower frequency content than the 

background noise. In this case, using a filter will remove part of the noise without removing the defect’s 

signal. This may help with data analysis. However, a cut-off frequency that is too high won’t remove much 

noise, and a cut-off frequency that is too low will filter out the defect signals.  

The median high-pass filter is used to filter out low frequency noise or drift such as lift-off variations of 

the probe within the tube, or changes in material, geometry, or thickness. As a rule-of-thumb, the window 

size of the high-pass median filter should be set to at least three times the axial length of the longest flaw 

that may be encountered. This rule-of-thumb is specific to what you are looking for with the channel you 

are using. If, for example, you plan to use the differential channel to detect holes, you can adjust this 

setting to about three times the length of the largest hole you are looking for with this channel. The 

window size should be adjusted with care. If it is set too small, it could filter out defects of interest. Note 

that the size of the filter is set in samples and not in mm. For example, if you have set your parameters to 

have 2 samples/mm and you want to enter a length of 300mm, then you should use a value of 600 samples. 

Pilger noise1 is yet another type of noise that can be observed on tubing data that can negatively alter the 

amplitude and phase of the signal. The Periodic filter can be enabled to reduce the effects of this 

phenomenon. Similar to the other filters, there is always a trade-off between the noise reduction level 

and the side-effects of the filter on the indication signals themselves when adjusting the parameters of 

the filter. It is not recommended to apply this filter by default, but it can be used on tube data that contains 

a strong pilgering signal. 

 
1 Pilger noise is caused by the cold pilgering process in which the diameter and wall-thickness of a tube 
are reduced to form seamless metal tubing. Pilger noise is typically seen as spiral-shaped variations on 
a C-scan. Because of the helical shape of pilger noise in the tube, the noise is somewhat periodical, but 
not constant. 
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More details about the adequate configuration of this filter can be found in Appendix 2. 

 

The second page of the Data Processing section presents the list of available bobbin channels and their 

filters.  

 

The following table describes each of the channels: 

Name  Description 

F1ABS Frequency 1, Absolute Bobbin 

F1DIF Frequency 1, Differential Bobbin 

F2ABS Frequency 2, Absolute Bobbin 

F2DIF Frequency 2, Differential Bobbin 

 

Low-Pass and Median High-Pass filters are available for these channels. The comments made for the C-

scan filters above can also be applied with the channel filter. 
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Data should be examined in its filtered and unfiltered states. It is important to keep in mind that the filters 

can distort the phase and change the amplitude of the signals.  

Click Next when finished.  

INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.  

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indication code list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Finish to complete the RFA setup wizard process. 
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SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after completing the Setup Wizard process. To 

modify a parameter previously entered, go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change. 

 

 

This will open one of the windows previously described, where you can change the values you originally 

entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This 

will apply the modification to the setup. 

It is important to note that the parameters defined in the Probe Selection window cannot be changed 

after the initial generation of the setup. If you wish to change the probe model, the Calibration of C-

scans option, or the representation for the Absolute channels, you must create a completely new setup. 

Advanced setup modifications are also possible in the Advanced Setup section on page 315. 

DATA LIST 

Magnifi will save a file for each inspected tube. The file names are defined by creating the list of tubes.  

This list can be created in the Data List section of the General tab of the Backstage. 

 

 

Four options are available to set the filename format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  



279 

 

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

Click on the Create New List button. The displayed window will be different depending on the chosen 
filename format. 

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 
then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 
generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 
list.  

 

 

The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the Data window of the Frontstage. 
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The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software 

(available from Eddyfi).  

 

PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on the Start/Resume button. 
2. Click on the Connect button under the Instrument tab. This will open the Instrument Connection 

window. Click on the line showing the instrument to which you want to connect and then click 

Connect. 

  

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To send a 

matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  
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Two (2) acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is 

used to scan your calibration tube and make the necessary adjustments on your setup without saving the 

data automatically. Acquisition Mode is used for the inspection. In this mode, the software automatically 

saves the acquired data using file names based on the tube list. 

Follow the steps below to perform the acquisition of the calibration standard: 

1. Enable Setup Mode by toggling on the Setup Mode button under the Home tab. This mode is 

active when the button is grayed. 

 

 

 

2. Plug the RFA probe into the Ectane 41-pin connector.  

3. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

4. Push the probe head all the way through the tube so that it exits the tube. 

5. Start the acquisition by clicking on the Acquire button under the Home tab, or by pressing F2 on 

your keyboard. 

6. Pull the probe at the recommended speed. 

7. When the probe exits the tube, press the Stop button, or again F2 on your keyboard. 

The image below shows a typical RFA scan of a calibration tube. No calibration has been performed yet. 
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Note that a red zone in the code pane means that the raw signal from at least one of the channels is 

saturated. This is usually the case when your probe is not inside the tube.  

 

VISUALIZING THE DATA 

LAYOUT 

By default, the setup generated with the RFA Wizard offers a layout that includes the following elements: 

• 2 strip charts and Lissajous/Voltage plane corresponding to the bobbin (ABS, DIF) coils, similar to 

the conventional RFT setups generated with the Generic Wizard  
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• 2 C-scans and 2 Lissajous corresponding to the array coils  

 

The tools found in the Layout ribbon can also be used to adjust the display settings to suit your preferences. 

Use the Replace, Remove or Split button to adjust the current display setting.  

 

 

DISPLAYED CHANNEL 

There are four buttons at the upper left corner of the Strip charts and Lissajous windows. These buttons 

are used to adjust the display settings for a channel in the specified window. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 
are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 
channel.  
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2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 
desired channel to select it. Right-click or Left-click on this button to switch to the following or 
previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential). 

4. Same principle as 2., but for the frequencies only. 

STRIP CHARTS AXIS ORIENTATION 

The Strip charts are projections of the Lissajous on the vertical and horizontal axis.  To switch from one 

axis to another, click on the box showing an arrow at the upper right corner of the Strip chart.  

 

ZOOMING 

BOBBIN CHANNELS 

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this 

section. 
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To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.  
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ARRAY CHANNELS 

On the C-scan, hold the right button of your mouse and drag on the zone of interest to zoom in on that 

section. You can drag your mouse either horizontally or vertically on the C-scan. 

To zoom out, right-click on the C-scan and select Zoom to Previous, Zoom to Content or Full Extent.   

  

ADJUSTING THE CURSOR LENGTH 

On the Strip chart, the cursor is composed of 3 lines. The dotted lines represent the limit of your cursor, 

and the solid line is the center of the selection.  

Only the section bound by the dotted lines will be shown in the Lissajous.  

Adjusting the cursor length is easily done using the mouse. Clicking and dragging on a dotted line with the 

left mouse button will adjust the 2 dotted lines symmetrically. To adjust only one dotted line, do the same 

operation with the right mouse button. 
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ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  

 

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 

MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method.  

 

1. Clicking on the corner with the black triangle gives a list of measurement methods for the 
amplitude of the signal. Click on the desired method to select it. Right- or Left-click on this button 
to select the next or the previous method in the list.  

2. Same as 1., but for the phase measurement. 

3. Rotate the measured phase by 180°. This option can be used if the software doesn’t measure the 
phase with the correct orientation.  

4. Take the same two points in time to take the measurement in the other Lissajous. 

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 
a vector on your Lissajous.  

LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotation applied, by definition. Rotating the signal 

will affect your calibration, so if you perform this operation, make sure to recalibrate afterwards.  
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The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   

DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and press on the space bar on the keyboard.  

C-SCAN DISPLAY ADJUSTMENT  

Manual adjustments can be made to the C-scans to improve their display for the detection of defects.  

 

One way of changing the display of a C-scan is by changing the color palette type and/or adjusting the 

scale of the color palette. To do so, double-click on the color palette ribbon at the top of the C-scan. 

 

 
 

 

Another way of adjusting the display of the C-scan is to manually rotate the signal in the associated 

Lissajous. Below shows a C-scan with a pit signal circled in red. As shown by the arrow in the upper right 

corner of the C-scan pane, the C-scan shows the vertical components of the Lissajous. 

 

On the Lissajous (below, left), the noise signal sits at approximately 60°. Manually rotating the Lissajous 

can be done by clicking and dragging the left-mouse button on the field highlighted in red. To minimize 

the noise signal, the Lissajous can be rotated such that the noise is horizontal.  
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After rotation (below, right), the pit signal becomes more prominent on the C-scan and the noise in the 

nominal sections of the tube (green) has been reduced.  

 

 
 

Caution: If you use sizing curves with the array part of the probe, it is necessary to readjust the manual 

rotation to zero so that the sizing curves give the expected values. 

 

SETUP ADJUSTMENT 

FREQUENCY VALIDATION 

The injection frequency (set in the Data definition section) will influence the phase angle separation 

between flaws of different depths. It can also affect the signal-to-noise ratio of certain flaws.   

If this frequency is too low, the phase angles of your flaws will be close to each other. Therefore, it will be 

difficult to build accurate sizing curves because a small variation of the phase will lead to a significant 

change of depth estimate.  

Multiple methods can be used to validate that the injection frequency was correctly set. Here’s two of 

them: 

• There is approximately 1° of phase change per 1% of wall loss between two grooves of different 
depths. The two grooves must not be too close in terms of depth.  
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• There is approximately 65° of phase separation between a through-wall hole and a 4 x FBH 20% 
depth. 

To adjust the injection frequency: 

8. Click on the Data button under the Setup tab.  

 

 

9. To increase the phase angle spread between your flaws, increase the injection frequency. 

Decrease the injection frequency to lower the phase angle spread.  

10. Click on Next and then click on Finish. 

11. Rescan your calibration tube. 

12. Verify that your injection frequency is correct. 

13. Redo steps 1 to 5 until you have an acceptable frequency. 

NOMINAL PONT VARIATION TOLERANCE 

When renormalizing the support plane signal in the Voltage plane, the angle correction applied relative 

to the nominal point is displayed in the bottom left corner of the view. Magnifi offers the possibility to 

display this correction value in red if it exceeds an acceptable value. 

     

A common practice is to set the threshold angle correction value at +/- 30°. To change this default value, 

click on the Voltage Plane window to highlight its borders and change the Tolerance field under the 

Current View tab.  
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Outside this value, the inspection frequency should be adjusted. This is described in more detail in 

Appendix 1 of this document. 

 

CALIBRATION 

Calibration is used to set the amplitude(s) and phase(s) of a channel using the selected measurement 

method. Given the options selected in the Probe Selection step of the Setup Wizard, the calibration of the 

bobbin channels can be performed with either the Lissajous or Voltage Plane, and the array channels can 

be independently calibrated if the Manual link type was chosen. All methods of calibration are shown 

below.  

 LISSAJOUS 

1. On either the conventional absolute (ABS_F1 or ABS_F2) or differential (DIF_F1 or DIF_F2) 

bobbin channel, position your cursor on the defect or feature corresponding to the calibration 

reference. In the picture below, the through-hole is selected. Make sure that the measurement 

vector includes the ends of the signal.  

  

Absolute Lissajous before calibration Differential Lissajous before calibration 

 
2. Click the System button under the Calibration tab.  

3. Select the Channel radio button. 

4. Select the item that corresponds to your calibration reference from the list. 
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5. Then press the green arrow. This action tells the system that the previous measurement 

matches the selected reference.  

6. Click Calibrate. This will apply the gain and rotation necessary to bring the reference signal to 

the desired value.  

If you have calibrated the hole to 1V, 90°, the signal after calibration should look like the images below: 

 

  
Absolute Lissajous after calibration. Differential Lissajous after calibration. 

 

VOLTAGE PLANE 

 

14. To adjust the signal, the user must manually draw a vector on the voltage plane from the nominal 

point of the calibration tube signal to the point of full attenuation (the effect of a completely 

blocked signal). Its length must initially be set to twice the length of the support plate, in the case 

of a Dual-Driver probe. To draw this vector, click on the manual measurement button "M", click 
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on the operation point of the signal, hold the left button of the mouse and drag it to the desired 

location. Once the vector is correctly drawn, click on the normalize button (blue compass). Magnifi 

will put the origin of the vector to the theoretical nominal point. It will apply a gain of 1/(vector 

amplitude) and a phase rotation of –(vector phase). If, for instance, the drawn vector has an 

amplitude of 0.8 and a phase angle of 10°, the system will apply a gain of 1.25 (1/0.8) and a 

rotation of -10° to the system.  

 

  

 

 
 

 

15. The signal may not be perfectly adjusted after the previous steps. You can adjust the signal again 

by drawing a new vector and by clicking on the normalization button until the signal is set correctly. 

In the examples below, the calibration tubes included two 360° grooves and we can see that both 

grooves reach the theoretical 360° coverage line. This can be a relevant indication to determine 

if a voltage plane is calibrated correctly. 
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16. Save your calibration by clicking on the green Save Nominal button. 

 

ARRAY CHANNEL – AUTOMATIC LINK TYPE 

 

With the Automatic link type option selected during setup, the settings made on the bobbin channels will 

be copied to the array channels; meaning the gain and rotation applied to the bobbin channels (absolute 

and differential) will be also copied to the array channels. Therefore, no action needs to be taken to 

calibrate the array channels. The example below shows how the array channels get calibrated side-by-

side with the conventional bobbin channels.  
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Above, calibration has not been applied to either channel. Below, the calibration was applied to the 

conventional bobbin channels which has been automatically pushed to the C-scan channels.  

 

ARRAY CHANNEL – MANUAL LINK TYPE 
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With the Manual link type option selected during setup, you must manually calibrate the array channels 

according to the following steps. 

1. On an array channel, position your cursor on the defect or feature corresponding to your 

reference for your calibration. In the image below, the through-hole is selected on the array.  

2. Make sure that the angle of the measurement vectors is oriented correctly on the array channels. 

The vector should include the signal ends on the differential. On the absolute, it should start from 

the nominal point and go to the signal end.  

 
3. Press the System button under the Calibration tab. 

4. Select the C-Scan radio button. 

5. Select the item that corresponds to your calibration reference from the list. 

6. Then click the green arrow. This action tells the system that the previous measurement matches 

the selected reference.  



298 

 

 
7. Click Calibrate. This will apply the gain and rotation necessary to bring the measured reference 

signal to the desired value 
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If you have calibrated the hole to 1V and 90°, the signal after calibration should look like the image below: 

 

CALIBRATION RESET 

A calibration reset will reset changes made to the software gain and rotation, while preserving the sizing 

curves that have been previously created. To perform a soft reset, follow the steps below: 

1. Under the Calibration ribbon, select the System menu. For both the Channel and C-scan radio 
buttons, click the “Reset” button to remove the stored information. 
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2. If you have chosen the Voltage Plane representation for your setup, select the voltage plane in 
Magnifi. Under the Current View ribbon, click on the “Reset Nominal” button. Note that you must 
perform this step individually for both frequencies. To do so, change the displayed frequency from 
the Voltage Plane view and then click on the Reset Nominal button again. 

 

3. The final step to completely remove calibration information from the current setup is to reset 
the manual rotation applied to the C-scan Lissajous. To do so, click on the rotation button, hold 
the left button and drag the mouse up or down until the display value is 0. Do this for all array 
channels. 

  

After performing the steps above, the calibration reset has been completed.  
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SIZING CURVES CALIBRATION 

The sizing curves allow the size of a defect to be estimated based on the calibration point signals 

(amplitude or phase) obtained with your calibration standard. Magnifi will give you the interpolated flaw 

size based on the sizing curves generated. 

The default RFA setups come with predefined curves for bobbin and array channels.  

To calibrate your sizing curves: 

1. Go to Calibration tab and click on the System icon. 

 

 
2. In the Calibration window,  

a. If the sizing curve to calibrate corresponds to bobbin channels (ABS, DIF): Select Channel 
and Sizing Curves  

b. If the sizing curve to calibrate corresponds to array channels (C-scan): Select C-scan and 
Sizing Curves  

 
 

3. Place your cursor on the part of the signal that corresponds to an item in the list (on the strip 
chart or the C-scan). 

Note: The system calibrates the signal with a measurement method that is defined in the Sizing Curves 

Configuration page (under the Advanced tab). Therefore, it is recommended to read the data with the 

same method as the system when you select your calibration points. This will allow you to see what the 

system is using to make its calibration. 
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4. Select the associated signal name in the list. 

5. Click on the green arrow. 

6. Redo the previous steps for all the other indications in the list. 

7. Click on the Calibrate button. 

 

When one or more points were not measured correctly, Magnifi generates an error message to indicate 

the user that the sizing curve(s) could not be built. Here are some typical examples of problems that could 

arise during sizing curve calibration. 

In the left image below, the blue measurement arrow is pointing downward towards the nominal point, 

instead of pointing up. In this case, the measured phase is rotated by 180˚ from the correct value. To 

correct the situation, the swap orientation button (green circling arrows) can be clicked before making 

the measurement during the calibration process. 

In the image on the right, the arrow is pointing up towards the end of the defect signal, which is correct. 

However, the arrow starts quite far from the nominal point, which will cause an error in the measurement. 

In this case, we suggest adjusting the cursors until the measurement is taken from a point near the base 

of the defect signal.  
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To readjust your sizing curves (e.g., if error messages were obtained during calibration), go the Calibration 

tab, and click on View Curves.  

 

The sizing curve window will appear. Each sizing curve will be listed in the drop-down menu. If an invalid 

notification is present on the curve, it means that either the sizing points have not been entered yet or 

that Magnifi failed to create the curve. To adjust the sizing curve manually, enter the values in the table.  
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To validate that a curve works properly, bring the measurement cursor over a flaw’s signal from your 

calibration tube and verify the value shown in the lower right corner of the Lissajous. It is recommended 

to use the same measurement method as the one that was used to build the sizing curve. To change the 

measurement method, click on the icons at the bottom left of the Lissajous. 
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If the default size does not appear, it means that you are not displaying a channel where a sizing curve 

has been defined.  

Built sizing curves can give you access to the phase-depth sizing overlays on the Lissajous and the Voltage 

planes. To activate this option, click on a window, go to the Current View tab and check the Depth-V. 

checkbox. 

 

LANDMARK CALIBRATION 

This section describes how to calibrate your landmarks. 

1. Go to the calibration tab and click on the Landmarks button.  
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2. Calibrate the landmarks shown in the Landmarks window the same way the sizing curve(s) 

points were calibrated.  You can use the Land channel to do so.  

 
 

The positions of TSI and TSO are described in the Landmark window in the Setup tab (TSI is on the far-

side tube sheet, that is, the first one encountered by the probe while pulling it during data acquisition; 

TSO is on the near-side tube sheet). 

 

Once the landmarks are calibrated properly, the system should be able to recognize them automatically 

and the name of the landmark will appear in the Code view with a blue triangle.  

 

Note: In order to calibrate the default Exit landmark, data that includes the probe exit at the far end of the 

tube is needed.  

 

FAST NORMALIZATION SETTINGS 

Material properties, such as relative permeability, can change from one tube to another in the same tube 

bundle. This will cause a shift of the nominal point on the voltage planes and a rotation of the channels 

using a Lissajous. Consequently, the sizing curves calibrated with the reference tube will no longer be valid 

for these tubes. More information on this phenomenon can be found in Appendix 1 of this document.  
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If the angular movement of the signals is not too great (typically less than 30°), a common practice is to 

renormalize the absolute channels displayed on the Voltage plane (if this representation was chosen) and 

recalibrate the support plate signal to the reference obtained with the calibration tube for the differential 

channel. 

As these operations are often performed several times during an inspection, Magnifi offers quick keys to 

facilitate the analysis. 

To configure them, go the RFT tab and click on the Settings Shortcuts button. The displayed window will 

show the channels using voltage planes and standard scale process.  

 

The keyboard shortcut next to the channels can be customized to normalize the associated channel. To 

set the reference values for channels using a Lissajous, select the reference indication signal with the 

cursors in your calibration tube data, then click on the Measure Reference button. The reference used in 

this case is normally the support plate. 

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it to the desired location. The save location is, by default, your inspection sub-folder. Note that 

when data are saved, the setup is also saved with it.  
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You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab. 

 

PERFORMING AN INSPECTION 

Once you have used the Setup Wizard to create a setup, calibrated the data from your calibration standard, 

and created your sizing curves, you are now ready to perform an inspection. 

Perform a preliminary scan of the tube bundle using the frequency estimated from the equation on page 

271. Be sure to renormalize the signal again to ensure the selected frequency is appropriate by checking 

if the angle correction is within the set tolerance.  

Renormalization and recalibration during the data-taking process is simplified with the shortcut keys you 

defined earlier. To renormalize the channels using the voltage plane process, select a sound area in the 

inspected tube and enter the keyboard shortcut you selected earlier for the fast normalization settings. 

To recalibrate the channels using the standard scale process, select the reference (normally a support 

plate) and enter the keyboard shortcut. The system will adjust the selected reference to the value set in 

the RFT Normalization Settings window (Amplitude and Angle). Note that these operations should be 

performed using the conventional channels, not the array channels. The gains and rotations made on the 

conventional channels will also be applied to the array channels. 

Whenever any hardware settings are changed, be sure to re-null the probe in the calibration tube before 

performing another acquisition.  

DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Data List section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  

 

The list of tubes is also shown in the Data window.  
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A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

exit out of acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to Acquisition Mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon.  

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A tube name can be changed by right-clicking on its name and by selecting the Rename option. 

LOADING A FILE 

17. First disconnect your computer from the Ectane by clicking on the Disconnect button under the 

Home tab (optional step). 

18. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

19. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two Indication buttons in the lower-right corner of the Lissajous view can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  

To add an indication to the data: 

20. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

21. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

22. Click on the defect button to add an entry to the report.  
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Report entries can also be added using keyboard shortcuts. The SMART Setup section of this manual 

explains how to configure them. 

Another type of report entry, called “feature”, can also be added to a tube to indicate, for instance, that 

it has no flaw or that it is plugged. A feature is an indication that is general to the tube, it is not localized 

like defects, and therefore has no measurement or size associated with it. To add a feature to a tube: 

23. Load the file 

24. Click on the appropriate indication button available under the Analysis tab 

 

 



312 

 

REPORT TABLE 

To access the list of indications entered: 

25. Make sure that the Report option is selected under the Layout tab.  

  

26. Click on the report tab at the bottom of the screen to make the list visible 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry be 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

27. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  

28. Click on the Generate Report button under the Report section of the General tab. 

29. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tube in each category.  
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30. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 

 

The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 
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The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro. 
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ADVANCED SETTINGS AND OPERATIONS 

ADVANCED SETUP MODIFICATIONS 

The RFA Setup Wizard offers possibilities to generate your setup, but some options are not directly 

accessible with the Wizard. To access these modifications, it is necessary to use advanced menus. 

MODIFICATION OF THE DEFAULT SCALE PARAMETERS FOR CALIBRATION 

By default, if the absolute channels are represented with a Lissajous when generating setups with the RFA 

Wizard, and the calibration of the absolute channels is performed on the Support Plate indication signal 

by bringing it to 0.5V and 0°. For the differential channels, the calibration puts the signal of the Through-

Wall Hole indication at 1V and 90°. 

These settings are the same for both the bobbin and array channels. 

If needed, these calibration parameters (reference point, amplitude or phase value and measurement 

method) can all be customized using the Advanced Channels and C-scans menus. 

Reminder: If the conventional absolute channels are represented with the Voltage Plane, the calibration 

uses the Voltage Plane process. Therefore, it can’t be customized. 

Bobbin Channels: 

1. To modify the calibration parameters for the bobbin channels: Click on Process Ch. under the 
Advanced menu. 

 

2. In the Data Processing page, select the page (ABS (Scale) or DIF) that you want to modify. 
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3. Double-click on the Scale icon for the channel that requires modification. 

4. For both the Amplitude and Phase, you can change the targeted value, the reference point and 
the measurement method. Note that different reference points can be used to calibrate the phase 
and the amplitude independently. 
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Array Channels:  

If the calibration mode for C-scans is set to Manual, the C-scans must be calibrated independently from 

the bobbin channels in the calibration tube. In that case, you might also want to modify the calibration 

parameters for the array channels: 

1. Click on C-scans under the Advanced menu. 

 

2. In the C-scan Configuration page, select the C-scan that requires modifications. 

 

 

3. In the Process section associated with the selected C-scan, select the Scale process, then click Edit 
to open the Scaling Setup page. 
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5. For both the Amplitude and Phase, you can change the targeted value, the reference point and 
the measurement method. Note that different reference points can be used to calibrate the phase 
and the amplitude independently. 

 

 

 

SIZING CURVE MODIFICATIONS 

In the Sizing Curves Configuration window (under the Advanced tab), you can either create a new curve 

by clicking on Add, or modify the general parameters of predefined curves such as measurement type, 
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channel source, etc. By default, all curves are measured using phase angle. However, they can be changed 

to amplitude. 

 

 

 
 

For every sizing curve seen under the General section, there will be a specific page in the Definitions 

section to configure the curve properties. By default, the Average Peak (MP) measurement method is set 

for the absolute channels, and the Peak to Peak (PP) option is used for the differential channels. 
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The plot of sizing curves for each individual channel can be seen by clicking on the Curve tab. From there, 

you can click Select... to see or modify the calibration points for each curve.  

 
 

Note: When you modify an existing curve or add a new curve, you must recalibrate/calibrate all sizing 

curves (channels and C-scans).  
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RFA LINKS EDITOR 

The RFA Links Editor menu can be found under the RFT ribbon. The drop-down menu available at the top 

of this window shows the selected mode of calibration for the C-scans in the calibration tube, as initially 

defined during the Setup Wizard. 

In the Links table, the left column shows the conventional bobbin channels, and the right column shows 

the C-scans associated to them. When a channel in this list is calibrated, or its software gain or rotation is 

modified, the same changes are automatically applied to the C-scans linked to it. 

 

It is highly recommended to leave this menu as it is. However, it is accessible to allow for advanced 

customization of an RFA setups. For instance, should a new C-scan be added to a setup, this menu would 

allow to link it to the correct bobbin channel. 

 

LOSS OF COMPATIBILITY WITH THE RFA WIZARD 

All the setup modifications covered until this point are considered as being a typical setup creation 

workflow for RFA technology. If additional customization of the setup is required for specific purposes, 

you should be aware that it might result in a loss of compatibility with the dedicated RFA Wizard. 

Modifications made to the following menus would break compatibility: 

• Advanced Scan Definition menu 
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• Channels and C-scans Advanced Process menus: Modifications to processes other than the Scale 

(as shown previously) 

 

• Instrument Configuration menu 

 

 

Important: If you need to make modifications to the above menus, you should stop using the RFA Wizard 

and only use the Advanced menus for all the adjustments to the setup, including the frequency selection, 

scan length, etc. 

SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 
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The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane, and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 

 

The following table shows the possible icons and their meaning: 

Icon Description Meaning 

(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 

 

 

Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 
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detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 

 
Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 

LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools. 
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The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can, however, give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 

 

Three landmarks are created if you click on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position), or the place where you stop recording (usually the 

operator side). 

 

 

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 
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Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. The Threshold is the voltage amplitude threshold. 

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the correct position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates doesn't need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tube sheets). 
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If you are using the conventional detection tools, you can set up the regions according to the automatic 

analysis tools you will use with the Indications and DQV buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view. 
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There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

 

And seven waveform types: 

 Up 

 Down 

 Down-up 

 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 

 

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 
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DATA QUALITY VALIDATION (DQV) 

Data Quality Validation allows defining tests to validate the quality of the data. 

 

Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 
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• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-lengths of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together in which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 

• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows grouping a zone together in which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together in which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 
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GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications.  

 

The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 
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The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 

Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the next group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 
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It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 

 

Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUTS 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 

LIMITATIONS 

Some operations, processes, and options are not available for the RFA probe and configuration in Magnifi. 

This section lists the limitations of the workflow in Magnifi. 

• RFA setups can only have two frequencies. More frequencies cannot be added.  

• The Absolute C-scan does not have a Voltage plane representation, only a Lissajous 
representation. 

• Contrary to conventional RFT setups, it is not possible to link the Absolute and Differential 
conventional channels together with RFA setups when the Voltage plane representation is used. 

• The RFA Wizard cannot generate encoder-based setups. 

• If the Periodic Noise filter has been activated, it may take a few seconds to complete processing. 
This is normal - the process can take up to more than a minute for very long scans. 

• The setup wizard does not suggest excitation frequencies based on the tube characteristics. This 
parameter must be determined by the user. 
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APPENDIX 1 – VOLTAGE PLANE 

The following two equations describe the through-wall transmission behavior of RFT: 

The phase lag equation shows that the signal is not only influenced by the tube properties, but also 

depends on the frequency (f) at which the tube is inspected. Given a tube of constant permeability and 

conductivity, and using a fixed inspection frequency, the phase lag will be proportional to the thickness of 

the tube.  

The magnetic field strength (B) will depend on this phase lag. For an infinite theoretical thickness, the 

resulting magnetic field will be null. The explanation being that the field is completely blocked and that 

nothing is caught by the receiver(s).   

The voltage plane is a graphical representation of these formulas. The curves built on a voltage plane show 

the effect of the thickness variation on the signal. There are four curves that represent a flaw coverage of 

90°, 180°, 270° and 360°. The point crossing the horizontal axis is the nominal point. This is the signal 

obtained when the probe is in a sound area of the tube. It has an amplitude of 1V and a phase of 0°.  
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When you first scan your calibration tube, this point doesn’t match the nominal point of your theoretical 

curve. You must calibrate the signal to match your probe signal to the theoretical curve(s). This operation 

is called normalization.  

A bundle of tube may include tubes that have different properties. The permeability, for example, may be 

different for some tubes. This will affect the nominal point position and the built sizing curves won’t be 

applicable to this tube.  

If the nominal point has not moved too far from the theoretical nominal point, the common practice is to 

renormalize and to size the flaw with the built sizing curves.   

If the nominal point has moved far from the theoretical value, it means that the tube properties are 

significantly different from the calibration tube. Therefore, the phase lag for a given flaw will also be 

significantly different and this will generate an error in the sizing that must be considered. In this case, it 

is recommended to change the drive frequency to put the nominal point back to the renormalization zone.  

 



341 

 

 

 

A common practice is to set the threshold angle at which the inspection frequency needs to be changed 

to 30°.  

  



342 

 

APPENDIX 2 – PERIODIC NOISE FILTER 

The Periodic noise filter addresses the presence of cyclic or periodic noise in C-scans caused by the tube 

manufacturing process.   

The pilger process in tubing manufacturing may create a cyclic permeability change along the length of 

tubes.  This in turn may cause noise that appears like visible diagonal stripes in C-scans. In most cases, this 

noise is low and will not prevent the analysis of the C-scan signal but in the instances where the noise is 

stronger, the Periodic noise filter may help to reduce it. 

 

Pilger noise 

By default, the filter is not enabled.  All filters affect the signal to which they are applied to a greater or 

lesser extent, and improper use can lead to the creation of artifacts or can negatively affect the signal.  It 

is recommended to use this filter only on data that has pilger noise that interferes with the analysis.   

It is possible to enable the filter and to set most parameters within the “C-scans” step of the RFA setup 

wizard. 
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Checking the box on the desired C-scan line under the Periodic Noise column enables the filter. The other 

parameters are described below. 

It is also possible to enable the filter and access the filter parameters by right-clicking on the desired C-

scan and selecting the C-scan configuration menu.  Double-clicking on Periodic Noise Filter brings up the 

Periodic Noise Filter Configuration. 
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The "Enable filter" option allows you to activate or deactivate the filter. 

The correct signal type, either "absolute" or "differential", must be selected according to the type of C-

scan to which it is applied.  

The Window Size is the axial direction zone size, in data samples, that is considered by the filter.  The size 

of the window can be determined by measuring the axial length of a small defect, in samples, such as the 

through-hole in the calibration tube. For RFA probes, this value is then divided by 5 for absolute C-scans, 

and by 8 for differential C-scans. 

Window SizeAbsolute =
Target defect size in samples

5
  

 

Window Size Differential =
Target defect size in samples

8
 

 

To measure the axial length of a defect, place the beginning and the end of the cursor at the defect’s axial 

extremities and read the value displayed in the ΔY (smpl) field.  

In the example below, on an absolute C-scan, the complete target defect signal is 185 samples long.  

Therefore, a Window Size value of 185/5 = 37 samples could be used. 

 

 

The Noise Threshold parameter allows the filter to process only noise that comes from a periodic source 

that needs to be reduced. Therefore, this threshold is set at an amplitude, in volts, between the observed 
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periodic noise level and other baseline noise.  The absolute peak measurement method can be used to 

read the noise level.  

Baseline noise can be measured when the probe is stationary in the calibration tube in an area free of 

defects. The signal coming from the pilger noise can be measured in a fault-free zone. 

If, for instance, the periodic noise has an approximate amplitude of 0.100 V and the baseline noise is about 

0.020 V, the Noise Threshold must be set between these two values.   

The High Intensity checkbox does a more intense version of the filter.  In the case of very high periodic 

noise, it will reduce the noise further, but may create signal discontinuities.  

 

The example above (left) shows a relatively high noise level. On the right, the result after applying the 

filter is shown.  On the unfiltered C-scan impedance plane (top), the cyclic noise (seen as overlapping 

ovals at the base of the defects) affects the signal to noise ratio and enlarges the defects such that the 

phase is difficult to measure.  On the filtered C-scan impedance plane (bottom), the signal is cleaner, 

and the phases are easy to measure since the signals are narrow. 

 

The Periodic Noise Filter does several operations in a row, and certain design constraints must be 

highlighted to understand how it behaves: 
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• As previously mentioned, low noise levels usually do not necessitate filtering. It might prove 
difficult to set a Noise threshold that would be consistently below the periodic noise and above 
other noises.  If this value is not set correctly or the periodic noise is too low, the filter will not 
work correctly.  

• The filter must be used on signals that are around the zero mark (nulled / high-pass median-
filtered signals). 

• The filter uses parts of the signal that only include pilger noise to determine its parameters. If 
there are very large defects in a zone, the software might not be able to find an adequate pilger 
noise signal and it will not be correctly filtered. 

• Similarly, filtering might be inefficient at the beginning and end of the scan because there is not 
enough data to measure the pilger noise parameters. 

• In the C-scan configuration window (seen above), each filter in the list sequentially processes 
the data  

• The filter receives the signals obtained from the processes that precede it (see the C-Scan 
configuration window above). This means that any signal amplitude used to select a Noise 
Threshold must be measured on the signal that the filter receives.  Since the periodic noise filter 
is last in the C-scan processing chain, measure the signal with the filter disabled to determine 
the correct value.   

• Prior processes like median filters or other filters might in some circumstances generate artifacts 
(straight lines, data at zero) that will in turn affect the periodic noise filtering (seen below). 

• This filter is computationally intensive, so the processing time for long files can be a minute or 
more for a single file. 
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INTRODUCTION 

This document presents how to use an NFT probe with Magnifi on an Ectane test instrument.  

EQUIPMENT 

NFT probes use a 19-pin connector that can be connected to an Ectane with the ‘’ERNM’’ option. The 

absolute and differential signal from the probe will provide Strip charts and Lissajous.  

As these probes need to fill an optimal portion of the tube inner diameter, a wide range of probe 

diameters are offered (see the tubing probe catalog for more details).  

From the following table, the best standard probe for your application can be selected. Note that Eddyfi 

also offers custom products that are not shown in these tables.  

Table 11 – NFT-BBAD probes diameter selection table 
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The NFT calibration tube used in this document includes the following flaws: 

• Internal groove, 30% of wall loss 

• Internal round bottom holes (RBH), 6.35mm diameter, 75% of wall loss 

• Through wall hole, 6.35mm diameter 

• Internal round bottom holes (RBH), 6.35mm diameter, 50% of wall loss 

• Internal round bottom holes (RBH), 6.35mm diameter, 25% of wall loss 

• Internal groove, 60% of wall loss 

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.  
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different inspections 

that are related in some way. For instance, it can include all the inspections done at a refinery shutdown 

and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder. 

Inspection folders are saved in the project file. An inspection folder can include data specific to the 

inspection of a tube bundle with a specific technology and could be named CS_075x0.065_NFT for 

instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage.  You can select an existing 

project/folder or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your project file. Select 

New, Folder and enter the chosen name. You can then select the newly created folder and click 

on Select Folder.  
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your 

inspection.  

 

 
3. Click Select. This will define the position where the setup(s) and data will be saved. 
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SETUP WIZARD 

In this section, we will show how to create a setup using the Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement 

for imperial units is inches.  When finished, click on Preferences again to go back to the General window.  

 

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to 

start the Setup Wizard. 
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COMPONENT DEFINITION 

The first page shown by the Setup Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is 

used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on 

this material.  
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It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 

 

You will be back to the Component Definition window. If you add new material, it will be available in the 

material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube’s outer diameter and length. 

These tube properties will help Magnify to suggest the optimal scan parameters. 

Click Next when everything is set correctly. 
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PROBE SELECTION 

In the Probe Selection window, select the probe you will be using for your inspection. 

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu. 

More precise filtering can be done by using the Model drop-down menu.  You can then select your probe 

by its catalog number (PRBT-NFT-BBAD) and then click Next. 
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SCAN DEFINITION 

The Scan Definition window is used to configure the axial position measurement method, the acquisition 

rate and the typical probe speed.  

 

The position along the tube can be defined by using either the internal clock of the system, or by using an 

axial encoder. If you use the internal clock, the default position will be given assuming that the probe is 

always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since 

the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder 

will give you the exact position of the probe. Note that the position can also be obtained by using the 

landmark tool, but this feature will be shown later.  

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate 

is set to 800 Hz for NFT, but depending on the drive frequency used to inspect, the actual acquisition rate 

may differ. The system will automatically readjust this value if needed. For standard NFT probes, the 

acquisition rate can always be set to 800 Hz.  

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For instance, 

with an acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least two 

points per millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t 
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be constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial 

resolution target.  The typical probe speed should be set as close as possible to its real value. This will help 

the algorithm that automatically detects landmarks (this will be explained in the Landmarks section). The 

recommended pulling speed for NFT is approximately 300mm/s. 

If you select to measure the position from Encoder, different fields will appear, and a second Scan 

Definition page will become available. 

  

 On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered. 

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the 

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition 

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a 

speed exceeding the Maximum probe speed, there will be gaps in the data.  

The second page includes the type of encoder and its resolution. A preset can also be specified if your 

acquisition doesn’t start at 0 mm.  

Click Next when you’re finished. 
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DATA DEFINITION 

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute 

and Differential channels. It is important to set these parameters correctly before acquiring the data since 

they are driven by the instrument and cannot be modified during the analysis.  

 

By default, Magnifi suggests a frequency of 300Hz. The frequency and the drive voltage can be changed 

by replacing their values in the Required frequencies table. Up to 4 frequencies can be set at the same 

time. And the sum of their amplitude cannot exceed 10V. 

Make sure that the chosen frequencies are within the probe limits that you can find in Table 1. If one of 

the suggested frequencies is not within the recommended probe frequency range, you can either remove 

it by clicking on the X or change it within the recommended range.  

Click on Next when the desired parameters are entered.  

The next window is used to build mixed channels. Mixes are processed channels that are mainly used to 

detect indication close to support plates. They are built with 2 frequencies of the same channel type to 

attenuate the effect of the support plate and to be able to size an indication at this location more 

accurately. Mixes are not typically used with NFT since this technology allows the detection of inside 

diameter indications only. Therefore, the support plates are not typically detectable.  
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Click on Next.  

 

DATA PROCESSING 

The Data Processing window is used to configure the signal processing to apply to the channels.  

You can choose to configure every frequency individually or you can apply the same filters to every 

channel with the Individually configure all the channels check box.  

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can 

be changed without any problem during data analysis, while wrong parameters choice for the data 

acquisition can mislead the analysis. It is possible to change the filters parameters after data acquisition, 

so it is always possible to fine tune the filters parameters during analysis. 
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The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful 

when your defect signal has a lower frequency content than the background noise. In this case, using a 

filter will remove part of the noise without removing the defect’s signals. This may help with data analysis. 

However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too 

low will filter out the defect’s signals.  

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of 

the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of 

the high-pass median filter should be set to at least three times the axial length of the longest flaw that 

may be encountered. Data should be examined in both its filtered and unfiltered states. It is important to 

keep in mind that the median high-pass filters can distort phase. More information about median filters 

for NDT analysis can be found on Eddyfi’s blog.  

Click Next when you are done.  
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CALIBRATION POINTS 

The Calibration Points page is used to define the points in your calibration tube. These indications will 

later be used to calibrate your probe and to build sizing curves.  

The units of measurement can be set in percentage or in depth (millimeters or inches).  

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and 

size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).  

Calibration points can also be imported with the Import button.  

 

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).  

CALIBRATION 

The Calibration page is used to define reference signal(s) that will be used to set the amplitude(s) and 

phase(s) of each channel using the selected measurement method.  

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 90° on the differential 

channel. The absolute channel is calibrated on the 60% groove by adjusting it to 6V, 90°. However, the 

calibration can be done differently on each channel type. It can also be done individually for each 

frequency by selecting the Individually configure all the channels option. Different reference signals can 

be set to calibrate the phase and the amplitude independently.  



364 
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When you select the reference signal, the system will use the selected measurement method to apply a 

rotation and a gain. Here is a short description of the available options: 

 

1. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

2. Absolute Horizontal (AH):  

Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

3. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

4. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 

5. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

6. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

7. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Only used and and recommended for absolute signals. 

8. Average Peak Horizontal (MPH):  

Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 

9. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

10. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

11. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

12. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

13. Peak to peak First Transition (PPF):  
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Uses the combination of the vertical and horizontal component of the first transition of the signal 
to measure maximum amplitude. The first signal transition is from the base of an indication to its 
peak. 

 

Click on Next went the parameters in the table are set according to your requirements. 

SIZING CURVES 

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this 

table.  

 

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals 

(amplitude only for NFT) obtained with your calibration standard. Magnifi will give you the interpolated 

flaw size based on the built sizing curves. 

Sizing curve names are customizable. The channel source and measurement type can also be changed. 

You can add sizing curves by clicking on the Add button. 

Click Next when you are done. 
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For every sizing curve created in the last window, a window will appear to configure the curve properties. 

The name of the curve will be shown in the upper left corner of the page (ABS in the example below).  

 

The measurement method options are the same as what is described in the calibration section of this 

document. By default, the option peak to peak (PP) option is set for the absolute and the differential 

channels.  

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of 

the available options: 

1. Best Fit (Dual linear) (for phase measurement only):  

A curve with two linear segments representing ID and OD (or Near and Far) side calibration 

points with respect to phase. 

2. Best Fit (Dual Slope) (for phase measurement only):  

A curve with two segments representing ID and OD (or Near and Far) sides. The ID section is 

linear and the OD section is polynomial. The OD side of the curve will need at least three points 

(including the hole) in order to trace a polynomial curve. 

3. Best Fit (Polynomial) (for phase and amplitude measurements):  

Best polynomial (degree 2) interpolation within the measured calibration points (requiring at 

least three points). 
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4. Connected Points (for phase and amplitude measurements):  

Simple, point-to-point curve. 

5. Best Fit (Linear) (for phase and amplitude measurements):  

Best linear interpolation within the measured calibration points 

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements): 

Polynomial (degree 2) interpolation with two segments for both ID and OD side of the curve. 

Need at least three points.  

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial) 

option is a more precise method when your calibration tube has multiple defects. 

Once the measurement method and the interpolation curve shape are chosen, you can select the curve 

points for each sizing curve previously created. The order in which the points appear in the list may 

influence your sizing cure. Make sure that the measured values of the calibration points are in ascending 

order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking 

the box Report as remaining wall thickness. 

Click Next when you are done.  

INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  
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Click Next when you are done 

 

DISPLAY 

The first Display window is used to set how the data is displayed during and after the acquisition.  

 

The Display Direction is the direction in which data appears on the screen.  

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box. 

The strip chart duration is the length of a Strip chart window when the data is acquired. 

Click Next. 

The second Display window is used to set the layouts. Checking the tick boxes in this window will make 

the proposed layouts available in your setup. You will be able to switch from one to the another via the 

layout tab. The " S " stands for Strip chart, " L " for Lissajous and “C” is for the defect Code indication zone.  
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The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 

Layouts can be readjusted at any time.  

Click Next to complete the setup wizard process. 
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SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the 

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change. 

 

This will open one of the windows previously described, where you change the values you originally 

entered. Change the desired parameter. If applicable, go through the process by clicking on Next, and 

then click on the Finish button. This will apply the modification to the setup.  

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed 

using advanced settings, the information shown using the Setup tab may not match your actual setup.  

SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 

 

The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 
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The following table shows the possible icons and their meaning: 

Icon Description Meaning 

(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 

 

 

Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 

detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 
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Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 

LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools. 

 

The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can however give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 
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Three landmarks are created if you press on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position) or on the place you stop to record (usually the 

operator side). 

 

 

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 

Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. And the Threshold is the voltage amplitude threshold. 
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Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the right position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates don’t need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tubesheets). 
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If you are using the conventional detection tools, you can set up the regions according to the automatic 

analysis tools you will use with the Indications and DVQ buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view. 

 

 

There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

 

And seven waveform types: 

 Up 

 Down 

 Down-up 
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 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 

 

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 

 

 

DATA QUALITY VALIDATION (DQV) 

Data Quality Validation allows defining tests to validate the quality of the data. 
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Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 

 

• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-length of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 

• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows group a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together for which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 
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GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications.  

 

The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 
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The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 

Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 
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It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 

 

Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUT 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 

 

DATA LIST 

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.  

This list can be created in the Data List section of the General tab of the Backstage. 

 

 

Four options are available to set the filename format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

 

Click on the Create New List button. The displayed window will be different depending on the chosen 

filename format. 
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For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 

then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 

generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 

list.  

 

 

The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the Data window of the Frontstage. 

The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software 

(available from Eddyfi).  
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PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button. 

2. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect and 

then click Connect. 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To download 

a matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  

 

 

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used to 

scan your calibration tube and make the necessary adjustments on your setup without saving the data 
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automatically. Acquisition mode is used for the inspection. In this mode, the software automatically saves 

the acquired data using file names based on the tube list.  

3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

4. Plug the NFT probe on the Ectane 19-pin connector.  

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

6. Push the probe head all the way through the tube so that it exits the tube. 

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

8. Pull the probe at approximately 12’’/s (300 mm/s). 

9. When it’s done, press the Stop button or F2 again on your keyboard. 

 

 

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually 

the case when your probe is out of the tube.  
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VISUALIZING THE DATA 

Multiple options are available to select your data and to measure it. The following describes useful 

functions to do so: 

DISPLAYED CHANNEL 

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons 

are used for the channel selection. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 

are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 

channel.  

 

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 

desired channel to select it. Right-click or Left-click on this button to switch to the following or 

previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential. 

4. Same principle as 2., but for the frequencies only. 
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STRIP CHARTS AXIS ORIENTATION 

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis 

to another, click on the box showing an arrow at the upper right corner of the Strip chart.  

 

ZOOMING 

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this 

section.  

 

 

 

 

 

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent. 

 

  



392 

 

ADJUSTING THE CURSOR LENGTH 

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and 

the full line is the center of what you have selected.  

Only the portion of data between the dotted lines will be shown in the Lissajous.  

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse 

button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same 

operation, but with the right button of your mouse.  

ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  

 

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 

MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method. 

A short description of the measurement methods can be found in the above calibration section of the 

setup wizard.  

 

1. Clicking on the corner with the black triangle gives the list of measurement method for the 

amplitude of the signal. Click on the desired method to select it. Right- or left-click in this button 

to select the next or the previous method in the list.  

2. Same as 1., but for the phase measurement 
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3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure 

the phase with the right orientation.  

4. Take the same two points in time to take the measurement in the other Lissajous 

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 

a vector on your Lissajous.  

LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the 

signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.  

The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   

DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and use the spacebar on the keyboard.  

 

CALIBRATION AND SIZING CURVES 

CALIBRATION 

The following section describes how to calibrate your probe. 

1. Go to the Calibration tab and click on the System icon. 

2. Select Channel in the Calibration window. 

3. In the Strip chart, select the signal to calibrate and adjust the cursors to see only the desired 

signal.  

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If for some reason the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  
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4. Select the signal name in the list. 

5. Click on the green arrow button to associate the measured signal to the calibration point. 

6. If more than one calibration point is present in the list, repeat steps 3, 4 and 5 for each one. 

7. When all your calibration points are checked marked, click on the Calibrate button. 

 

SIZING CURVES 

The following section describes how to build your sizing curves. 

1. Go the Calibration tab and click on the Sizing curve button. 

2. Select Channel and Sizing Curves in the Calibration window. 

3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal. 

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If for some reason the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to 

show the defect size. To have the correct interpolated point, the measurement method also needs to be 



395 

 

the same as the one used for the sizing curve. To change the measurement method, click on the icons at 

the bottom left of the Lissajous. 

4. Select the signal name in the list. 

5. Click on the green arrow. 

6. Redo the previous steps for all the other indications in the list. 

7. Click on the Calibrate button. 

 

  

Sizing curves can also be adjusted manually. To do so, go to the Calibration tab, and click on View Curves. 

The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the 

drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t 

entered the sizing points yet, or that Magnifi failed to create the curve. To adjust the sizing curve manually, 

enter the value in the table.  

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the 

Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not 

appear, it means that you are not in a channel where a sizing curve was set. 

LANDMARKS 

The following section describes how to calibrate your landmarks. 

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks 

window the same way you calibrated the sizing curve(s) points. You can use the Land channel to do so.  

The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside 
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tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside 

tubesheet).  

Once the landmarks are calibrated properly the system should be able to recognize them automatically.  

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far 

end of the tube is needed.  

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file. Note that when a 

data is saved, the setup is also saved with it.  

 

You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  
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INSPECTION 

STANDARD ACQUISITION 

The following section describes how to perform an inspection. 

1. Connect Magnifi to your instrument. 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the NFT probe into Ectane 19-pin connector.  

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard.  

5. Push the probe all the way through the tube until it exits the far end. 

6. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

7. Pull the probe towards you at a constant speed until it exits the tube. 

8. When finished, press the Stop button or again F2 on your keyboard. 

9. Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.  

MANUAL SEQUENCE 

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and 

can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are 

needed to use this feature. These landmarks can be created by using the Landmarks button under the 

SMART Setup tab.    

To set the manual sequence: 

1. Click on the Manual Sequence button under the Calibration tab.  

2. If a warning message is shown in this window, change the parameters until no warning is shown. 

The system will progress through the different windows to guide you.  

3. Click on Settings … 
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4. Select Landmark in the Type section 

5. In the drop-down menu choose the Landmark that will initiate the data recording. If you keep 

the default landmarks, you can select the Exit landmark that will be triggered when the probe 

goes out of the tube when the probe is pushed.  

6. You can enter a delay to start the acquisition after the first landmark is detected (Start 

Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop 

Acquisition Delay).  

7. Two options are available to restart the acquisition: The user can either push a button or use a 

timer. Select the desired option in the Restart section.  

8. Click on OK. 

To use the manual sequence: 

1. Connect Magnifi to the instrument 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the NFT probe into the Ectane 19-pin connector. 

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Open the Sequence window by clicking on the Manual Sequence button under the Calibration 

tab. 

6. Put your probe in the tube to inspect and click on the Launch button. This will start the data 

acquisition. 
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7. Push the probe out of the tube. If set correctly, this will trigger the landmark that will start the 

data recording.  

8. Pull the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the 

landmark and this will initiate the data recording. 

9. Acquisition restart: 

a. If you selected User Input in the settings of the Manual Sequence Configuration, the system 

will wait for the user to enter information on the tube to restart the acquisition. Click on 

NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition. 

Repeat steps 6, 7 and 8. for all the tubes to inspect. 

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown 

will trigger after the last tube acquisition was taken. The acquisition will start after this time 

has elapsed. Redo step 6 and 7 for all the other tubes to inspect in the bundle.  

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is 

the case, you won’t be able to catch the landmark that trigs the data recording at the end of the tube. In 

this situation, you can click on the Target button in the Sequence window to start the data recording. 

DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  

 

The list of tubes is also shown in the Data window.  
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A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

go out of acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon.  

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A tube name can be changed by right-clicking on its name and by selecting the Rename option. 
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LOADING A FILE 

1. First disconnect your computer to the Ectane by clicking on the Disconnect button under the 

Home tab 

2. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  

To add an indication to the data: 

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is 

explained in the SMART Setup section of this manual. 

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab 

 

 

REPORT TABLE 

To access the list of indications entered: 

1. Make sure that the Report option is selected under the Layout tab.  

 

 

2. Click on the report ribbon at the bottom of the screen to make the list visible. 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  
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2. Click on the Generate Report button under the Report section of the General tab. 

3. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tube in each category.  

  
4. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 

 

 

The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro.  
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NFA Application Guide 
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INTRODUCTION 

This procedure presents how to use an NFA probe with Magnifi and above on an Ectane test instrument.  

EQUIPMENT 

The NFA probes use a 160-pin connector that can be connected to an Ectane with the ‘’E64’’ option.  

The array section of the probe will provide a C-scan imaging and the conventional channel will display a 

standard Strip chart / impedance plane signal for the absolute. 

From the following table, the best probe for your application can be selected.  

 

The NFA calibration tube used in this document includes the following flaws: 

• Internal taper groove, 30% of wall loss on 4in length 

• ID Round bottom hole 50% of wall loss, Diameter 0,138in 

• ID Round bottom hole 50% of wall loss, Diameter 0,186in 

• ID Round bottom hole 50% of wall loss, Diameter 0,375in 

• ID Round bottom hole 50% of wall loss, Diameter 0,250in 

• ID Round bottom hole 50% of wall loss, Diameter 0,312in 

• Internal Groove 20 % 

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.  
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different inspections 

that are related in some way. For instance, it can include all the inspections done at a refinery shutdown 

and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder. 

Inspection folders are saved in the project file. An inspection folder can include the data specific to the 

inspection of a tube bundle with a specific technology and could be named SS316_075x0.065_ECT for 

instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.  
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage.  You can select an existing 

project/folder, or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your Project file. Select New, 

Folder and enter the chosen name. You can then select the newly created folder and click on Select 

Folder.  
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Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your inspection.  

 

 
2. Click Select. This will define the position where the setup(s) and data will be saved. 
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SETUP WIZARD 

In this section, we will show how to create a setup using the New Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. inchesThe default 

measurement for imperial units is inches. When finished, click on Preferences again to go back to the 

General window.  

 

 

To create a new setup, it’s strongly suggested to use the Wizard option menu. Click on Create Setup to 

start the Wizard. 

  



413 

 

COMPONENT DEFINITION 

The first page shown by the Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is 

used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on 

this material.  

It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 
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You will be back to the Component Definition window. If you added a new material, it will now be available 

in the material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube’s outer diameter and length. 

These tube properties will help Magnify to suggest the optimal scan parameters. 

Click Next when everything is set correctly.  
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PROBE SELECTION 

In the Probe Selection window, you must select the probe you will be using for your inspection. 

You can filter the probe list by choosing an inspection technique from the Technique: drop-down menu. 

More precise filtering can be done by using the Model drop-down menu.  You can then select your probe 

by its catalog number (PRBT-NFA-BBAA) and then click Next. 
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SCAN DEFINITION 

The Scan Definition window is used to configure the axial position measurement method, the acquisition 

rate and the typical probe speed.  

  

The position along the tube can be defined by using either the internal clock of the system, or by using an 

axial encoder. If you use the internal clock, the default position will be given assuming that the probe is 

always pulled at the typical probe speed. If the typical probe speed is set to 300mm/s, and the time since 

the acquisition began was 2 seconds, then the system will indicate a position of 600mm. Using an encoder 

will give you the exact position of the probe. Note that the position can also be obtained by using the 

landmark tool, but this feature will be shown later.  

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate 

is set to 1500 Hz for NFA.  

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For instance, 

with an acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points 

per millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t be 

constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial 

resolution target. The typical probe speed should be set as close as possible to the real value. This will 

help the algorithm that automatically detects landmarks (this will be explained in the Landmarks section). 

The recommended pulling speed for NFA is approximately 300mm/s. 

The Probe Resolution (Circular Axis) is defined by 360 divided by the number of pancake coils located on 

the circumference of the NFA probe. For this instance, the 18mm NFA have 28 coils, so the resolution is 

12.85. The Displayed Resolution (Circular Axis) is the number of points displayed in the C-scan and it is 

defined by the Probe Resolution divided by the Oversampling (interpolation).  

The Displayed Resolution (Axial Axis) is defined by typical probe speed divided by the Acquisition rate.  

The size is the length of the tube to be inspected. The length needs to be set accurately for the Landmarks 

work in Magnifi. 
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If you select to measure the position from Encoder, different fields will appear, and a second Scan 

Definition page will become available. 

  

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered. 

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the 

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition 

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a 

speed exceeding the Maximum probe speed, there will be gaps in the data.  

The second page includes the type of encoder and its resolution. A preset can also be specified if your 

acquisition doesn’t start at 0 mm.  

 

Click Next when you’re finished. 
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DATA DEFINITION 

The Data Definition window is used to set the hardware gain, frequency and drive voltage for the Absolute 

and Array channels. It is important to set these parameters correctly before acquiring the data since they 

are driven by the instrument and cannot be modified during the analysis. But NFA the set frequency will 

not change.  

  

By default, Magnifi suggests one frequency set by default to 8kHz. 

But frequency and drive voltage can be changed by replacing the value of your choice. Up to 4 frequencies 

can be set at the same time. And the sum of their amplitude cannot exceed 10V. Also, the Absolute 

channel(s) cannot use a different frequency than the Array channel(s). They are linked together. 

Click on Next when the desired parameters are entered.  
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DATA PROCESSING 

The Data Processing window is used to configure the signal processing to apply to the channels.  

You can choose to configure every frequency individually or you can apply the same filters to every 

channel with the Individually configure all the channels check box.  

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can 

be changed without any problem during data analysis, while a wrong parameters choice for the data 

acquisition can mislead the analysis. It is possible to change the filters parameters after the acquisition, 

so it is always possible to fine tune the filters parameters during the analysis. 
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The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful 

when your defect signal has a lower frequency content than the background noise. In this case, using a 

filter will remove part of the noise without removing the defect’s signals. This may help with data analysis. 

However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too 

low will filter out the defect’s signals.  

The median high pass filter is used to filter out low frequency noise such as lift-off variations of the probe 

within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of the high-

pass median filter should be set to at least three times the axial length of the longest flaw that may be 

encountered. Data should be examined in both its filtered and unfiltered states. It is important to keep in 

mind that the median high-pass filters can distort phase. More information about median filters for NDT 

analysis can be found on Eddyfi’s blog.  

Click Next when you are done.  
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CALIBRATION POINTS 

The Calibration Points page is used to define the points in your calibration tube. These indications will 

later be used to calibrate your probe and to build sizing curves.  

The units of measurement can be set in percentage or in depth (millimeters or inches).  

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and 

size. The side and size of the flaw will be used to position the calibration point on the sizing curve(s).  

Calibration points can also be imported with the Import button.  

 

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).  

CALIBRATION 

The Calibration pages are used to define reference signal(s) that will be used to set the amplitude(s) and 

phase(s) of each channel using the selected measurement method.  
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By default, the calibration is performed on the 9.5mm 50% round bottom hole for the array channels. The 

angle will be 90° for CIRC channel and 42° for PIT and RAW. For all array channels the voltage will be set 

to 2V. For the conventional channel the GR-20 is set to 2V, 90°. However, the calibration can be done 

differently on each channel type. It can also be done individually for each frequency by selecting the 

Individually configure all the channels option. Different reference signals can be set to calibrate the phase 

and the amplitude independently.  
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When you select the reference signal, the system will use the selected measurement method to apply a 

rotation and a gain. Here is a short description of the available options: 

 

1. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

2. Absolute Horizontal (AH):  

Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

3. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

 

 

4. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 
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5. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

6. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

7. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Used only and recommended for absolute signals. 

8. Average Peak Horizontal (MPH):  

Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 

9. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

10. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

11. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

12. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

13. Peak to peak First Transition (PPF):  

Uses the combination of the vertical and horizontal component of the first transition of the signal 
to measure maximum amplitude. The first signal transition is from the base of an indication to its 
peak.Click on Next went the parameters in the table are set according to your requirements. 
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SIZING CURVES 

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this 

table.  

 

The sizing curve will allow you to estimate the size of a defect based on the calibration points signals 

amplitude obtained with your calibration standard. Magnifi will give you the interpolated flaw size based 

on the built sizing curves. 

Sizing curve names are customizable. The channel source and measurement type can also be changed. 

You can add sizing curves by clicking on the Add button. 

Click Next when you are done. 

For every sizing curve created in the last window, a window will appear to configure the curve properties. 

The name of the curve will be shown in the upper left corner of the page (TAPER in the example below).  
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The measurement method options are the same as what is described in the calibration section of this 

document. By default, the peak-to-peak option is set for all channels.  

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of 

the available options: 

1. Best Fit (Dual linear) (for phase measurement only):  

A curve with two linear segments representing ID and OD (or Near and Far) side calibration 

points with respect to phase. 

2. Best Fit (Dual Slope) (for phase measurement only):  

A curve with two segments representing ID and OD (or Near and Far) side. The ID section is 

linear and the OD section is polynomial. The OD side of the curve will need at least three points 

(including the hole) in order to trace a polynomial curve. 

3. Best Fit (Polynomial) (for phase and amplitude measurements):  

Best polynomial (degree 2) interpolation within the measured calibration points (requiring at 

least three points). 

4. Connected Points (for phase and amplitude measurements):  

Simple, point-to-point curve. 
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5. Best Fit (Linear) (for phase and amplitude measurements):  

Best linear interpolation within the measured calibration points 

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements): 

Polynomial (degree 2) interpolation with two segments for both ID and OD side of the curve. 

Need at least three points.  

The linear options are mostly used when few data points are available, while the Best fit (Dual Polynomial) 

option is a more precise method when your calibration tube has multiple defects. 

Once the measurement method and the interpolation curve shape are chosen, you can select the curve 

points for each sizing curve previously created. The order in which the points appear in the list may 

influence your sizing cure. Make sure that the measured values of the calibration points are in ascending 

order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking 

the box Report as remaining wall thickness. 

Click Next when you are done.  
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INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Next when you are done 
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DISPLAY 

The first Display window is used to set how the data is displayed during and after the acquisition.  

 

The scroll direction is the direction in which data appears on the screen. If you choose downward, the 

signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal 

will go from the bottom to the top of the screen.  

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box. 

The strip chart duration is the length of a Strip chart window when the data is acquired. 

Click Next. 

The second Display window is used to set the layouts. Checking the tick boxes in this window will make 

the proposed layouts available in your setup. You will be able to switch from one the another via the 

layout tab The " C " stands for code, " S " stands for Strip chart," L " for Lissajous, " CS " for C-scan and " CS-

3D " for 3D C-scan. 

The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 
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Layouts can be readjusted at any time.  

 

Click Next to complete the setup wizard process. 

 

SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the 

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change.  

 

This will open one of the windows previously described, where you can change the values you originally 

entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This 

will apply the modification to the setup.  
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Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed 

using advanced settings, the information shown using the Setup tab may not match your actual setup. 

 

SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 

 

The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 
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The following table shows the possible icons and their meaning: 

Icon Description Meaning 

(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 

 

 

Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 

detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 
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Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 

LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools. 

 

The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can however give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 
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Three landmarks are created if you press on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position) or on the place you stop to record (usually the 

operator side). 

 

 

In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 

Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. And the Threshold is the voltage amplitude threshold. 
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Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the right position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates don’t need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tubesheets). 
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If you are using the conventional detection tools, you can set up the regions according to the automatic 

analysis tools you will use with the Indications and DVQ buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view. 

 

 

There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

 

And seven waveform types: 

 Up 

 Down 

 Down-up 
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 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 

 

Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 

 

 

DATA QUALITY VALIDATION (DQV) 

Data Quality Validation allows defining tests to validate the quality of the data. 
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Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 

 

• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-length of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 

• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows group a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together for which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 
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GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications.  

 

The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 
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The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 

Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 
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It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 

 

Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUT 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 

 

DATA LIST 

Magnifi will create a file for each inspected tube. The list of tubes can be created in the Data List section 

of the General tab of the Backstage. 

 

 

Four options are available to set the filename format: 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

Click on the Create New List button. The displayed window will be different depending on the chosen 

filename format. 

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 

then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 
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generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 

list.  

 

 

 

The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the file name window of the Frontstage. 

The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in Tubepro.  
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PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button. 

2. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect and 

then click Connect. 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To download 

a matching version into your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  

 

 

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is used to 

scan your calibration tube and make the necessary adjustments on your setup without saving the data 

automatically. The acquisition mode is used for the inspection. In this mode, the software automatically 

saves the acquired data using file names based on the tube list.  
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

4. Plug the NFA probe on the Ectane 160-pin connector.  

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

6. Push the probe head all the way through the tube so that it exits the tube. 

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

8. Pull the probe at approximately 12’’/s (300 mm/s). 

9. When it’s done, press the Stop button or F2 again on your keyboard. 
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VISUALIZING THE DATA 

Multiple options are available to select your data and to measure it. The following describes useful 

functions to do so: 

DISPLAYED CHANNEL 

There are four buttons at the upper right corner of the C-Scans, Strip charts and Lissajous windows. These 

buttons are used for the channel selection. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 

are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 

channel.  

 

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 

desired channel to select it. Right-click or Left-click on this button to switch to the following or 

previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential) 

4. Same principle as 2., but for the frequencies only 
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STRIP CHARTS AXIS ORIENTATION 

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis 

to another, click on the box showing an arrow at the upper right corner of the Strip chart.  

 

ZOOMING 

On the strip chart/or on a C-scan, hold the right button of your mouse and drag on the zone of interest to 

zoom in this section. This operation can be done in both axis for the C-scan.  

 

 

 

 

 

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.   
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ADJUSTING THE CURSOR LENGTH 

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and 

the full line is the center of what you have selected.  

Only the portion of data between the dotted lines will be shown in the Lissajous.  

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse 

button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same 

operation, but with the right button of your mouse.  

ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  

 

Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 
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MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method. 

A short description of the measurement methods can be found in the above calibration section of the 

setup wizard.  

 

1. Clicking on the corner with the black triangle gives the list of measurement method for the 

amplitude of the signal. Click on the desired method to select it. Right- or left-click on this 

button to select the next or the previous method in the list.  

2. Same as 1., but for the phase measurement. 

3. Remove 180° to the measured phase. This option can be used if the software doesn’t measure 

the phase with the right orientation.  

4. Take the same two points in time to take the measurement in the other Lissajous 

5. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 

a vector on your Lissajous.  

LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotated applied, by definition. Also, rotating the 

signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.  

The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   

DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and use the spacebar on the keyboard. Calibration and sizing curves 
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CALIBRATION AND SIZING CURVES 

SLEW 

The NFA probes include bobbins that generate absolute channel(s). It also includes a set of pancake coils 

that generates C-scan(s). Since the bobbins and the pancake coils are not physically located at the same 

position on the probe, there is a time delay between the channels (coils) and the C-scan (pancakes coils).  

To bring all the signals at the same position, the bobbin channels can be shifted in time to match the C-

scan. This process is called Slew in Magnifi.  

To Slew: 

1. Click on the Slew button that can be found under the Calibration tab.  

 

2. Place your cursor over a flaw in your C-scan.  

3. Click on the button at the left in the Slew Calibration window. This will set the reference point at 

which the channels will move.  

4. Place your cursor over the same flaw but on the absolute channel.  

5. Click on the button at the right in the Slew Calibration window. 

6. Click on Apply. 

Note that this process will move the channel(s) by a constant number of samples. Therefore, a probe 

pulling speed that was not constant won’t have a data alignment that is valid throughout the hole scan.   
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CALIBRATION 

The following section describes how to calibrate your probe. 

1. Go to the Calibration tab and click on the System icon. 

2. Select Channel in the calibration window. 

3. In the Strip chart, select the signal to calibrate and adjust the cursors to see only the desired 

signal.  

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

 

4. Select the signal name in the list. 

5. Click on the green arrow button to associate the measured signal to the calibration point. 

6. If more than one calibration point is present in the list, repeat steps 3, 4 and 5 for each one. 

7. When all your calibration points are check-marked, click on the Calibrate button. 
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SIZING CURVES 

The following section describes how to build your sizing curves. 

1. Go the calibration tab and click on the Sizing curve button. 

2. Select Channel and Sizing Curves in the calibration window. 

3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal. 

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If for some reason the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to 

show the defect size. To have the correct interpolated point, the measurement method also needs to be 

the same as the one used for the sizing curve. To change the measurement method, click on the icons at 

the bottom left of the Lissajous. 

1. Select the signal name in the list. 

2. Click on the green arrow. 

3. Redo the previous steps for all the other indications in the list. 

4. Click on the Calibrate button. 
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LANDMARKS 

The following section describes how to calibrate your landmarks. 

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks 

window the same way as you calibrated the sizing curve(s) points. You can use the Land channel to do so.  

The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the far side 

tubesheet, that is, the first one encountered during data acquisition; TS1 is the nearside tubesheet). 

 

Once the landmarks are calibrated properly the system should be able to recognize them automatically.  

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far 

end of the tube is needed.  

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file.  
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You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  
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INSPECTION 

STANDARD ACQUISITION 

The following section describes how to perform an inspection. 

1. Connect Magnifi to the instrument. 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the NFA probe into the Ectane 160-pin connector. The orange dot on the connector must 

be aligned with the orange dot on the Ectane. 

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Push the probe all the way through the tube until it exits the far end.  

6. start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

7. Pull the tube probe towards you at a constant speed until it exits the tube. 

8. When finished, press the Stop button or again F2 on your keyboard. 

9. Repeat steps 4,5 and 6 for all the tubes to inspect in your bundle.  

MANUAL SEQUENCE 

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and 

can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are 

needed to use this feature. These landmarks can be created by using the Landmarks button under the 

SMART Setup tab.    

To set the manual sequence: 

1. Click on the Manual Sequence button under the Calibration tab.  

2. If a warning message is shown in this window, change the parameters until no warning is shown. 

The system will progress through the different windows to guide you.  

3. Click on Settings … 
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4. Select Landmark in the Type section. 

5. In the drop-down menu, choose the Landmark that will initiate the data recording. If you keep 

the default landmarks, you can select the Exit landmark that will be triggered when the probe 

goes out of the tube when the probe is pushed.  

6. You can enter a delay to start the acquisition after the first landmark is detected (Start 

Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop 

Acquisition Delay).  

7. Two options are available to restart the acquisition: The user can either push a button or use a 

timer. Select the desired option in the Restart section.  

8. Click on OK. 

To use the manual sequence: 

1. Connect Magnifi to the instrument 

2. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. The 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

3. Plug the NFA probe into the Ectane 160-pin connector. 

4. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

5. Open the Sequence window by clicking on the Manual Sequence button under the Calibration 

tab. 

6. Put your probe in the tube to inspect and click on the Launch button. This will start the data 

acquisition. 
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7. Push the probe until it exits the far end of the tube. If set correctly, , Magnifi will recognize the 

landmark and this will initiate the data recording.  

8. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection 

that will stop the data recording. 

9. Acquisition restart: 

a. If you selected User Input in the settings of the Manual Sequence Configuration, the system 

will wait for the user to enter information on the tube to restart the acquisition. Click on 

NDD or Review. This will add a tag to the inspected tube and it will restart the acquisition. 

Redo step 6, 7 and 8a. for all the tubes to inspect 

b. If you selected Timer in the settings of the Manual Sequence Configuration, a countdown 

will be triggered after the last tube acquisition was taken. The acquisition will start after this 

time has elapsed. Repeat steps 6 and 7 for all the other tubes to inspect in the bundle.  

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this is 

the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of the tube. 

In this situation, you can click on the Target button in the Sequence window to start the data recording. 

DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  

 

This list of tubes is shown in the Data window at the left of the Frontstage.  
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A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

go out of acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to the acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon.  

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A tube name can be changed by right-clicking on its name and by selecting the Rename option. 
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LOADING A FILE 

1. First disconnect your computer from the Ectane by clicking on the Disconnect button under the 

Home tab. 

2. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

3. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two (2) Indication buttons at the lower corner of the Lissajous windows can be used to add an entry 

to the report. These 2 buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to different flaws.  

To add an indication to the data: 

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is 

explained in the SMART Setup section of this manual. 

Indications can also be added to a tube to indicate, for instance, that it has no flaws or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab 

 

 

REPORT TABLE 

To access the list of indications entered: 

1. Make sure that the Report option is selected under the Layout tab.  

 

 

2. Click on the report ribbon at the bottom of the screen to make the list visible 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  
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2. Click on the Generate Report button under the Report section of the General tab. 

3. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tube in each category.  

  
4. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 

 

 

The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro.  
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INTRODUCTION 

This document presents how to set up and calibrate the MFL probe with Magnifi on an Ectane test 

instrument using the Setup Wizard.  

EQUIPMENT 

The MFL probes use a 19-pin connector that can be connected to an Ectane with the ‘’ERMN’’ option.  

The Absolute, Differential and Trail signal from the probe will provide Strip charts and Lissajous. Magnetic 

flux leakage technology gives a variation of amplitude only. The phase variation on the Differential channel 

is artificially built to help the user to identify the indications. The Trail signal is more sensitive to internal 

flaws and can help determine the flaw side in a tube. 

From the following table, the best standard probe for your application can be selected.  

Note that Eddyfi also offers custom products at diameter that are not shown in this table.  
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Table 12 – Probe diameter selection table 

 

The MFL calibration tube used in this document includes the following flaws: 

• Internal 360° groove, 10% of wall loss 

• External 180° groove, 40%,60% and 80% of wall loss 

• OD Flat bottom hole (FBH) 40%, 60% and 80% depth 

• Hole, 100% of wall loss 

Other combinations of flaws can be used to calibrate the probe and to build sizing curves.  
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PROJECT AND INSPECTION FILES 

In this section, we will create a folder structure that will manage the saving location of your setup, data 

and report. This management is operated through the creation of a Project. 

Magnifi suggests two levels of file. The first level is the Project. It is meant to include different inspections 

that are related in some way. For instance, it can include all the inspections done at a refinery shutdown 

and be named Refinery_Shutdown_May_2018. The second level of the file is the Inspection folder. 

Inspection folders are saved in the project file. An inspection folder can include the data specific to the 

inspection of a tube bundle with a specific technology and could be named SS316_075x0.065_ECT for 

instance. This inspection folder groups the setup, the tube list, the data files and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage.  You can select an existing 

project/folder or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your project file. Select 

New, Folder and enter the chosen name. You can then select the newly created folder and click 

on Select Folder.  
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your 

inspection.  

 

 
3. Click Select. This will define the position where the setup(s) and data will be saved. 
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SETUP WIZARD 

In this section, we will show how to create a setup using the Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement 

for imperial units is inches. When finished, click on Preferences again to go back to the General window.  

 

 

To create a new setup, it’s strongly suggested to use the Setup Wizard process. Click on Create Setup to 

start the Setup Wizard. 
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COMPONENT DEFINITION 

The first page shown by the Setup Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The ultrasound velocity is 

used to set IRIS parameters only, and it doesn’t need to be set if an IRIS inspection is not performed on 

this material.  

It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 
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You will be back to the Component Definition window. If you added a new material, it will now be available 

in the material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube’s outer diameter and length. 

These tube properties will help Magnify to suggest the optimal scan parameters. 

Click Next when everything is set correctly. 
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PROBE SELECTION 

In the Probe Selection window, select the probe you will be using for your inspection. 

You can filter the probe list by choosing an inspection technique from the Technique drop-down menu. 

More precise filtering can be done by using the Model drop-down menu.  You can then select your probe 

by its catalog number (PRBT-MFL-ADT) and then click Next. 
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SCAN DEFINITION 

The Scan Definition window is used to configure the axial position measurement method, the acquisition 

rate and the typical probe speed.  

 

The position along the tube can be defined by using either the internal clock of the system, or by using an 

axial encoder. If you use the internal clock, the default position will be given assuming that the probe is 

always pulled at the typical probe speed. If the typical probe speed is set to 1000mm/s, and the time since 

the acquisition began was 2 seconds, then the system will indicate a position of 2000mm. Using an 

encoder will give you the exact position of the probe. Note that the position can also be obtained by using 

the landmark tool, but this feature will be shown later.  

The acquisition rate is the number of acquisition points taken per second. By default, the acquisition rate 

is set to 2000 Hz for MFL. 

The axial resolution will depend on the combination of the acquisition rate and pulling speed. For an 

acquisition rate of 2000 Hz, the pulling speed needs to be less than 1m/s to have at least 2 points per 

millimeter. If you do not use a pusher-puller device such as the Probot, the pulling speed won’t be 

constant. Therefore, it is recommended to target a lower pulling speed to be able to reach your axial 

resolution target.  The typical probe speed should be set as close as possible to the real value. This will 
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help the algorithm that automatically detects landmarks (this will be explained in the Landmarks section). 

The recommended pulling speed for MFL is approximately 1000mm/s. 

If you select to measure the position from Encoder, different fields will appear, and a second Scan 

Definition page will become available.  

  

  

On the first page, the Typical probe speed, Maximum probe speed and the Density will have to be entered. 

The Maximum probe speed is the maximum acceptable speed for your probe and the Density is the 

number of acquired points per millimeter (axial resolution). These values will be used to set the acquisition 

rate and to optimize the acquisition processes used by the Ectane. Note that if your probe is pulled at a 

speed exceeding the Maximum probe speed, there will be gaps in data. 

The second page includes the type of encoder and its resolution. A preset can also be specified if your 

acquisition doesn’t start at 0 mm.  

Click Next when you’re finished. 

  



481 

 

DATA DEFINITION 

The Data Definition window is used to set the hardware gain for the different channels. It is important to 

set these parameters correctly before acquiring the data since they are driven by the instrument and 

cannot be modified during the analysis.  

 

Click on Next when the desired parameters are entered.  

The next window is used to build mixed channels. For MFL, a mix channel is built by default to create a 

differential signal shape on the differential signal. This part of setup is used for internal signal processing 

purposes only and it is not recommended to change it.  
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Click on Next. 

DATA PROCESSING 

The Data Processing window is used to configure the signal processing to apply to the channels.  

Note that the signal processing is done after the data acquisition. An inappropriate parameter choice can 

be changed without any problem during data analysis, while a wrong parameters choice for the data 

acquisition can mislead the analysis. It is possible to change the filters parameters after the acquisition, 

so it is always possible to fine tune the filters parameters during the analysis. 
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The low pass filter eliminates part of the signal that is above a certain frequency. As an example, it is useful 

when your defect signal has a lower frequency content than the background noise. In this case, using a 

filter will remove part of the noise without removing the defect’s signals. This may help with data analysis. 

However, a cutoff frequency that is too high won’t remove much noise, and a cutoff frequency that is too 

low will filter out the defect’s signals.  

The median high pass filter is used to filter out low frequency noise or drift such as lift-off variations of 

the probe within the tube, changes in material, geometry or thickness. As a rule-of-thumb, the width of 

the high-pass median filter should be set to at least three times the axial length of the longest flaw that 

may be encountered. Data should be examined in both its filtered and unfiltered states. It is important to 

keep in mind that the median high-pass filters can distort phase. More information about median filters 

for NDT analysis can be found on Eddyfi’s blog.  

Click Next when you are done.  
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CALIBRATION POINTS 

The Calibration Points page is used to define the points in your calibration tube. These indications will 

later be used to calibrate your probe and to build sizing curves.  

The units of measurement can be set in percentage or in depth (millimeters or inches).  

You can add calibration points by clicking on the Add button. Specify the calibration point name, side and 

size. The side and size of the flaw will be used to position the calibration point in the sizing curve(s).  

Calibration points can also be imported with the Import button.  

 

Click Next when you have set the required calibration points for your calibration(s) and sizing curve(s).  
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CALIBRATION 

The Calibration pages are used to define reference signal(s) that will be used to set the amplitude(s) and 

phase(s) of each channel using the selected measurement method. 

By default, the calibration is performed on the Hole signal by adjusting it to 1V and 90° on the differential 

channel. The wear scar 60% is used to calibrate the absolute channel at 6V and 90°. And the inside 

diameter groove is used to set the trail signal at 10V with a phase of 0°. These calibrations are done to 

have the amplitude on one axis only (0° or 90°) since signals from the MFL probe don’t have a phase. 

Different reference signals can be set to calibrate the amplitude independently for each channel. Simply 

modify the parameters in the table to customize the calibration.  

 

When you select the reference signal, the system will use the selected measurement method to apply a 

rotation and a gain. Here is a short description of the available options: 

1. Absolute (A):  

Uses a straight line from the Lissajous origin to the main cursor position to measure amplitude. 

2. Absolute Horizontal (AH):  

Uses only the horizontal component, from the Lissajous origin to the main cursor position to 

measure amplitude. 
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3. Absolute Vertical (AV):  

Uses only the vertical component, from the Lissajous origin to the main cursor position to 

measure amplitude. 

4. Absolute Peak (AP):  

Uses a straight line, from the Lissajous origin to the peak value of the data selection, to measure 

amplitude. 

5. Absolute Peak Horizontal (APH):  

Uses only the horizontal component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

6. Absolute Peak Vertical (APV):  

Uses only the vertical component, from the Lissajous origin to the peak value of the data 

selection, to measure amplitude. 

7. Average Peak (MP):  

Takes the distances from points at the extremity of the cursor to the peak of the data selection 

to build an average vector. Only used and recommended for absolute signals. 

8. Average Peak Horizontal (MPH):  

Uses the horizontal component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals. 

9. Average Peak Vertical (MPV):  

Uses the vertical component of the distances form points at the extremity of the cursor to the 

peak of the data selection to make an average vector. Used for absolute signals.   

10. Peak to peak (PP):  

Uses the combination of the vertical and horizontal component to measure the maximum 

amplitude. 

11. Horizontal (PPH):  

Uses only the horizontal component to measure the amplitude. 

12. Vertical (PPV):  

Uses only the vertical component to measure the amplitude. 

13. Peak to peak First Transition (PPF):  

Uses the combination of the vertical and horizontal components of the first transition of the signal 
to measure maximum amplitude. The first signal transition is from the base of an indication to its 
peak. 

 

SIZING CURVES 

The first page of this section is the definition of your sizing curves. A curve will be built for each line in this 

table.  
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The sizing curve will allow you to estimate the size of a defect based on the calibration points signals 

obtained with your calibration standard. Magnifi will give you the interpolated flaw size base on the built 

sizing curves. 

Sizing curve names are customizable. The channel source and measurement type can also be changed. 

You can add sizing curves by clicking on the Add button. 

Click Next when you are done. 

For every sizing curve created in the last window, a window will appear to configure the curve properties. 

The name of the curve will be shown in the upper left corner of the page (ABS in the example below).  
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The measurement method options are the same as what is described in the calibration section of this 

document. By default, the Peak-to-Peak option is set for absolute channels and the differential channels.  

The interpolation method can be selected with the Shape dropdown menu. Here is a short description of 

the available options: 

1. Best Fit (Dual linear) (for phase measurement only):  

A curve with two linear segments representing ID and OD (or Near and Far) side calibration 

points with respect to phase. 

2. Best Fit (Dual Slope) (for phase measurement only):  

A curve with two segments representing ID and OD (or Near and Far) sides. The ID section is 

linear, and the OD section is polynomial. The OD side of the curve will need at least three points 

(including the hole) in order to trace a polynomial curve. 

3. Best Fit (Polynomial) (for phase and amplitude measurements):  

Best polynomial (degree 2) interpolation within the measured calibration points (requiring at 

least three points). 

4. Connected Points (for phase and amplitude measurements):  

Simple, point-to-point curve. 

5. Best Fit (Linear) (for phase and amplitude measurements):  
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Best linear interpolation within the measured calibration points 

6. Best Fit (Dual Polynomial) (for phase and amplitude measurements): 

Polynomial (degree 2) interpolation with two segments for both ID and OD side of the curve. 

Need at least three points.  

Once the measurement method and the interpolation curve shape are chosen, you can select the curve 

points for each sizing curve previously created. The order in which the points appear in the list may 

influence your sizing cure. Make sure that the measured values of the calibration points are in ascending 

order on the list. You can set Magnifi to show the remaining wall instead of the defect size by checking 

the box Report as remaining wall thickness. 

Click Next when you are done.  

INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Next when you are done 
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DISPLAY 

The first Display window is used to set how the data is displayed during and after the acquisition.  

 

The scroll direction is the direction in which data appears on the screen. If you choose downward, the 

signals will go from the top to the bottom of the screen. If you choose the upward direction, the signal 

will go from the bottom to the top of the screen.  

You can enable/disable the miniature strip chart under the Lissajous by checking/unchecking the box. 

The strip chart duration is the length of a Strip chart window when the data is acquired. 

Click Next. 

The second Display window is used to set the layouts. Check marking the proposed layouts will make them 

available in your setup. You will be able to switch from one to the another via the layout tab. The " S " 

stands for Strip chart, " L " for Lissajous and “C” is for the defect Code indication zone.  

The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 

Layouts can be readjusted at any time.  
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Click Next to complete the setup wizard process. 

 

SETUP MODIFICATIONS 

Some parameters or preferences may need to be modified after the Setup Wizard process. To modify the 

parameter previously entered, you can go to the Setup tab in the Frontstage and click on the button 

associated with the parameter you want to change.  

 

This will open one of the windows previously described, where you can change the values you originally 

entered. If applicable, go through the process by clicking on Next, and then click on the Finish button. This 

will apply the modification to the setup.  

Advanced settings can be found under the Advanced tab of the Frontstage. If parameters are changed 

using the advanced settings, the information shown using the Setup tab may not match your actual setup.  
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SMART SETUP TOOLS 

Additional functions, which facilitate data analysis, can be set up under the SMART Setup tab.   

LOGBOOK 

The first button on the left side under the SMART Setup tab allows you to enable or disable the logbook. 

 

The logbook stores information about the analysis in addition to allowing the following functions: batch 

screening, seeing results at a glance from the data list pane and saving manual modifications made to the 

landmarks during the analysis. 

The logbook stores the following information: landmarks (type, position, dimension, including manual 

modifications), indications (AI and conventional, label, position, dimension, etc.), indication grouping, and 

data quality validation results. When enabled, an additional column is added to the data file list to allow 

seeing results and to filter, sort, or analyze according to these results. 

 

The following table shows the possible icons and their meaning: 

Icon Description Meaning 

(empty) Empty 
No logbook entry associated with this file because 

it has not been screened yet. 
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Dashed outline circle, 

without a number 

Logbook entry associated with the file contains 

information such as landmark detection or regions. 

The absence of additional information on the icon 

reveals that no indication detection engine or DQV 

tests were enabled when the logbook was written. 

 
Dashed outline circle, with a 

number 

Logbook entries associated with the file contains 

information such as landmark detection as well as 

detected indications. The number displayed inside 

the circle shows the quantity of potential 

indications detected. 

No DQV tests were enabled when the logbook was 

written. 

 
Dashed outline circle, with a 

green check mark 

The green check mark indicates that the DQV 

test(s) passed on this file. 

 
Dashed outline circle, with a 

red cross 

The red cross indicates that at least one DQV 

test(s) failed on this file. 

 

Dashed outline circle, with a 

number, with a green check 

mark 

The logbook entries associated with this file 

indicates that potential indications have been 

detected by the detection engine and that the DQV 

test(s) passed. 

 
Dashed outline circle, with a 

number, with a red cross 

The logbook entries associated with this file 

suggest that potential indications have been 

detected by the detection engine and that at least 

one DQV test(s) failed. 

 Orange warning triangle 

The AI detection tools identified an unusual 

situation. In this case, the level of confidence in the 

detection findings could be very low. Therefore, 

users should pay special attention when reviewing 

the detection results. 

 

The logbook is saved within the inspection folder. Its data is written when a file is screened using the 

dedicated buttons in the Analysis ribbon. It is also automatically written when a file is loaded while the 

logbook is enabled, and no logbook entry existed for this file yet. 

It is worth mentioning that the logbook also includes defects and landmarks, even if these have been 

detected with detection tools that do not use AI (conventional landmark detection and indication boxes). 

Also note that the automatic indication detection tools are not available if you use the acquisition license 

(ACQ). 
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LANDMARKS 

The Landmarks button is used to setup the parameters for landmark detection with conventional tools. 

 

The Landmark Detection window is used to configure the automatic detection of features such as tube 

sheets and support plates. Landmarks are not mandatory and don’t need to be set to have functional 

setup. They can however give a reference for the axial position in a tube. They can also be used by the 

software to trigger automatic acquisition sequences. 

 

Three landmarks are created if you press on the Suggest button. The channel selected to detect these 

landmarks should be the lowest frequency absolute channel. The R_ before the channel stands for Raw. 

This is the signal of the channel without software filter, rotation, or software gain applied. 

You can base the position of your landmarks either on the location where you start to record (usually the 

tube entrance, opposite from the operator position) or on the place you stop to record (usually the 

operator side). 
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In the above example, the Exit landmark is detected when the probe exits the tube at its outer end. It has 

a negative position because this event happens before entering the tube. It is enabled only when doing 

the acquisition. 

TSI is the first tube sheet encountered when the probe is pulled. TSO is the last tube sheet encountered 

at the end of the acquisition. 

Landmark detection can be set up manually by describing the shape, component, and voltage threshold 

that will trigger the detection. The Shape describes the appearance of the signal when the landmark is 

reached. If a differential signal shape is chosen, the Peak-to-Peak distance (“P2P”) will also be needed. 

The Direction is the projection axis (horizontal or vertical) of the Lissajous signal that will be taken to 

trigger the landmark. And the Threshold is the voltage amplitude threshold. 

Landmarks can be calibrated on real signals; in this case, there is no need to change these parameters as 

they will be automatically measured by the software. It’s important to set the landmark positions as 

accurately as possible. If the position is not accurately set, the software might prevent their automatic 

detection since it won’t be at an expected position. 

The Type field is a name that associates the calibration point with the landmark. If landmarks share the 

same Type, they will be calibrated at the same time using the same point and process. To associate two 

landmarks with the same Type, their signal must be the same. If support plates of the same geometry are 

present in a bundle, they can share the same Type. In the above example, TS1 and TS2 don’t share the 

same Type because one is triggered when the probe goes inside the tube and the other is triggered when 

the probe exits the tube. 

The Detection Engine drop-down menu can be set to Legacy or Extended. With the Legacy mode, all the 

landmarks need to be entered with the right position. The system will look for the exact number of 

landmarks entered at positions close to those entered in the table. With the Extended mode, the system 

will look for a number of landmarks between the Qty max and the Qty min. With this mode, the exact 

number of support plates don’t need to be constant or known. 

REGIONS 

The Regions option allows the user to define inclusion/exclusion zones based on Landmarks. This is used 

to categorize the data to process correctly. For example, they can be useful for restricting the detection 

of channel saturation to an area within the tube or specify an automatic analysis type for a given region 

(e.g., under the tubesheets). 
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If you are using the conventional detection tools, you can set up the regions according to the automatic 

analysis tools you will use with the Indications and DVQ buttons (described later). 

INDICATIONS 

The Indications module allows the user to define various zones or even waveform types to trigger a certain 

detection threshold. 

 

These detection zones can be applied to conventional channels and C-scan channels. The Label is the name 

that will appear in the Code view. 
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There are five zone types: 

 Absolute pie 

 Differential pie 

 Centered rectangle 

 Rectangle 

 Over or under a horizontal or vertical threshold 

 

And seven waveform types: 

 Up 

 Down 

 Down-up 

 Any direction 

 Up-down 

 Down-up-up 

 Up-down-up-down 

 

Each zone or waveform can be linked to a defined region, and thresholds can be set. The zone types also 

include the boundary setting to prevent signal oscillation from triggering unnecessary detections. 

Detection zone parameters can also be set by clicking on the Lissajous of the used channel and activating 

the Edit Alarm option on the Current View tab. 

The detected indication can be found in the Indication window, which can be activated in the Layout tab. 
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Clicking on an indication in the pane instantly positions the cursor on the selected indication in the Strip 

chart view. If you click on an indication in the code view (described later), the associated indication is 

highlighted in the Indications pane. 

 

 

DATA QUALITY VALIDATION (DQV) 

Data Quality Validation allows defining tests to validate the quality of the data. 

 

Five test types are available. To add a test, click on the Add button on the DQV page and select the test 

type with the drop-down menu. Parameters associated with this test can be changed in the Details section 

of the DQV window. 
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• Dead Channel: Verify that channels are reading a signal whose amplitude is above a defined 

threshold. An amplitude that remains below the threshold throughout the scan indicates a dead 

channel. 

• Landmark Detected: Verify the presence of all the selected landmark names in the Details section. 

To validate full tube-length of straight bundles for ECT bobbin data using AI detection, select this 

option and check the TSI and TSO landmarks. When AI setup for landmarks is completed and the 

TWH calibrated, the DQV test will automatically use the AI results to perform the test. 

• Hardware Saturation: Verify if signal saturation appears on raw channels. The merge field allows 

grouping a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region, 

for example, the areas inside the tube. 

• Channel Saturation: Verify if signal saturation appears on calibrated channels. The merge field 

allows group a zone together for which the test has failed. This function avoids having many 

notifications if the test fails several times in one area. This test can be limited to a specific region. 

• C-scan Saturation: Verify if signal saturation appears on C-scans. The merge field allows grouping 

a zone together for which the test has failed. This function avoids having many notifications if the 

test fails several times in one area. This test can be limited to a specific region. 

The results of the DQV tests can be found in the DQV window, which can be activated in the Layout tab. 
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GROUPING 

The grouping tool can help the analyst find critical indications for review as it categorizes and groups the 

automatically detected indications.  

 

The Grouping menu offers a default configuration with three predefined categories: 

• Support Plates 

• Critical 

• Less Critical 
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The Details section of each group shows the parameters defining the conditions that must be met for a 

detected indication to be classified in this group. The user can modify all parameters. 

By default, the Support Plates group is configured with the mix channel with a Peak-to-Peak (PP) 

measurement method, and Max/Min threshold values are set for amplitude and phase. For this group, 

the criteria are limited to indications detected under the SP regions. As a result, the indications detected 

under support plates for which all conditions are true will fall into this category. 

Critical and Less Critical are two other groups predefined in the Grouping window. Both groups are set on 

DIF-F2 channel, but with different Amplitude/Phase measurement settings. In both cases, the grouping 

criteria is restricted to In Tube and Air to Air (for calibration tubes) regions, which covers the full-tube 

length data. 

It should be noted that each automatically detected indication can only be categorized in a single group. 

Also, the grouping operation is executed according to the order of the groups defined in the Groups list. 

Therefore, if a given indication meets all the criteria of the first group, it will be categorized in this group. 

If not, it will be passed to the following group. If it meets all the criteria of the second group, it will be 

categorized into this one. If not, it will again be passed to the next group, and so on. If an indication does 

not meet the criteria of any group, it will be placed in the Unclassified group. This implies that every single 

indication will be categorized, and none can appear simultaneously in more than one group. 

New groups can be created with custom parameters. 
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It is also possible to remove a group or use the up/down arrow keys to change the group priority within 

the list. 

 

In the Front stage interface, the Grouping results will be displayed in the Indications pane. 
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To help the analyst focus on the most relevant detected indications furthermore, it is possible to hide the 

Unclassified indications. To accomplish this, check the box “Hide unclassified indications” at the bottom 

of the Grouping menu and click on OK. 

 

Enabling this option influences the following elements of the software: 

• Indications pane; 

• Code view; 

• Logbook column. 

The images below compare them when the Unclassified indications are shown (left) and when they are 

hidden (right). 

When the option is enabled, the Indications pane will not show the “Unclassified” group. The count in the 

header serves as a reminder to the user that not all indications are currently shown. 
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In the Code view, the red markers from the Unclassified indications have been removed. 
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In the data file list, the number shown in the Logbook column represents the number of visible indications, 

matching the number shown in the header of the Indications pane. 
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REPORT SHORTCUT 

Keyboard shortcuts can be used to make entries in the report. By opening the shortcut window, it is 

possible to select a channel with a measurement method and to associate an indication with it. 

 

For example, we could use the differential channel F2 with a Peak-to-Peak measurement method to enter 

pits in the report. 

 

To select a key, press the Shortcut field and press the desired key on your keyboard. It is possible to use a 

single key or a combination of keys such as ALT+D, for example. 

When a report entry is made with the keyboard shortcut, the abbreviation of the type of indication 

displays momentarily on the corresponding Lissajous. 
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DATA SCREENING 

Data screening set up with the SMART Setup tools can be performed by the two buttons on the left under 

the Analysis tab. 

 

It is possible to run analysis on a selection of files or all files. The analysis is typically performed on all files 

when the setup and calibration are adequate. The results are recorded in the logbook and can be viewed 

in the Data window. 

 

DATA LIST 

Magnifi will save a file for each inspected tube. The file names are defined by creating a list of tubes.  

This list can be created in the Data List section of the General tab of the Backstage. 

 

 

1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

Click on the Create New List button. The displayed window will be different depending on the chosen 

filename format. 

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 

then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 
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generate the list of tubes. You can also use the Create & New button to add another set of tubes to your 

list.  

 

 

 

The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the Data window of the Frontstage. 

 

The tube list can also be imported from another project using the Import List button. The tube list file can 

be found in the Inspection folder. It is also possible to import a list created in the Tubepro software 

(available from Eddyfi).  
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PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on Start/Resume button. 

2. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect and 

then click Connect. 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To download 

a matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  

 

 

Two acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. The Setup Mode is 

used to scan your calibration tube and make the necessary adjustments on your setup without saving the 

data automatically. Acquisition mode is used for the inspection. In this mode, the software automatically 

saves the acquired data using file names based on the tube list.  
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3. For the calibration phase, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

4. Plug the MFL probe on the Ectane 19-pin connector.  

5. Bring the probe head in a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

6. Push the probe head all the way through the tube so that it exits the tube. 

7. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

8. Pull the probe at approximately 1 m/s. 

9. When it’s done, press the Stop button or F2 again on your keyboard. 

 

Note that a red zone in the code pane means that at least one of the raw signals is saturated. This is usually 

the case when your probe is out of the tube.  

VISUALIZING THE DATA 

Multiple options are available to select your data and to measure it. The following describes useful 

functions to do so: 
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DISPLAYED CHANNEL 

There are four buttons at the upper right corner of the Strip charts and Lissajous windows. These buttons 

are used for the channel selection. 

 

1. Links Strip charts and Lissajous to the same channel. For instance, if a Lissajous and a Strip chart 

are both set to 1, setting the Lissajous to DIF-F1 will also set the associated Strip chart to this 

channel.  

 

2. Clicking on the corner with the black triangle gives the list of available channels. Click on the 

desired channel to select it. Right-click or Left-click on this button to switch to the following or 

previous channel in the list.  

 

3. Same principle as 2., but for the type of channel only (absolute or differential) 

4. Same principle as 2., but for the frequencies only 

STRIP CHARTS AXIS ORIENTATION 

The Strip charts are projections of the Lissajous on the vertical or horizontal axis. To switch from one axis 

to another, click on the box showing an arrow at the upper right corner of the Strip chart.  
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ZOOMING 

On the strip chart, hold the right button of your mouse and drag on the zone of interest to zoom in this 

section.  

   

To zoom out, right-click on the Strip chart and select Previous Zoom or Full Extent.   

 

ADJUSTING THE CURSOR LENGTH 

On a Strip chart, the cursor is divided by 3 lines. The dotted lines represent the limit of your cursor and 

the full line is the center of what you have selected.  

Only the portion of data between the dotted lines will be shown in the Lissajous.  

To adjust your cursor length, hover your mouse over the dotted line, and click and drag the left mouse 

button. This will adjust the 2 dotted line symmetrically. To adjust only one dotted line, do the same 

operation, but with the right button of your mouse.  

ADJUSTING THE SCALE 

The scale of a window (Lissajous or Strip chart) can be modified by clicking on the scale button with the 

left button (decrease scale) or the right button (increase scale) of your mouse.  
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Another way to modify the scale is to click and drag (up or down) the right button of your mouse on the 

scale button. 

MEASUREMENT METHOD 

The buttons at the lower left corner of the Lissajous windows are used to select the measurement method. 

A short description of the measurement methods can be found in the above calibration section of the 

setup wizard.  

 

5. Clicking on the corner with the black triangle gives the list of measurement method for the 

amplitude of the signal. Click on the desired method to select it. Right- or left-click on this 

button to select the next or the previous method in the list.  

6. Same as 1., but for the phase measurement 

7. Remove 180° to the measured phase. This option can be used if the software doesn’t measure 

the phase with the right orientation.  

8. Take the same two points in time to take the measurement in the other Lissajous. 

9. Allow a manual measurement of the signal. Click and drag the left button of your mouse to draw 

a vector on your Lissajous.  

LISSAJOUS ROTATION AND PANNING 

The signal in a Lissajous can be rotated by holding CRTL on the keyboard while holding the left button of 

your mouse and dragging it around the rotation axis. Note that this operation cannot be performed on 

the raw channels since these channels have no gain or rotation applied, by definition. Also, rotating the 

signal will affect your calibration. If you perform this operation, make sure to recalibrate afterwards.  

The origin point can also be moved by holding the left button of your mouse on the Lissajous background 

and by dragging it in the desired direction.   
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DATA CENTERING 

To center the data in the different windows, put your cursor at a point where you want the data to be 

centered and use the spacebar on the keyboard.  

CALIBRATION AND SIZING CURVES 

SLEW 

The MFL probes include two bobbins that generate absolute and differential channels. It also includes a 

Trail bobbin. Since the Trail is not physically located at the same position as the other coils, there is a time 

delay between the Differential/Absolute channels, and the trail channel.  To bring all the signals at the 

same position, the trail channel can be shifted in time to match the other channels. This process is called 

Slew in Magnifi. 

To Slew: 

1. Click on the Slew button that can be found under the Calibration tab.  

 

2. Place your cursor over a flaw in the strip chart of a Differential channel.  

3. Click on the button at the left in the Slew Calibration window. This will set the reference point at 

which the channels will move.  

4. Place your cursor over the same flaw but on the strip chart of the Trail channel.  

5. Click on the button at the right in the Slew Calibration window. 

6. Click on Apply. 

Note that this process will move the channels by a constant number of samples. Therefore, a probe pulling 

speed that was not constant won’t have a data alignment that is valid throughout the hole scan.   
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CALIBRATION 

The following section describes how to calibrate your probe. 

1. Go to the Calibration tab and click on the System icon. 

2. Select Channel in the calibration window. 

3. In the Strip chart, select the signal to calibrate and adjust the cursors to see only the desired 

signal.  

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 

when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

.  

4. Select the signal name in the list 

5. Click on the green arrow button to associate the measured signal to the calibration point. 

6. If more than one calibration point is present in the list, repeat step 3, 4 and 5 for each one. 

7. When all your calibration points are check-marked, click on the Calibrate button. 

 

SIZING CURVES 

The following section describes how to build your sizing curves. 

1. Go the calibration tab and click on the Sizing curve button. 

2. Select Channel and Sizing Curves in the Calibration window. 

3. Select the signal in your Strip chart and adjust the cursors to see only the desired signal. 

Note: The system calibrates the signal with a measurement method that is defined in the calibration part 

of the setup (previous step). It is recommended to read the data with the same method as the system 
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when you select your calibration point. This will allow you to see what the system is using to make its 

calibration. If, for some reason, the measurement is not taken properly, you may be able to readjust your 

cursor to have the right measured values.  

Also, when points are entered in the sizing curves, the interpolated value is displayed on the Lissajous to 

show the defect size. To have the correct interpolated point, the measurement method also needs to be 

the same as the one used for the sizing curve. To change the measurement method, click on the icons at 

the bottom left of the Lissajous. 

1. Select the signal name in the list. 

2. Click on the green arrow. 

3. Redo the previous steps for all the other indications in the list. 

4. Click on the Calibrate button. 

 

 

Sizing curves can also be adjusted manually. To do so, go the Calibration tab, and click on View Curves. 

The sizing curve window will appear. Each sizing curve you asked Magnify to create will be listed in the 

drop-down menu. If an invalid notification is present on the curve, it means that you either haven’t 

entered the sizing points yet or that Magnifi failed to create the curve. To adjust the sizing curve manually, 

enter the value in the table.  

To validate the curves, you can bring the measurement cursor over one of the calibrated flaws in the 

Lissajous and get an estimation of the depth (shown in the lower right corner). If the flaw size does not 

appear, it means that you are not in a channel where a sizing curve was set. 
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LANDMARKS 

The following section describes how to calibrate your landmarks. 

Go to the calibration tab and click on the Landmark icon. Calibrate the landmarks shown in the Landmarks 

window the same way as you calibrated the sizing curve(s) points. You can use the Land channel to do so.  

The positions of TS1 and TS2 are described in the Landmark window in the Setup tab (TS2 is the farside 

tubesheet, that is, the first one encountered by the probe during data acquisition; TS1 is the nearside 

tubesheet). 

Once the landmarks are calibrated properly the system should be able to recognize them automatically.  

Note that in order to calibrate the default Exit landmark, a datafile that includes the probe exit at the far 

end of the tube is needed.  

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file. Note that when 

data is saved, the setup is also saved with it.  

 

You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  
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INSPECTION 

STANDARD ACQUISITION 

The following section describes how to perform an inspection. 

5. Connect Magnifi to your instrument. 

6. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

7. Plug the MFL probe into the Ectane 19-pin connector.  

8. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard.  

9. Push the probe all the way through the tube until it exits the far end.  

10. Start the acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 

on your keyboard. 

11. Pull the tube towards you at approximately 1m/s (40’’/s). 

12. When finished, press the Stop button or again F2 on your keyboard. 

13. Repeat steps 4,5,6 and 7 for all the tubes to inspect in your bundle.  

MANUAL SEQUENCE 

An inspection can also be done by using the manual sequence. This feature is based on the landmarks and 

can trigger the acquisition start/stop and the data recording automatically. At least two landmarks are 

needed to use this feature. These landmarks can be created by using the Landmarks button under the 

SMART Setup tab.    

To set the manual sequence: 

1. Click on the Manual Sequence button under the Calibration tab.  

2. If a warning message is shown in this window, change the parameters until no warnings are 

shown. The system will progress through the different windows to guide you.  

3. Click on Settings … 
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4. Select Landmark in the Type section. 

5. In the drop-down menu, choose the Landmark that will initiate the data recording. If you keep 

the default landmarks, you can select the Exit landmark that will be triggered when the probe 

goes out of the tube when the probe is pushed.  

6. You can enter a delay to start the acquisition after the first landmark is detected (Start 

Recording Delay) and a delay to stop the acquisition when the last landmark is detected (Stop 

Acquisition Delay).  

7. Two options are available to restart the acquisition: The user can either push a button or use a 

timer. Select the desired option in the Restart section.  

8. Click on OK. 

To use the manual sequence: 

9. Connect Magnifi to the instrument. 

10. Enter into Acquisition Mode by clicking on the Setup Mode button under the Home tab. 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

11. Plug the MFL probe into the Ectane 19-pin connector.  

12. Bring the probe head to a clear area in your standard and balance the probe by clicking on the 

Null button under the Home tab, or press F6 on your keyboard. 

13. Open the Sequence window by clicking on the Manual Sequence button under the Calibration 

tab 
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14. Put your probe in the tube to inspect and click on the Launch button. This will start the data 

acquisition. 

15. Push the probe until it exits the far end of the tube. If set correctly, Magnifi will recognize the 

landmark and this will initiate the data recording.  

16. Pull the probe towards you until it exits the tube. This will trigger the last landmark detection 

that will stop the data recording. 

17. Acquisition restart: 

a. If you selected User Input in the settings of the Manual Sequence Configuration, the 

system will wait for the user to enter information on the tube to restart the acquisition. 

Click on NDD or Review. This will add a tag to the inspected tube and it will restart the 

acquisition. Repeat steps 6, 7 and 8 for all the tubes to inspect. 

b. If you selected Timer in the settings of the Manual Sequence Configuration, a 

countdown will trigger after the last tube acquisition was taken. The acquisition will 

start after this time has elapsed. Redo step 6 and 7 for all the other tubes to inspect in 

the bundle.  

When doing your inspection, you may encounter some tubes that can’t be scanned completely. If this 

is the case, you won’t be able to catch the landmark that triggers the data acquisition at the end of 

the tube. In this situation, you can click on the Target button in the Sequence window to start the data 

recording. 

DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  
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The list of tubes is also shown in the Data window.  

 

 

A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

go out of the acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the "play" icon next to the file name will be replaced with a checkmark 

icon. 

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

A tube name can be changed by right-clicking on its name and by selecting the Rename option. 
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LOADING A FILE 

18. First disconnect your computer from the Ectane by clicking on the Disconnect button under the 

Home tab. 

19. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

20. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  
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REPORT 

INDICATIONS 

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  

To add an indication to the data: 

1. Select the defect signal in the strip chart and adjust the cursor so that the signal in the Lissajous 

includes only the defect signal.  

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  
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Report Entries can also be added with keyboard shortcuts. How to set up these keyboard shortcuts is 

explained in the SMART Setup section of this manual. 

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab 

 

REPORT TABLE 

To access the list of indications entered: 

1. Make sure that the Report option is selected under the Layout tab.  

 

 

2. Click on the report ribbon at the bottom of the screen to make the list visible 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  

2. Click on the Generate Report button under the Report section of the General tab. 
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3. Choose your preferences and enter the required parameters. The # of tubes in component is 

used to show the percentage of tube in each category.  

  
4. Click Finish to generate the report.  

Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 
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The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 

 

 

The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro.  
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IRIS Application Guide 
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INTRODUCTION 

This document presents how to use an Eddyfi IRIS system with Magnifi on an Ectane test instrument.  

Eddyfi offers five types of IRIS centering devices. The following was made using a small centering device 

but can also be applied to other types of IRIS centering devices. 

For illustration purposes, we used a SS316 tube 25.4 mm (1 in) in outside diameter (OD) and 1.96 mm 

(0.077 in) in wall thickness.  

 

TERMINOLOGY 

PROBE DELAY (PD) 

Corresponds to the transit time of the ultrasonic pulse to reach the mirror (typically 20 s to 23 s) 

TUBE INTERNAL RADIUS (IR)* 

Corresponds to the pulse transit time through water (from the mirror to the front wall) 

* This explanation assumes a stationary mirror, thus we use internal “radius” instead of “diameter”   

TUBE WALL THICKNESS (WT) 

Corresponds to the pulse transit time through the metal. Time in between front wall and back wall 
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EQUIPMENT 

CENTERING DEVICE 

 

ULTRASONIC TRANSDUCER 

 

TURBINE 

 

IRIS PUMP 

 

CABLES 
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SELECTION 

Select your hardware according to the following tables. 

Example: 

• CDSL-SLA: Small centering device 

• TB-170: 17.0 mm (0.67 in) turbine 

• TD-15M-254: 15MHz, 25.4 mm (1 in) focal length transducer 

 

IRIS selection table for tubing: 
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IRIS selection table for piping: 
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PROJECT AND INSPECTION FOLDERS 

In this section, we will create a folder structure that will manage the save locations of your setup, data 

and report. This management is operated through the creation of a project. 

Magnifi suggests two levels of file. The first level is the Project folder. It is meant to include different 

inspections that are related in some way. For instance, it can include all the inspections done at a refinery 

shutdown and be named Refinery_Shutdown_May_2018. The second level of file is the Inspection 

subfolder. Inspection subfolders are saved in the project folder. An inspection subfolder can include the 

data specific to the inspection of a bundle of tubes with a specific technology and could be named 

SS316_075x0.065_ECT for instance. This inspection subfolder regroups the setup, the tube list, the data 

and the Magnifi report.  

PROJECT
(ex: Refinery 04-17)

INSPECTION 1
(ex: Bundle No A1D3FX)

INSPECTION 2 INSPECTION X

SETUP

TUBE 
LIST

DATA

... ...

REPORT
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When you open Magnifi, the first page displayed is called the Backstage.  

 

To create or open a project, click on Open/Add Project in the backstage. You can select an existing 

project/folder or you can create a new folder. 

1. Create a folder by right-clicking on the location where you want to add your Project file. Select 
New, Folder and enter the chosen name. You can then select the newly created folder and click 
on Select Folder.  
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2. Click on Add/Open Inspection in the backstage, then click on Add and enter the name of your 
inspection.  

 

 

3. Click Select. This will define the position where the setup(s) and data will be saved. 
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SETUP WIZARD 

In this section, we will show how to create a setup using the Setup Wizard in Magnifi. 

Before going further, you can change the measurement unit. To do so, click on Preferences. In the System 

tab, you can change the measurement units from metric to imperial and vice versa. For the metric units, 

you can choose to use meters, centimeters, or milimeters in the General tab. The default measurement 

for imperial units is inches.  When finished, click on Preferences again to go back to the General window.  

 

 

To create a new setup, it’s strongly suggested to use the Wizard option menu. Click on Create Setup to 

start the Wizard. 
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COMPONENT DEFINITION 

The first page shown by the Wizard is the Component Definition.  

Click on the Material field to open the drop-down menu. Select the material of the tube to be inspected. 

If the material is not in the list, you can click on Manage… to open the List of Available Material window.  

 

 

To add a new material to the list, click on Add. A new line will appear in the list. Give the material a relevant 

name and set the material resistivity and permeability to its theoretical value. The resistivity and 

permeability are used to set electro-magnetic techniques parameters only. They don’t need to be set if 

an electro-magnetic inspection is not performed on this material.  

It’s possible to add a note about the material to specify information such as its application or composition. 

When you are done, click OK. 
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You will be back to the Component Definition window. If you added a new material, it will now be available 

in the material list.  

Adjust the tube wall thickness by entering the value in the Wall thickness field or by moving the slider. 

Enter the tube's outer diameter and length. 

These tube properties will help Magnifi to suggest the optimal scan parameters. 

Click Next when everything is set correctly. 
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PROBE SELECTION 

 

By selecting the Iris technique, Magnifi will recommend a Turbine, Transducer and Centering Device to be 

used for the optimal results for the tube in the previous section. In the case you don’t have the transducer 

in hand and you don’t have time to order it, we suggest using the closest possible frequency and a focal a 

bit further than the recommended transducer. Click Next when you’re finished. 
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SCAN DEFINITION  

 

The position from: option defines how the c-scan is populated. It can be populated by using the pin at the 

end of the turbine or using an encoder. The Acquisition rate can be increased after the setup by clicking 

on Scan icon from the Setup menu. Increasing the Acquisition rate will enable you to rotate faster, but the 

inspection can possibly become noisier. Click Next when you’re finished. 
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The resolution is set to have 180 points through the circumference and have 1 point every mm on the 

tube axis. Click Next when you’re finished. 
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INDICATION CODES 

The Indication Codes page is used to define the entries that can be added to the report when analyzing 

the data.   

 

When an indication is added, its abbreviation (code) is shown in the code pane, next to the data.  

You can modify the default indications codes list by changing the parameter in the table. New indications 

can be defined by clicking on the Add button.  

Click Next when you are done 
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DISPLAY 

The second Display window is used to set the layouts. Checking the tick boxes in this window will make 

the proposed layouts available in your setup. You will be able to switch from one to the another via the 

layout tab.  

The layout with the blue background will be the one opened by default, which can be changed to your 

desired option. 

Layouts can be readjusted at any time.  

 

Click Next to complete the setup wizard process. 
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DATA LIST 

Magnifi will create a file for each inspected tube. The list of tubes can be created in the Data List section 

of the General tab of the Backstage. 

 

 

Four options are available to set the filename format: 
1. Free format:  

Each file has a custom name. Can also be defined from the Data tab of the Front Stage. 

2. Prefix:  

The file name includes a defined prefix followed by a sequential number. 

3. Row, Col:  

Row number, Column number. Mostly used for tubing inspections. 

4. Zone, Row, Col:  

Zone number, Row number, Column number. Mostly used for tubing inspections. 

 

Click on the Create New List button. The displayed window will be different depending on the chosen 

filename format. 

 

For the Row, Col option, enter the number of rows, the starting row number and row interval. You can 

then enter the number of tubes per row in the Nb. of Columns fields of the table. Click on Create to 

generate the list of tubes. You can also use the Create & New button to add another set of tubes to you 

list.  
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The same principles apply to the other file formats, except for the Free format option for which the file 

name(s) needs to be entered manually in the file name window of the Frontstage. The tube list can also 

be imported from another project using the Import List button. The tube list file can be found in the 

Inspection folder. It is also possible to import a list created in Tubepro.  
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HARDWARE ASSEMBLY 

Note: Please report to the relevant supplied document if you use a micro turbine and extra-small centering 

devices. 

Unscrew the turbine base from the turbine.  

 

Holding the centering device, screw the turbine base 

• Make sure the arms do not come in conflict with the turbine base. 

• To optimize your probe data, both centering modules must be far from each other and the 
centering arms must be in the direction showed on the picture below: 

 

Insert the microdot connector at the base of the centering device until it exits the base of the turbine 

previously assembled 

 

Screw the poly to the base of the centering device 
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• Make sure the IRIS coaxial cable at the far end and close to the microdot connector is not kinked. 
You may have higher noise just after the front wall echo in the A-scan. It will directly affect the 
probe sensitivity on smaller defects. 

 

Screw the transducer to the microdot connector 

• If your transducer has white spots on the curved section, this is an indicator to eventually replace 
it. To increase its lifetime, don’t use it without coupling (water) and remove the BNC connector 
when the probe is not running. 

 

Screw the turbine to its base 

• The UT transducer must not push the turbine rotor. To avoid it, shake the IRIS cable until the UT 
transducer is completely inserted in the turbine. 

• Make sure the rotation is smooth. If not, you may have to lubricate the rotor. It may also be 
necessary to clean the mirror for better signal quality. 

• Centering tape can be added to the turbine. 

 

Connect the BNC cable to the BNC connector on the poly 
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Connect the BNC cable to the Ectane 

 

TIPS 

• To optimize your probe data, both centering devices must be far away from each other and in the 
right direction, as in the picture below. 

• Centering tape can also be added to the turbine.  

• Make sure the UT transducer doesn’t push the turbine rotor. To avoid this situation, shake the 
IRIS cable until the UT transducer is completely inserted in the turbine 

• With the XS centering devices, use the key to adjust both centering modules at the proper 
strength. 
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PERFORMING AN ACQUISITION 

1. If you are in the Backstage, move to the Frontstage by clicking on the Start/Resume button. 

2. Click on the Connect button under the Instrument tab. This will open the Instrument 

configuration page. Click on the line showing the instrument to which you want to connect and 

then click Connect. 

 

Note: Your Ectane firmware version may not match the version of Magnifi you are using. If this is the case, 

a red and white X icon will be shown in the Status field of the Instrument connection window. To download 

a matching version to your Ectane, click on the Config. button and then click the Send firmware to the 

instrument button of the Instrument configuration window.  

 

 

Two (2) acquisition modes are available in Magnifi: Setup Mode and Acquisition Mode. Setup Mode is 

used to scan your calibration tube and make the necessary adjustments on your setup without saving 

the data automatically. Acquisition mode is used for the inspection - in this mode, the software 

automatically saves the acquired data using file names based on the tube list.  
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3. For the gates adjustment, go to Setup Mode by clicking on the Setup Mode button under the 

Home tab. This mode is active when the Setup Mode button is grayed. 

 

4. Push the centering device fully in the tube and make sure the ultrasonic beam is in a clear area 

in your standard. 

 

5. Click Start/Resume   to start the acquisition.  
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6. Increase the size of the A-scan window  

 
 

 
7. Start the IRIS pump and press F2 to see live data. 
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8. Press   to get an envoloppe over your A-Scan 

 

 

9. Set the start position and the length of the pin gate as narrowly as possible. The level should be 

set to avoid the surrounding noise level. (This is to make sure no noise will come in the gate and 

increase the rotation speed.)  

 
 
10. In this situation, reducing the overall gain will reduce the noise level. After the gain is adjusted, 

click two times on  to refresh the A-scan.  

 
 
 
 

Noise 

Gate for the pin 
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11. Adjust the front wall gate, it needs to be as low as possible without catching noise and wide 

enough to get the movement of the front wall due to the centering.  

 

 

12. Click on  to remove the envoloppe and click on  to zoom on the back wall. 

 
 
13. Increase the TCG slope as much as possible without putting too much noise in the signal. The 

backwall signal should be around 80% of the full screen height. 
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14. Increase the Level and the Start position of the back wall gate to clean the C-scan and bring the 

gate as close as possible to the front wall. 

 

 

Press F2 to stop the acquisition, press F2 again start the acquisition and pull your calibration tube. The 

pulling speed should be around 50 to 100mm/s 

 
 
 

Above the noise 
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15. To troubleshoot this kind of result (green noise in the C-Scan), different options are available. 

(Do the changes while you are acquiring the data to see the results live) 

a. Reduce overall gain in the general tap.  

b. Increase the level of the backwall gate. 

In the image below the probe is on the 50% OD groove (the last part of the C-scan in yellow). 

c. You need to reduce the level of the backwall gate. 

d. You might need to decrease the overall gain again and increase the slope of the TCG to clean 

the C-Scan 

 

 
 

16. Put the cursor into a clear portion of the tube. Click on ,  select Probe Delay and Wall 

Thickness and then press Calibrate. (That will adjust the velocity and wedge delay to get the 

defined WT in your readings) 
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17. Play with the color palette to improve the image. 
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Note: In this presentation, we used a shorter focal length (1in) for the transducer. So, it reduces the Back 

Wall response.  That’s why the 50% groove (3rd groove) is not clean. The level of the OD signal of the 50% 

groove is sometimes at the same level as the base noise. 

 

SAVING YOUR SETUP 

Once all your setup adjustments are done, you can save your setup by clicking on the Save Setup button 

under the Home tab. The displayed window will allow you to give an appropriate name to your setup and 

to save it at the desired locations. The save location is, by default, your inspection file. Note that when a 

data is saved, the setup is also saved with it.  

You can also save the data of your calibration standard by clicking on the Save As button under the Home 

tab.  
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DATA LIST MANAGEMENT 

For each acquisition, Magnifi can automatically save a file using the file name defined previously in the 

Tube list section of this document. To do so, checkmark the Automatic File Recording option that can be 

found under the General tab of the Preference menu of the Backstage.  

 

The list of tubes is also shown in the Data window.  

 

A common practice is to rescan your calibration tube and balance the probe periodically. You can save 

this new calibration tube data by adding a new tube in your tube list (999 001 for example). Or you can 

go out of the acquisition mode, scan your tube, and click on the Save Cal As… button under the Calibration 

tab to save your data. You can then go back to the acquisition mode to continue your inspection and to 

automatically save the acquired tubes in your bundle.   

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to the tube 

description.  

You can rescan a tube by selecting its name in the list and by clicking on the Rescan button in the Home 

tab.  

Also, a tube name can be changed by right-clicking on its name and by selecting the Rename optio 
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INSPECTION 

The following section describes how to perform an inspection. 

1. Go to the Acquisition Mode by clicking on the Setup Mode button under the Home tab. The 

Acquisition Mode is activated when the Setup Mode button is not grayed.  

2. Insert the centering device/turbine into the tube to inspect, start the IRIS pump and start the 

acquisition by clicking on the Acquire button under the Home tab or by pressing the F2 on your 

keyboard. 

3. Pull the probe at approximately 2’’/s (50 mm/s). 

4. When it’s done, press the Stop button or again F2 on your keyboard. 

5. Repeat steps 2,3 and 4 for all the tubes to inspect in your bundle.  

For each acquisition taken, Magnifi can automatically save a file using the file name defined previously in 

the Tube list section of this document. To do so, checkmark the Automatic File Recording option that can 

be found by clicking on the Acquisition preferences button in the Data window. This option is selected by 

default.  

 

The list of tubes is shown in the Data window on the left of the Frontstage.  
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Tubes can be added or removed by using the first line of buttons of this window.  

Once a tube has been scanned, the " play " icon will be replaced by a checkmark icon next to the tube 

description.  

You can rescan a tube by selecting a tube in the list and by clicking on the Rescan button in the Home tab.  

Also, a tube name can be changed by right-clicking on a tube in the list and by selecting the Rename option. 

LOADING A FILE 

6. First disconnect your computer frome the Ectane by clicking on the Disconnect button under the 

Home tab 

7. You can load a file by double-clicking on the file name in the Data window. It can also be done 

by selecting the file in the list and by clicking on the Load button under the Home tab. Note that 

double-clicking on a tube when you are still connected to an instrument will initiate data 

acquisition.  

8. You can open the next or the previous file in the list by clicking on the Previous or Next button of 

the Home tab. 

The data files can be filtered by using the Filter button of the Data window.  

 

REPORT 

INDICATIONS 

The two Indication buttons at the lower corner of the Lissajous windows can be used to add an entry to 

the report. These two buttons indicate the code that is associated with the defect being entered. Both 

buttons are identical, but can be set to identify different flaws.  
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To add an indication to the data: 

1. Select the indication in the C-scan and adjust the cursor so that the cursor only includes the 

indication 

2. Then, click on the red triangle in the corner of the Indication button to select the type of defect 

to enter.  

3. Click on the defect button to add an entry to the report.  

 

Indications can also be added to a tube to indicate, for instance, that it has no flaw or that it is plugged.  

To add an indication to a tube: 

1. Load the file 

2. Click on the appropriate indication button available under the Analysis tab 

 

REPORT TABLE 

To access the list of indications entered: 

1. Make sure that the Report option is selected under the Layout tab.  
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2. Click on the report ribbon at the bottom of the screen to make the list visible 

 

Entries in the report can be modified by changing the value in the table. You can also delete an entry by 

clicking on the X next to it.  

REPORT GENERATION 

Magnifi can automatically generate a full report with the report table.  

To generate this report: 

1. Go to the Backstage by clicking on the arrow at the upper left corner of the Frontstage.  

2. Click on the Generate Report button under the Report section of the General tab. 

3. Choose your preferences and enter the required parameters. The # of tube in component is 

used to show the percentage of tube in each category.  

  
4. Click Finish to generate the report.  
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Once generated, the report is saved as a .html file in the current Inspection sub-directory. It can be viewed 

using any regular web browser. 

There is a “copy” button next to each element of the report such as tables and images. When clicking on 

it, the element will be copied to the clipboard. It can then be pasted to another file such as an Excel or 

Word. 

 

The Print button, bottom right corner on image above, can be used to either print a paper copy of the 

whole report or to save it as a .pdf document. The PDF generator available with the current web browser 

will be used. 

 

 



565 

 

The report logo can be modified by clicking on the Select Company Logo that can be found under the 

System tab of the Backstage.  

 

The report table file in the Inspection folder can also be imported into other reporting software such as 

Tubepro. 
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ECA Application Guide 
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INTRODUCTION 

The intent of this guide is to provide the user with the necessary knowledge to set up and properly operate 

an ECA probe. 

QUICK PROBE SELECTION GUIDE 

MECHANICAL DESIGN 

Eddyfi offers several models of ECA probes. The 3 most popular probe types are described below. 

 

Probe type Picture Purpose 

Semi-flexible 

 

 

Best suited for flat and curved surfaces, 

both concave and convex.  

Conform to outside diameter of 41 cm 

(16 in.) or more (depending on  probe 

model).  

Combines part the flexibility of the 

flexible probe and the ruggedness and 

wear resistance of the rigid solutions. 

 

Padded 

 

 

Best suited for uneven surfaces that are 

reasonably smooth. 

Suited for smooth weld. Designed to 

adapt to weld crown of 5 mm (0.2 in.) or 

less. 

 

Flexible 

 

 

Ultra-flexible probe. Can conform to 

curved surfaces with a bend radius of 20 

mm (0.787 in.) or more (depending on 

probe model). 

 

Probe types 
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TOPOLOGY 

The term topology refers to how the coils are organized inside a probe and how they are activated. The 

table below describes some of the strengths and weaknesses of the most commonly used topologies. 

  

Topology Coil arrangement (+) (-) 

Impedance Absolute 

(IMP or ABS) 

 

 
 

• Non-directional 
(sensitive to defects in 
all orientations) 

• Sensitive to short, long 
and gradual defects 

• Fewer number of 
channels compared to 
transmit-receive modes 

• Very sensitive to surface 
condition, probe handling 

• Sensitivity to lift-off 
(distance between the 
coils and the inspected 
surface) 

• Can’t discriminate 
orientation of short 
defects 

Long Single Driver 

(LSD) 

 

 
 

• Typically used for 
detection of subsurface 
defects 

• Good performances on 
carbon steels (surface-
breaking only) 

• Good tolerance to lift-
off 

• More limited in terms of 
smallest detectable flaw 
compared to the SDD 
topology 

Short Double Driver 

(SDD) 

 

 
 

• Good sensitivity to short 
and shallow defects 

• More sensitive to lift-off 
than LSD topology, but 
less than IMP topology 

• Limited performances on 
ferromagnetic materials, 
especially for long 
defects 

 

T = Transmitter, R = Receiver 
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With the impedance absolute topology, each coil generates one channel. 

 

 
 

Coil layout - Impedance Absolute topology 

 

The transmit-receive topologies (SDD and LSD) produce 2 different groups of channels each, the axial and 

the transverse. The transmit-receive groups are mostly sensitive to flaws oriented along the transmitter-

receiver axis. Therefore, the axial group is mostly sensitive to axial flaws and the transverse group is mostly 

sensitive to transverse flaws. They are both sensitive to volumetric flaws as well. Each receiving coil 

produces one channel. 

 

                                                 
 

Coil layout – Short Double Driver topology 

 

                                                 
 

 
Coil layout – Long Single Driver topology 

  

1 coil = 1 channel 

Axial group  

(SDDA) 

Scan axis 

Scan axis Scan axis 

Transverse 

group (SDDT) 

Axial group  

(LSDA) 

Scan axis Scan axis 

Transverse 

group (LSDT) 
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COIL DIAMETER 

The coil diameter have an impact on the followings: 

• Minimum detectable flaw 

• Depth of penetration 

 

MINIMUM DETECTABLE FLAWS 

As a rule of thumb, one could use the following formula to estimate the length of the shortest surface-

breaking defect that can be detected. The distance to be considered is the distance between the 

transmitter and the receiver. In the case of the Impedance Absolute topology, the diameter of the coils 

could be used as an estimate. 

 

𝑀𝑖𝑛𝑖𝑚𝑢𝑚 𝑑𝑒𝑡𝑒𝑐𝑡𝑎𝑏𝑙𝑒 𝑑𝑒𝑓𝑒𝑐𝑡 =
𝐶𝑒𝑛𝑡𝑒𝑟 − 𝑡𝑜 − 𝑐𝑒𝑛𝑡𝑒𝑟 𝑐𝑜𝑖𝑙 𝑑𝑖𝑠𝑡𝑎𝑛𝑐𝑒

4
 

 

Note that this represent an approximation and that real performances will vary according to many 

parameters such as the surface conditions, lift-off, permeability variations, etc. 

 

 

 

DEPTH OF PENETRATION 

The depth of penetration is directly related to the coil diameter. Generally, the capability of a coil to 

discriminate defects of different depths increases with the coil diameter. For instance, a 2 mm coil could 

discriminate defects having depths ranging between 0 and 2 mm. Past 2 mm deep, the signal amplitude 

may remain the same. Note that this represent an approximation and that real performances will vary 

according to many parameters such as the surface conditions, lift-off, permeability variations, etc. 

Typically, you could consider that far-side defects could be detected if they have a depth of at least 25% 

of the wall thickness and a length of 1 to 2 times the wall thickness. Again, you should consider this as an 

approximation to get started. Of course, real performances will vary according to many parameters such 

as the surface conditions, lift-off, permeability variations, etc. 
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For far-side defects, you could also use the following formula as a first approach to estimate a potential 

operating frequency. Of course, the frequency range of a probe is typically related to the size of the coils. 

 

𝑓 =
1.6 𝑥 𝜌

𝑡2
 

 

Where 𝑓 is the operating frequency in 𝑘𝐻𝑧, 𝜌 is the resistivity of the inspected material in 𝜇𝛺 ∙ 𝑐𝑚 and 𝑡 

is the remaining ligament of material between the surface (inspection side) and the bottom of the defect, 

in 𝑚𝑚. 

Important: With the currently available range of ECA probes, subsurface defects can’t be detected in 

carbon steel or other ferromagnetic materials having a high magnetic permeability, even if they are very 

close to the surface.  
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PROBES DESCRIPTION 

I-FLEXTM PROBES 

DESCRIPTION 

 

ECA-IFG-056-250-048-N03S with encoder 

I-FLEX TOPOLOGIES 

        

ECA-IFG-056-250-048-N03S – PCB 

 

Probe model 

Topology  

Coil OD 

(mm) 

 

Channels 

(according 

to topo.) 

Central freq. 

(kHz) 
Short 

Double 

Driver 

Long 

Single 

Driver 

Imp. Abs. 

ECA-IFC-128-005-033-N03S    *  6.0 32 5 

ECA-IFG-079-250-048-N03S    5.0 60, 59, 32 250 

ECA-IFG-079-050-048-N03S    5.0 60, 59, 32 50 

ECA-IFG-056-250-048-N03S    3.5 60, 59, 32 250 

ECA-IFG-056-050-048-N03S    3.5 60, 59, 32 50 

ECA-IFG-034-500-048-N03S    2.0 60, 59, 32 500 

* Axial channels only 

I-Flex topologies 

2 
5 

4 

1 
3 

1. Flexible body 

2. Scan direction arrow 

3. Encoder holder slot 

4. I-Flex encoder holder 

5. High precision standard encoder 

Up to three topologies can be activated:  

1. Impedance Absolute 

2. Short Double Driver 

3. Long Single Driver 
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PADDED PROBE 

DESCRIPTION 

1. Encoder slot 
2. Scan direction arrow 
3. Padded sensitive area 
4. Coverage indicators 

 

ECA-PDD-034-500-032-N03S 

 

TOPOLOGIES 

Each padded probe can operate a single topology. It has either a Short Double Driver or a Long Single 

Driver configuration, depending on the model. 

 

Probe model 

Topology  

Coil OD (mm) 

 

Number of 

channels 
Short Double 

Driver 

Long Single 

Driver 

ECA-PDC-058-250-032-N03S   3.5 59 

ECA-PDD-056-250-032-N03S   3.5 60 

ECA-PDC-055-500-050-N03S   2.0 95 

ECA-PDD-054-500-050-N03S   2.0 96 

ECA-PDC-035-500-032-N03S   2.0 59 

ECA-PDD-034-500-032-N03S   2.0 60 

Padded probe topologies 

  

1 

2 

3 

4 
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SEMI-FLEXIBLE PROBE 

DESCRIPTION 

1. Encoder slot 
2. Scan direction arrow 
3. Semi-flexible sensitive area 
4. Coverage indicators 

 

ECA-SFC-064-005-017-N03S 

TOPOLOGIES 

Each semi-flexible probe can operate a single topology. It has either a Short Double Driver or a Long Single 

Driver configuration, depending on the model. 

Probe model 
Topology 

Coil OD (mm) 
Number of 

channels 
Short Double 

Driver 

Long Single 

Driver 

ECA-SFC-128-005-033-N03S   6.0 32 

ECA-SFC-064-005-017-N03S   6.0 16 

ECA-SFC-058-250-032-N03S   3.5 59 

ECA-SFD-056-250-032-N03S   3.5 60 

ECA-SFC-071-500-064-N03S   2.0 123 

ECA-SFD-070-500-064-N03S   2.0 124 

ECA-SFC-035-500-032-N03S   3.5 26 

ECA-SFD-034-500-032-N03S   2.0 60 

Semi-flexible probe topologies 

  

2 

1 

3 

4 
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SETUP 

LOAD / CREATE SETUP 

5. Open Magnifi. 

6. In the backstage, click on Open Setup  . 

7. From the Default Master List section, select the setup corresponding to the probe to be used. 

 

8. Connect the 160-pin array connector to the EctaneTM or ReddyTM unit. 

9. Connect the 18-pin encoder connector to the Ectane unit or the 12-pin encoder connector to 

the Reddy. 

10. For the Ectane instrument, connect the instrument to Magnifi by clicking on the button 

located in the Instrument ribbon in the front stage.  

11. For the Reddy instrument, the connexion to Magnifi is automatic. 

12. Once connected, you will see in the General section of the backstage that the probe is detected.  

 

  

Default I-Flex Setup in Default Master List 

The I-Flex probe is detected by the instrument 

Note that you will get a warning message if the currently loaded setup is not compatible with the probe. 

The appropriate setup is not loaded automatically when a probe is connected. Make sure to select the 
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probe number that fits exactly with the one detected by the instrument, some model numbers in the list 

are very similar. 

 

Alternatively, a setup can also be created using the setup Wizard by clicking on Create Setup  

from the General section of the backstage.  

Note that all the steps of the Wizard are already filled with default values when creating a new setup or 

when loading one from the Default Master List. In any case, all the steps of the Wizard always remain 

accessible through the Setup ribbon in the front stage if you want to apply modifications to your setup. 

 

 

All the Wizard steps are accessible in the Setup ribbon 
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The table below presents the principal settings and their respective Wizard steps. 

 

 

 

 

 

 

  

Wizard step Parameters 

 

Encoder settings 

C-Scan size 

Oversampling (interpolation) 

 

Gain 

Topology 

Frequency 

Driver voltage 

 

Filters 

 

Calibration points 

 

Calibration settings 

 

Indication Codes 

 

Sizing curves 

 

Layout 

Display settings 
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ENCODER SETTINGS 

13. In the frontstage, go to the Setup ribbon and open the Scan  menu. 

14. To enable the encoder, set the parameter Position from to Encoder. To disable the encoder, 

choose Clock from the drop-down list. Click Next. 

 

Scan Definition, page 1 

15. On the second page of the Scan Definition step, in the Encoder section, make sure your encoder 

resolution matches the one set in the software: 

 

Scan definition, page 2 

16. Depending on the orientation of the encoder relative to the probe and scanning direction, you 

might have to Invert direction to make sure that the positions provided by the encoder are going 

in the same direction as the probe scanning axis. 

17. Click Next on all the following pages, then Finish. 
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LAYOUT 

IMPEDANCE ABSOLUTE LAYOUT 

 

Impedance Absolute layout 

A probe used in Impedance Absolute mode produces a single group of channels and therefore the setup 

has a single C-Scan. Each horizontal line in the C-Scan represents one channel. 

The C-Scan view displays the vertical component of the Lissajous view since the signal component selector 

(arrow button at the top right of the C-Scan) is set to vertical by default. Only one channel at a time is 

displayed in the Lissajous view. It corresponds to the C-Scan line under which the horizontal cursor is 

located.  

 

 

C-Scan – Impedance Absolute Lissajous – Impedance 

Absolute 
Data list 
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TRANSMIT-RECEIVE LAYOUT 

 

Transmit-receive layout 

A probe used in Transmit-Receive mode typically produces 2 groups of channels and therefore the setup 

has 2 C-Scans. Each horizontal line in a C-Scan represents one channel. 

The C-Scan view displays the vertical component of the Lissajous view since the signal component selector 

(arrow button at the top right of the C-Scan) is set to vertical by default. Only one channel at a time is 

displayed in the Lissajous view. It corresponds to the C-Scan line under which the horizontal cursor is 

located.  

 

  

Lissajous - Axial channels 

Lissajous - Transverse channels 

C-Scan - Axial channels Data list 

C-Scan - Transverse channels 
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OPERATING FREQUENCY SELECTION 

The selection of the right frequency can greatly affect the results. 

By default, the frequency set by the Wizard is simply the central frequency of the coils. Note that 

depending on the material under test and the target defects’ type and dimensions, the optimal frequency 

can vary. You can consult the first section of this document to guide you through the selection of the 

operating frequency. 

The following steps will suggest a typical workflow that can be used when adjusting the frequency. Ideally, 

a representative sample of the material to inspect with a target defect would be used. 

18. Some probes like the I-Flex offer several topologies. Open the Data step and validate that 

you are using the desired topology. 

 

Data definition page 

19. Still in the Data step, select the desired frequency. Click on Finish. 

20. Make sure that no filter is applied. Indeed, the filters could remove the signal coming from the 

lift-off, which needs to remain visible for the frequency selection and validation. To disable the 

filters, verify that the filter options are unticked in the Process menu  . 

21. Deactivate the encoder. To do so, open the Scan menu  and set the Position from to Clock. 

22. Place the probe on a flawless portion of the sample applying an even pressure and null your 

probe by clicking on the Null button . 

23. Start the acquisition  and collect a material-air signal by lifting the probe away from the 

sample’s surface. This is the lift-off signal. 
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Performing a lift-off with the I-flex probe 

 

24. Without stopping the acquisition, put the probe back on the material and scan over a target 

defect. In the picture below, the defect is a long notch, but ideally the defect would be 

representative of the target defects. 

       
Scanning the notch 

25. Click on Stop acquisition  

Note that the data shown below were acquired using an Impedance Absolute topology over stainless steel 

material. These images are used to illustrate the frequency selection concept. However, you should keep 

in mind that the shape of the signals will vary according to many parameters such as the topology, the 

frequency, the material, the defect type and dimensions, etc. and could be quite different than those 

shown here. 

  

Material 
Air 
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26. In the C-Scan view, place the cursor on the lift-off signal, as shown below.  

 

Lift-off signal 

27. In the Lissajous view, rotate the signal so that the first portion of the lift-off signal is horizontal. 

The material operating point should be on the right, with the first portion of the lift-off going 

towards the left. You can use the rotation button at the top-right corner of the Lissajous. 

             

Lift-off signal, rotated 

28. The previous image shows that the signal is saturated. Depending on the application, it might be 

acceptable, especially if very little lift-off variations are expected during the scans. However, it 

could be a good practice to avoid saturation. To do so, open the Data definition page , 

decrease the Gain and perform another acquisition. Decrease the Gain by small steps until a 

non-saturated signal is obtained. 

Note: Inversely, you can increase the gain (or voltage) if the signals are too small. 

Rotation button 

Material Air Material 

Notch Material 

Air 

First portion of 

lift-off signal 

Saturated (see next step) 
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Lift-off signal, rotated, without saturation 

29. In the C-Scan view, place the cursor over the lift-off and defect signals so you can observe both 

of them simultaneously in the Lissajous. You might want to modify the frequency in order to 

improve the detection of the target defect or to increase the phase separation between the lift-

off signal and the defect signal. The frequency can be modified in the Data definition page .  

Note that changing the frequency will modify the shape and rotation of the signals, so you will need to 

repeat all the previous steps every time you modify the frequency. 

   

Lift-off signal and notch signal 

CALIBRATION 

In order to obtain optimal detection, a probe calibration should be performed. This step requires a 

calibration plate or block with a long notch. The purposes of the probe calibration are: 

Not Saturated 

Phase separation 
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• Adjusting the overall rotation and amplitude of the signals so that target defects provide the 
desired amplitude and phase. 

• Uniformize the response in amplitude and phase for all the channels so they provide the same 
response over the same defect. 

 

CALIBRATION PLATE PREPARATION 

Prepare the calibration plate. It must have a notch at least 20 mm longer than the total coverage of the 

probe to facilitate the manipulations and also make sure that the channels at both ends of the array are 

not seeing edge effects.  

The coverage in millimeters is indicated in the probe acronym. For example, the coverage of the probe 

ECA-PDD-056-250-032-N03S, is 56 mm. Therefore, it would be recommended to have a notch with a 

length of approximately 76 mm. 

Also, the notch should be located far enough from the edges of the plate to ensure that the calibration 

scans can be performed without reaching the edges. 

Finally, the dimensions of the notch (width and depth) should ideally be similar to the dimensions of the 

target defects. 

 

CALIBRATION OF TRANSMIT-RECEIVE CHANNELS 

Important: The frequency selection must be performed prior to the calibration. See previous section. 

Also, note that the data shown below were acquired using a Short Double Driver topology over stainless 

steel material. These images are used to illustrate the probe calibration concept. However, you should 

keep in mind that the shape of the signals will vary according to many parameters such as the topology, 

the frequency, the material, the defect type and dimensions, etc. and could be quite different than those 

shown here. 

With the transmit-receive topologies, two groups of channels have to be calibrated, the axial channels 

and the transverse channels. The following steps will show how to: 

• Properly acquire the reference signals for calibration of each group of channels; 

• Adjust the rotation so that the lift-off is horizontal (as shown in the previous section).  

30. In the Process menu , turn off the median filters. 

31. In the Scan menu , set the Position from to Clock. 

32. Place the probe on a flawless portion of the plate and click the Null button . 
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33. Start the acquisition  and perform a material-air signal (lift-off signal). 

 

Performing a lift-off with the I-flex probe 

 

34. Without stopping the scan, perform a scan with the probe parallel to the notch. This signal will 

be used for the calibration of the transverse channels since it simulates a transverse indication. 

   

Scanning the notch to produce a transverse indication 

35. Without stopping the scan, rotate the probe 90˚ and place it back on the plate as shown on the 

next figure. 

36. Null  the probe again. 

37. Perform a scan with the probe perpendicular to the notch. This signal will be used for the 

calibration of the axial channels since it simulates an axial indication. 

Material 
Air 
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Scanning the notch to produce an axial indication 

38. Click on Stop acquisition . 

Important: If your C-Scan is not long enough to perform the lift-off signal, the transverse notch signal and 

the axial notch signal, increase the C-Scan size in the Scan menu, in the Encoders and axis setting page 

. 

 

39. Place your cursor on the lift-off signal.  

 

Short double driver - Lift-off and notch signal 

  

Null again here 

Lift-off Lift-off 

Axial notch 

Trans. notch 
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40. For both the axial and the transverse channels, in the Lissajous view, rotate the signal so that 

the first portion of the lift-off signal is horizontal. The material operating point should be on the 

right, with the first portion of the lift-off going towards the left. You can use the rotation button 

at the top-right corner of the Lissajous. 

 

 

Short double driver - Lift-off and notch signal - rotated signal 

 

Now, the following steps will show how to: 

• Set the target values of amplitude and phase for calibration; 

• Perform the calibration.  

 

41. In the Lissajous view, click and hold the Amplitude measurement button, a contextual menu will 

open. 

 

 

 

  

First portion 

of lift-off 

signal 

Rotation button 

Amplitude measurement button 

Phase measurement button 
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42. From this menu, select the amplitude measurement method. It is recommended to use Peak to 

Peak (Vpp). 

 

43. In the Lissajous view, click and hold the Phase measurement button, a contextual menu will 

open. 

44. From this menu, select the phase measurement method. It is recommended to use Peak to Peak 

first transition (Vppf). 

45. Place your cursor over the first notch indication which represents a transverse indication.  

46. From the transverse Lissajous view, look at the measured amplitude and phase of the indication. 

You should move the cursor up and down in the C-Scan to look at the different transverse 

channels and should notice an average value of amplitude and phase. Note those average values 

for later. 

 

      

Cursor placed over the “transverse” notch 

  

Amplitude = 3.08V 

Phase = 10.5° 
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47. Place your cursor over the second notch indication which represents an axial indication and 

repeat the previous step. 

 

 

Cursor placed over the “axial” notch 

 

48. In the Wizard ribbon, open the calibration step . 

49. Enter the amplitude and phase values that were noted at the previous steps in their respective 

fields. Make sure to use the axial reference for the axial C-Scan and the transverse reference for 

the transverse C-Scan. Also, it is recommended to use the Peak to Peak measurement method 

for amplitude and Peak to Peak first transition for phase. 

 

Note that you can adjust the amplitude to a desired target value, it does not have to be exactly the same 

as what was previously measured. However, it is recommended to enter an amplitude value that is close 

to the initially measured value. If the desired target value is far from what has been measured, it could be 

a good practice to adjust the voltage and/or gain accordingly and repeat the previous steps. For the phase, 

it is recommended to use a number as close as possible to what was previously noted to make sure that 

the lift-off keeps the right orientation. 

 

Amplitude = 2.18 V 

Phase = 11.1° 
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Calibration page 

 

50. Click on Finish. 

51. From the Calibration ribbon, open the System Calibration menu . This button will open the 

following menu. 

 

 
 

52. Keeping this menu open, in the C-scan, place your cursor over the transverse calibration notch 

signal. Make sure that the horizontal cursor is wide enough to encompass completely the 

indication, but not too wide to avoid grabbing the lift-off signal or other sources of noise near 

the indication. 

53. Select the transverse calibration reference from the opened calibration menu, press the green 

arrow  . 
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54. In the C-scan, place your cursor on the axial calibration notch signal. Make sure that the 

horizontal cursor is wide enough to encompass completely the indication, but not too wide to 

avoid grabbing the lift-off signal or other sources of noise near the indication. 

55. Select the axial calibration reference from the opened calibration menu, press the green arrow 

. 

56. Click on Calibrate. 

 
Calibration window, 2 channels to calibrate 

57. Perform a quick calibration check. Place the cursor over the indications to validate that the 

measured amplitude and phase correspond to the parameters configured previously. Your 

probe is calibrated. 

 

 
Transverse notch signal after calibration 

CALIBRATION OF IMPEDANCE ABSOLUTE CHANNELS 

You should follow the same procedure as explained previously for the transmit-receive channels. The only 

differences are that: 

Calibrated signal 

Amplitude = 2.00 V 

Phase = 15° 
Amplitude and phase 

Measurement methods 
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• Only the first pass over the notch is required since there is only one group of channels and it is 
equally sensitive to all orientations. 

• The menus will have only one reference signal, as shown below. 
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CALIBRATION WITH SINGLE GAIN AND PHASE 

If no calibration plate with a long notch is available, it is therefore impossible to perform a full calibration 

of your array probe. However, if a sample with a target defect is available, it remains possible to perform 

a partial calibration using the Single Gain and Phase mode.  

This type of calibration will not uniformize the response in amplitude and phase for all the channels so 

there will remain variations from one channel to the others.  

However, it will at least allow for an adjustment of the overall rotation and amplitude of the signals so 

that target defects provide approximately the desired amplitude and phase. 

To perform a Single Gain and Phase calibration, follow the same steps as for the full calibration of the 

transmit-receive channels, but in the Calibration page of the Wizard make sure to check the SG option 

(Single Gain and Phase) for all the groups.  
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ACQUISITION 

The following steps suggest a standard acquisition workflow. In this case, a smooth stainless steel weld 

will be scanned with an I-Flex probe. 

58. If the filters have been disabled to perform the frequency selection and calibration, make sure 

to re-enable them by going In the Process menu . 

59. Also, you can re-activate the encoder if desired. In the Scan menu , set the Position from to 

Encoder. 

60. In the Home ribbon, uncheck the Setup Mode .  

61. In the Data tab on the left side of the front stage, add an Inspection file, by clicking on the green 

cross. If the Data tab is not available, go to the Layout ribbon and enable it by clicking on the 

Data button . 

 

Adding an inspection data in the data list 

62. Null  the probe on a flawless section of the weld and start the acquisition. 
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Scanning a weld with the I-Flex probe 

63. During the scan, you should try to keep a constant pressure. Also, you should try to keep the 

same index position (up-down) when scanning a constant feature such as a weld, an edge, a 

radius, etc. This will generally provide better data quality.  

64. Stop the acquisition. 

65. Your data file is automatically saved in your Inspection file (if the Setup mode is disabled and the 

Automatic File Recording option from the General Preferences section in the backstage is 

enabled). 

 

MAINTENANCE 

• The probes are not watertight. Do not immerse in water, as this may cause the probes to 
malfunction. 

• To clean the probes, use a soft, humid cloth. Do not use harsh chemical cleaners, as it may damage 
the probes. 

• The probes must be used with adequate setup file. 

  

Scan direction, in the same axis than 

the weld. 
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Sharck™ G2 Application Guide 
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PROBE DESCRIPTION 

BUTT WELD 

1. Keypad (see section 1c) 

2. Active area markers 

3. Scan direction 

4. Strap attachment 

5. Removable embedded encoder (see section 0 for cleaning) 

6. Wheels (see section 0 for cleaning) 

7. Removable frame to clean fingers (see section 0) 

8. Fingers with TECA™ elements (22) 
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Figure 2. Sharck-Butt Weld features 

FILLET WELD 

1. Keypad (see section 0.) 

2. Active area markers 

3. Scan direction 

4. Spring loaded side wheels 

5. Side wheels adjustment buttons (see section 0 IV) 

6. Adjustable module screw 

5 

6 

8 
7 
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7. Spring loaded embedded encoder 

8. Wheels (see section 0 for cleaning) 

9. Removable frame to clean fingers (see section 0) 

10. Adjustable module fingers (6) 

11. Fixed module fingers (6) 

 
Figure 3. Sharck-Fillet Weld features 

  

1 

2 

4 

3 

5 

6 

9 
11 

10 

8 
7 
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KEYPAD 

1. LED: Green LED turned on during an acquisition (not 

functional on 1st generation of Ectane®) 

2. Start/Stop an acquisition 

3. Null the probe 

4. Calibration wizard 

5. Save data (currently not functional on Reddy®, but will 
be implemented in a future version of Magnifi) 

 

 

 

Figure 4. Keypad features 

KEY CHARACTERISTICS 

Type of defect Fatigue cracking 
 (axial and transverse to weld) 
 
Conformability Conforms to weld 
 
Coverage 53 mm (2.1 in) 
 
Channels requirements 64 
 
Minimum pipe OD 25.4 mm (10 in) for circumferential scans 
 40.6 mm (16 in) for axial scans 
 
Detection capabilities Axial and transverse 
 From 3 x 0.5 mm (0.12 x 0.02 in) 
 
Sizing capabilities Axial only 
 From 12.5 x 1 mm (0.5 x 0.04 in) 
 Up to 7 mm (0.28 in) deep 
 Up to 3 mm (0.12 in) Lift-off 
 
Temperature 100 deg C (212 F) 
 
Maximum probe speed Up to 200 mm/s (7.9 in/s) 

1 

2 

3 4 

5 
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MATERIAL COMPATIBILITY 

The User Mat calibration that will be discussed later in this User guide is mainly useful to compensate for 

permeability changes which may occur during scans, either along a same part being inspected or simply, 

between alloys having different properties. Permeability changes affect signal amplitude for a given flaw, 

this is then the reason why there is a need to compensate for it, assuring accurate depth sizing on each 

individual crack. The Sharck probes were primarily designed for the assessment of surface breaking cracks 

in carbon steel material and welds. Those can also be used to derivates to a certain extend. 

Carbon steels (most of construction steels) 

• Reliable detection. 

• Reliable length and depth sizing. 

Alloy steels 

• Reliable detection 

• Reliable length sizing but possible underestimation of depth sizing (specifically Nickel based 

one). 

Note: A dedicated sizing matrix, hence setup file can be produced for specific alloys providing a 
sample with EDM notches is made available to Eddyfi. 

High strength low alloy (HSLA) steel 

• Reliable detection. 

• Reliable length and depth sizing. 

Note: Forged steels can be carbon steels, alloy steels or HSLA steels. Same capabilities as 
mentioned above. 
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MAGNIFI SETUP 

  Make sure to use Magnifi 4.4 or Magnifi GO 1.5 (or a more recent version). 

  Click Open setup  and select the setup corresponding to the probe in the Default Master List. 

  Connect the 160-pin ECA probe connector to an Ectane or Reddy unit. 

  Connect the 18-pin encoder connector to the Ectane I/O connector or the 12-pin encoder 
connector to the Reddy I/O connector. 

  For Ectane only: connect  the instrument to Magnifi. 
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DATA MANAGEMENT 

This section suggests a convenient way to manage and save automatically large amounts of data files 

during an inspection. The following steps can be done in advance in Magnifi (or Magnifi GO), before 

getting to the inspection site. 

  In the backstage of Magnifi, in the Inspection menu, select a project folder and an inspection 

folder . 

  In the Acquisition menu, select the Prefix filename option. 

  Click Create New List . 

  Select the prefix for the data file list, the number of files in the list, the index for the first data file 
and the index increment between each file. The example below shows a data file list based on the 
following parameters: 

Selected parameters: 

Resulting datafile list:Prefix: TECA 

Number of elements: 4 

Element start number: 10 

Element increment: 2 

 

Prefix Index 

TECA 010 

TECA 012 

TECA 014 

TECA 016 

  Click Create. 

  In the frontstage, in the Layout tab, make sure the Data button is checked. The data file list will 
be displayed on the left side of the screen. 

  At the bottom of the data file list, click Acquisition preferences , and check the following two 
options: 

  Automatic file recording. 

  Automatic Next on Stop Acquisition. 

When an acquisition is stopped, these two options allow to automatically save the data file and 

select the next one in the list. The user can then start the next acquisition, without any other action 

required. 

  Once the setup parameters and preferences are settled and the probe has been calibrated (see 

section 4), uncheck Setup Mode  in the Home tab. 

  In the data file list, select the first file to be acquired. The inspection can then begin. 
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A few more information about data management in Magnifi and Magnifi GO: 

• The small icon beside each data file indicates its current state: 

Icon Definition 

 The datafile was acquired and saved, but has not been analyzed yet 

 
The datafile was acquired, saved and analyzed, and it was reported as 

being defect-free 

 
The datafile was acquired, saved and analyzed, and defects have been 

reported 

 The datafile has not been acquired yet (empty file) 

   The datafile is tagged for further review 

 

For more information on data analysis, refer to section 7 of this user guide. 

• At any time during the inspection, the user can click Add data  or Delete data  at the 

bottom of the datafile list. Datafiles added with this button will keep the same prefix, and 

their index will be incremented by the number selected in the index menu . To create 

datafiles with a new prefix, go back to the backstage and click Create New List. 

• To re-scan a datafile that has already been acquired and saved, right-click on the datafile (or 

hold the Reddy’s touchscreen) and click Re-scan. To choose whether the original datafile 

should be kept or erased, select the corresponding option in Acquisition preferences . 
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LAYOUT 

1. Dp-Proc C-scan: Visualisation of axial cracks with material permeability and lift-off compensations. 
Each horizontal line corresponds to a channel of the probe. 

➔ Used to localize axial cracks indications, in combination with Lg C-scan. 

2. Dp-Raw Lissajous: Raw impedance signal of the channels underneath the cursor in the Dp-Proc. 

➔ Used for depth measurement of axial cracks. 

3. Lg C-scan: Visualisation of axial cracks ends. 

➔ Used to localize axial crack indications quickly, in combination with Dp-Proc C-scan, and size 
the cracks length. 

4. Lg Lissajous: Signal of the channels underneath the cursor in the Lg C-scan. 

5. Tr Strip chart: Superimposed strip charts of the transverse channels. 

➔ Used to detect transverse crack. 

6. Compensated Depth: Depth measurement of the axial crack, up to 7 mm (0.28 in), with 
compensation for lift-off and permeability. 

7. Length: Length measurement of the axial crack. 

8. Lift-off: Local lift-off measurement, up to 3 mm (0.12 in). 

 
Figure 5. Sharck BW / FW acquisition and analysis layout 

Note: To change the settings of any of these windows or to access the Transverse C-Scan, select it 
and go to the Current View tab. 

1 

3 

2 

4 

5 

6 7 8 
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PROBE CALIBRATION 

CALIBRATION FROM THE SHARCK MENU 

The following calibration should be performed before beginning a new inspection: 

I)  Place the probe in the air, away from any metallic surface, then click Null . 

II)  In the Sharck menu, click Calibration . 

III)  Keep the probe in the air and click . 

IV)  Put the probe in the middle of the aluminum plate supplied for calibration purposes and apply 

pressure to ensure that all wheels are in close contact with the surface, then click 
. 

Note1: For the Fillet Weld probe, make sure that the adjustable module is set flat. 

Note2: Ensure the Aluminium plate is placed away from any conductive material prior to 
performing the calibration. 

 

 
Figure 6. Sharck probes on aluminium plate 

V)  Place the probe on the weld to be inspected. 

Note: For the Fillet Weld probe, ensure the adjustable module is set correctly to the weld cap 
under assessment. 

VI)  Click  and move the probe along the weld. 

VII)  Click . 

VIII)  Close the Sharck calibration window. 
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Figure 7. Sharck probes on carbon steel weld 

CALIBRATION FROM THE PROBE KEYPAD 

It is also possible to calibrate the probe using the calibration button on the probe’s keypad. The 

overall process does not change; only the clicking operations change: 

I)  Place the probe in the air, away from any metallic surface, then press the Null button  on the 
probe. 

II)  Press the calibration button on the probe. 

III)  Put the probe in the middle of the aluminum plate (supplied for calibration purposes) and apply 
pressure to ensure that all wheels are in close contact with the surface, then press the calibration 

button on the probe. 

IV)  Place the probe on the weld to be inspected. 

V)  Press the calibration button on the probe and move the probe along the weld. 

VI)  Press the calibration button on the probe to calibrate the probe. 

VII)  Press any button on the probe to close the calibration window. 
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ACQUISITION 

BUTT WELD 

I)  Null the probe in the air. 

II)  Place the probe on the weld. Use the marker lines on top of the probe to center it on the weld, and 
the marker line on the cable side of the probe to align the x=0 position with the beginning of the 
area to scan. 

 
Figure 8. Scan position x=0 aligned with the marker line on the probe side 

III)  Start the acquisition. 

IV)  Acquire data by moving the probe along the weld following the direction indicated by the arrow on 
the top of the probe. 

V)  Stop the acquisition. 

Note1: The total scan length can be changed in Setup → Scan. 

Note2: Always Null the probe before performing an acquisition. 

FILLET WELD 

I)  Null the probe in the air. 

II)  Set the angle of the adjustable module (This can be done before step I). 

III)  Place the guiding wheels on the edge of the weld, near the bottom toe. 

X = 0 
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Figure 9. Probe guiding wheels leaning against weld toe 

IV)  Press the side wheel adjustment buttons. 

 
Figure 10. Pressing the side wheel adjustment buttons will trigger the mechanism 

V)  Align the marker line on the probe with the beginning of the area to scan. 

 
Figure 11. Scan position X=0 aligned with the marker line on the fillet weld probe 

VI)  Start the acquisition. 

VII)  Acquire data by moving the probe along the weld. 

VIII)  Stop the acquisition. 

Note: To perform a full inspection, a second pass is carried out on the wall by turning the probe 
and carrying out steps I to VII again. 

X = 0 
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ANALYSIS 

The analysis is performed in three simple steps: user material calibration, detection and sizing. 

Note: The Sharck BW and FW probes are designed to detect both axial and transverse cracks but 
only axial ones can be sized. Transverse cracking would need to the scanned axially to be fully 
assessed. 

USER MATERIAL CALIBRATION 

To compensate for the magnetic permeability of the inspected material, a "user material calibration" 

should always be performed before analyzing data. This will help with the detection of defects and will 

ensure the accuracy of the depth sizing. 

I)  Open the C-scan cursor as large as possible in the middle of the C-scan. To compensate properly, it 
is very important that every channel contains more data from clean material than from apparent 
defects within the width of the horizontal cursor (see Figure 13). 

II)  On the Dp-Raw Lissajous, verify that you are on a real channel and not an interpolated channel. If 
you are on an interpolated channel, move the cursor up and down until the channel name appear 
on the screen.  

 

 

Figure 12. Identification of a real channel. On top, the channel F1Dp07. Below, an interpolated channel, 
identified as “-” 

III)  In the Sharck menu, click the  button. 
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Figure 13. Top: Good user material calibration, with the C-scan cursor widely opened; Middle: Good user 
material calibration, cursor contains only one specific crack, but opened wide enough (at least three times 
the length of the crack) providing a local averaging; Bottom: Bad user material calibration, cursor too 
closed around the crack signal. The user material is not well measured because there is not enough safe 
material information in it, averaging mostly calculated on the crack signal. 

DETECTION OF AXIAL CRACKS 

The detection of axial cracks must be done with both Dp-Proc and Lg C-scans. The Dp-Proc C-scan detect 

a crack along its entire length, while the Lg C-scan shows its ends. 

An indication is considered as an axial crack when it presents these criteria: 

• Positive vertical signal (yellow/orange/red) in the Dp-Proc C-scan. 

• Blue and red dots in the Lg C-scan. Note that the blue dot is always to the left (first end) of 

the red dot (last end). If the red dot is to the left of the blue dot, it is not an axial crack (can 

be linked to a transverse crack or a geometrical indication). 

• Correlation between the two C-scans: The blue and red dots must be at the beginning and 

end of the yellow/orange/red signal. 
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Figure 14. Detection of axial cracks. 3 cracks detected in this example (2 deep and 1 shallow) 

On the DP-Proc C-scan, the green color represents the base material (amplitude close to 0.00 V). Crack-

like defects are associated to a positive signal that is proportional to their depth (increasing order of crack 

depth: yellow, orange, bright red, dark red). 

The color palette is a visual threshold directly related to the depth of the cracks. To enhance the contrast 

of the cracks, the color scale can be lowered manually. However, this will also enhance the noise caused 

by permeability variations, weld geometry, or other surface conditions. 

 

 
Figure 15. Same cracks displayed with 2 different color scales in Dp-Proc C-scan 

In previous version of Magnifi the Lg C-scan is not compensated for lift-off. When lift-off is detected, it is 

recommended to reduce the scale of Lg C-scan color palette to help with the detection.  

 

Color scale: ±2.50 V 

Color scale: ±1.00 
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Figure 16. Same cracks displayed with 2 different color scales in Lg C-scan 

DEPTH SIZING AND REPORTING OF AXIAL CRACKS 

Sizing information 

During the analysis of a data file, the sizing of axials cracks is shown in the lower right corner of the screen. 

This information is updated in real time as the cursor is moved in the C-scan views. 

 
Figure 17. Magnifi automatically maximise the cursor position and measure the depth of crack. Sometimes, 

there could be several blue and red dots closed to each other. The black arrows on both Dp-Proc and Lg C-scans 
show which blue and red dots are used for the crack length sizing. This can be adjusted if necessary by the user. 
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Figure 18. Length arrows on the Lg C-scan 

 

Local user material calibration: 

To improve the depth sizing of an axial crack, it is recommended to perform a local user material 

adjustement (close to the indication) before reporting it. 

I)  Click close to the crack in the Dp-Proc or Lg C-scan to center the cursors on the crack. 

II)  Open the cursors around three times the length of the defect. 

 
Figure 19. Step Position and size of the cursors on a potential axial crack 

III)  Verify that the user material calibration has been done properly around the defect (see Figure 20). 

  

Figure 20. Correct and incorrect user material calibration 

Note: When correctly applied the background of the Dp-proc C-scan is green around the defect, 
and the dashed line in the Lissajous is close to the horizontal centreline. When not applied 
correctly, two yellows stripes are seen around the crack signal, and the dashed line in the Lissajous 
is far from the horizontal centreline. 
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IV)  If the user material calibration is not correct, perform a local material calibration by clicking the 

 button without moving the cursors. 

 

Precision sizing and entry report 

I)  Use the indication code buttons in the lower right corner of the Lissajous 
window (for example “CRK” or “SCC”) to add the automatic analysis tool inside 
the region of interest. If the option “Take a screenshot with report entry” is checked in the backstage, 
a screenshot will be taken at this point. 

 
Figure 21. Add indication buttons. The indication code of the button can be changed by clicking the small 

arrow at the lower right corner of the button 

In the backstage of Magnifi, make sure the selected Table Profile in the Report options is Sharck Array. 

With this option, the report will include the measured depth, position and local lift-off. 

This will trigger two events (if the “Defect Tuning”  option is selected): 

 Data within the cursors are scanned and the cursors get centered over the indication giving the 

deepest sizing. 

 

 
Figure 22. Cursor positioning prior to (top) and after (bottom) clicking the indication button 

  The TECA Tune Calculations window opens. 

Indication buttons 
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Figure 23. TECA Tune Calculations window 

II)  In most cases, the automatic process will give the optimized results, so no adjustment is needed in 
the TECA Tune Calculations windows. However, in the rare cases that the automatic process is not 
optimal, this window gives the user the choice to adjust some parameters, making sure the sizing 
is accurate. If such a case happens, the user can manually adjust:  

i)  The baseline level, if it seems incorrect on the Lissajous. This can occur if there is a lot of 

background noise or if there is a rapid change of material properties near the crack or if the 

cursors are set too tight around the crack signal.  

 
Figure 24. Baseline level (dashed line). Set too high (1), too low (2), or correctly (3) 

ii)  The start and/or end of a crack. The start/stop position might not be correct for intermittent 

cracking but also cracking occurring at the edge of the scan. The gray arrows on the C-scans 

will move as these parameters are adjusted (Figure 18). 

I) Click “Add Entry” to add the analyzed indication in the report or click “Cancel” to close the TECA Tune 

Calculations windows without adding the indication to the report. 

Note1: If a datafile contains no defect indication, you can click  

Note2: To add or remove indication codes, go to Setup → Indication. 

DETECTION OF TRANSVERSE CRACKS 

The detection of transverse crack can rapidly be done using the TR strip chart, at the bottom of the default 

layout. Note that the TR strip chart is not compensated for the lift-off. If lift-off is detected, it is 

recommended to reduce the scale of the strip chart to avoid missing a defect. 

Too high 

Too low 
Correct 
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Figure 25. Detection of transverse cracks (four in this example) 

If you wish to see the approximated length of a transverse crack and its position, select the TR C-scan. 

 
Figure 26. Transverse cracks visible on TR C-scan 

If a transverse crack is detected an additional scan along the defect will be necessary (if the geometry 

enables it) to obtain sizing information. 
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MAINTENANCE 

PROTECTION FROM ABRASIVE SURFACES 

If the component to be inspected is abrasive or rough, it is recommended to protect the probe with a tape 

(polyolefin, Teflon or other non-conductive abrasion resistant material). If the sample has a flat surface, 

the tape can be put directly on the probe fingers. The lift-off compensation will ensure a good 

measurement even if not all fingers are in contact with the surface, as long as the lift-off is 3 mm (0.12 in) 

at most. 

 

 
Figure 27. Protective tape applied on probe active area 

If the weld cap is too high, causing a lift-off superior to 3 mm (0.12 in), it is best to put it on the sample, 

to allow the probe sensors to be in contact with the surface. 

 

 
Figure 28. Protective tape applied directly on weld 
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BUTT WELD PROBE MAINTENANCE 

When used on dirty surfaces, dust can accumulate on the encoder wheel and between the fingers. To 

clean the encoder, unscrew it with a small flathead screwdriver from the probe housing and clean it with 

a soft cloth or air spray. To clean the fingers, disassemble the removable frame to loosen the fingers and 

remove the dust between them with a soft cloth or air spray. Make sure to reassemble all the parts prior 

to carrying out further inspection.  

Figure 29. The encoder and the removable frame can be dismantled to clean the probe. Supporting 
wheels can also be remove if necessary 

 
Figure 30. With the 1st frame removed, the fingers are looser and can therefore be separated for an 

easy cleaning 

FILLET WELD PROBE MAINTENANCE 

To clean the fingers of the fillet weld probe, follow the same procedure as the one for the butt weld 

probe. Since the encoder is spring-loaded, it is not possible to remove it from the probe housing. 

 

Figure 31. Both modules have a removable frame to help the fingers cleaning 
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Figure 32. Guiding and supporting wheels can also be unscrewed if it is necessary to clean them 

 

ENCODER CALIBRATION 

If the encoder resolution included in the Magnifi setup is different from its real resolution, the data in the 

C-scan will be slightly distorted (misalignment of indications and zigzag shapes, see Figure 33 below). The 

length measurement and defect positioning can be affected. 

In such a case, a simple calibration can be performed to apply a correction factor to the encoder 

resolution: 

  Start an acquisition. 

  Move the probe in a straight line and on a flat surface and stop the acquisition. 

Note1: A longer travel distance will lead to a more precise calibration. 

Note2: It is not required to scan a metallic surface for this calibration. 

  Measure precisely the traveled distance. 

  In the Calibration menu, click on the Encoder  calibration button. 

  Enter the measured traveled distance and click Enter. 

  Click Calibrate and click OK. The correction factor is now applied to the setup configuration. 
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Figure 33. a) Before encoder calibration (small error on the encoder’s resolution); b) after encoder 

calibration 

  

Zigzag shapes due to wrong 
encoder resolution 

a) 

b) 
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Sharck™ Pencil G2 Application 

Guide 
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PROBE DESCRIPTION 

 

 

 

Figure 34 : Sharck Pencil G2 models. Straight (ST) (left), Right Angle (RA) (middle), and Toothbrush (TB) (right). 

 

MATERIAL COMPATIBILITY 

The User Mat calibration that will be discussed later in this User guide is mainly useful to compensate for 

permeability changes which may occur during scans, either along a same part being inspected or simply, 

between alloys having different properties. Permeability changes affect signal amplitude for a given flaw, 

this is then the reason why there is a need to compensate for it, assuring accurate depth sizing on each 

individual crack. The Sharck probes were primarily designed for the assessment of surface breaking cracks 

in carbon steel material and welds. Those can also be used to derivates to a certain extend. 

Carbon steels (most of construction steels) 

• Reliable detection. 

• Reliable depth sizing. 

Alloy steels 

• Reliable detection 

• Possible underestimation of depth sizing (specifically Nickel based one). 

Note: A dedicated sizing matrix, hence setup file can be produced for specific alloys providing a 
sample with EDM notches is made available to Eddyfi. 

High strength low alloy (HSLA) steel 

• Reliable detection. 

• Reliable depth sizing. 

Note: Forged steels can be carbon steels, alloy steels or HSLA steels. Same capabilities as 
mentioned above. 
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SETUP 

I) Make sure to use Magnifi® 4.3 or Magnifi® GO 1.4 (or a more recent version). 

II) Click Open setup  and select the setup corresponding to the probe in the Default Master List. 

III) Connect the pencil probe to the Ectane® 41-pin connector or to the Reddy® 19-pin connector. 

IV) For Ectane® only: connect  the instrument to Magnifi®. 

 

DATA MANAGEMENT 

This section suggests a convenient way to manage and save automatically large amounts of data files 

during an inspection. The following steps can be done in advance in Magnifi (or Magnifi GO), before 

getting to the inspection site. 

 In the backstage of Magnifi, in the Inspection menu, select a project folder and an inspection folder 

. 

 In the Acquisition menu, select the Prefix filename option. 

 Click Create New List . 

 Select the prefix for the data file list, the number of files in the list, the index for the first data file 

and the index increment between each file. The example below shows an example of data file list 

based on the following parameters: 

 Selected parameters:  Resulting data file list :  

 Prefix: TECA  Prefix Index  

 Number of elements: 4  TECA 010  

 Element start number: 10  TECA 012  

 Element increment: 2  TECA 014  

    TECA 016  

 Click Create 

 In the frontstage, in the Layout tab, make sure the Data button is checked. The data file list will be 

displayed on the left side of the screen. 

 At the bottom of the data file list, click Acquisition preferences , and check the following two 

options: 

Automatic file recording 

Automatic Next on Stop Acquisition 
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When an acquisition is stopped, these two options allow to automatically save the data file and select 

the next one in the list. The user can then start the next acquisition, without any other action required. 

 Once the setup parameters and preferences are settled and the probe has been calibrated (see 

section 4), uncheck Setup Mode  in the Home tab. 

 In the data file list, select the first file to be acquired. The inspection can then begin. 

A few more information about data management in Magnifi and Magnifi GO: 

• The small icon beside each data file indicates its current state: 

Icon Definition 

 
The data file was acquired and saved, but has not been analyzed yet 

 
The data file was acquired, saved and analyzed, and it was reported as 

being defect-free 

 
The data file was acquired, saved and analyzed, and defects have been 

reported 

 The data file has not been acquired yet (empty file) 

   
The data file is tagged for further review 

 

For more information on data analysis, refer to section 0 of this user guide. 

• At any time during the inspection, the user can click Add data  or Delete data  at the 

bottom of the data file list. Data files added with this button will keep the same prefix, and their 

index will be incremented by the number selected in the index menu . To create data files 

with a new prefix, go back to the backstage and click Create New List. 

 

• To re-scan a data file that has already been acquired and saved, right-click the data file (or hold 

the Reddy’s touchscreen) and click Re-scan. To choose whether the original data file should be 

kept or erased, select the corresponding option in Acquisition preferences . 
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LAYOUT 

1. Dp-Proc strip chart: Visualisation of axial cracks with material permeability and lift-off compensations. 

o Used to localize axial cracks indications quickly, in combination with Lg strip chart 

2. Lg strip chart: Visualisation of axial cracks ends 

o Used to localize axial crack indications quickly, in combination with Dp-Proc strip chart, and 
size the axial cracks length 

3. Dp-Raw Lissajous: Raw impedance signal within the cursor of the strip charts. 

o Used for depth measurement of axial cracks  

4. Compensated Depth: Depth measurement of the axial crack, up to 7 mm, with compensation for lift-
off and permeability. 

5. Length: Length approximation of the axial crack 

o The length approximation is based on the manual scan speed. To be accurate, the scan must 
be done at exactly 50 mm/s. 

6. Lift-off: Local lift-off measurement, up to 4 mm 

7. Lg Lissajous: Signal of the Lg channel within the cursors of the strip chart. 

   

Figure 35 : Acquisition and analysis layout 

 

  

1 

2 

3 

5 6 4 

7 



628 

 

PROBE CALIBRATION 

I) Place the probe in the air, away from any metallic surface, then click on Null  

II) In the Sharck menu, click Calibration  

III) Keeping the probe in the air, click on  

IV) Put the probe in the middle of the aluminum plate supplied for calibration purposes 

Note1: Place the probe in the center of the Aluminium plate with the tip flat on the surface 

Note2: Ensure the Aluminium plate is placed away from any conductive material prior to 
performing the calibration. 

V) Click on  

 

Figure 36: Sharck pencil probe on the aluminum plate 

VI) Place the probe on the material to be inspected. 

VII) Click on  and move the probe on the material.  

Note: During this calibration step, keep the probe flat on the surface, in the HAZ. 

VIII) Click on . 

IX) Close the Sharck calibration window. 
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ACQUISITION 

I) Null the probe in the air. 

II) Place the probe on the weld. 

   

Figure 37 : Probe tip position on the weld. Flat on in the HAZ (left), with an angle on the toe (center), and flat of the 
top of the weld (right). 

III) Start the acquisition. 

IV) Scan the weld with the probe so that the long side of the tip of the probe is parallel to the weld, in the 

direction of the arrow featured on the pencil’s casing. 

Note: Scanning speed should be approximately 50 mm/sec (2 in/sec) 

Note: It is recommended to do two scans on the toe. The first scan with the tip flat on the surface, 
in the HAZ, leaning on the toe of the weld. The second scan with the tip at mid-angle between the 
weld and the HAZ. 

V) Stop the acquisition 

Note1: Always Null the probe before performing an acquisition. 

Note2: To detect transverse cracks on the top of the weld turn the probe 90° 

 

Figure 38 : Probe tip position for the detection of transverse cracks. 
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ANALYSIS 

The analysis is performed in three simple steps: user material calibration, detection, and sizing. 

USER MATERIAL CALIBRATION 

To compensate for the magnetic permeability of the inspected material, a "global user material 

calibration" should always be performed before analyzing data, to help with the detection of defects. A 

"local user material calibration" will ensure the accuracy of the depth sizing (see section 0). 

I) For a global calibration, open the strip chart cursor as large as possible in the middle of the Dp-Proc 

strip chart. To compensate properly, it is very important that the signal within the cursors contains 

more data from clean material than from apparent defects or lift-off. 

II) In the Sharck menu, click the  button. 

   

   

   

Figure 39 : Top: Good user material calibration, with the C-scan cursor widely opened; Middle: Good user material 
calibration, cursor contains only one specific crack, but opened wide enough (at least three times the length of the 
crack) providing a local averaging; Bottom: Bad user material calibration, cursor too closed around the crack signal. 

The user material is not well measured because there is not enough safe material information in it, averaging 
mostly calculated on the crack signal. 

DETECTION OF AXIAL CRACKS 

The detection of axial cracks is made using both the Dp-Proc and the Lg strip charts. The Dp-Proc strip 

chart shows the depth of the crack, while the Lg strip chart shows its beginning and end. To be certain 

that an axial crack is present, it must meet these criteria: 

- Positive peak in the Dp-Proc strip chart. 
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- Negative and positive peaks in the Lg strip chart. Note that the negative peak is always to the left 
of the positive peak. If the positive peak is to the left of the negative peak, it is not an axial crack 
(can be linked to a transverse crack or a geometrical indication). 

- Correlation between the two strip charts : The negative and positive peaks in the Lg strip chart 
must be at the beginning and end of the positive peak in the Dp-Proc strip chart 

 

Figure 40: Detection of axial cracks. The ends of the crack are correlated on both strip charts.  

 

DEPTH SIZING AND REPORTING OF AXIAL CRACKS 

SIZING INFORMATION 

During the analysis of a data file, the sizing of axials cracks is shown between the two Lissajous. This 

information is updated in real time as the cursor is moved in the strip charts. 

   

Figure 41 : Example of sizing information displayed in the infodields. In this example, the 

compensated depth of the crack is 4.4 mm, the length is 11.3 mm and the lift-off is 0.1 mm. 

 

LOCAL USER MATERIAL CALIBRATION 

To improve the depth sizing of an axial crack, it is recommended to perform a local user material 

adjustement (on or close to the indication) before reporting it. 

III) Click on the crack in the Dp-Proc or Lg strip chart to center the cursors on the crack. 

IV) Open the cursors to at about three times the length of the defect. 
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Figure 42 : Position and size of the cursors on a potential axial crack 

V) Verify that the user material calibration has been done properly around the defect. 

 
 

 
 

Figure 43 : Good vs bad user material calibration. On the top (good calibration), the dashed line in the Lissajous is 
near the horizontal null mark line. On the right (bad calibration), the dashed line in the Lissajous is far from the 

horizontal null mark line. 

VI) If the user material calibration is not correct, perform a local material calibration by clicking the 

 button without moving the cursors. 

 

PRECISION SIZING AND ENTRY REPORT 

VII) Click on one of the indication buttons in the lower right corner of the Lissajous (“CAPC” written in red 

in Figure 44). This will open the TECA Tune Calculations window (Figure 45) 
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Figure 44: Indication buttons in the Lissajous window 

 

Figure 45: TECA Tune Calculations window 

VIII) In most cases, the automatic process will give the optimized results, so no adjustment is needed in 

the TECA Tune Calculations windows. However, in the rare cases that the automatic process is not 

optimal, this window gives the user the choice to adjust some parameters, making sure the sizing is 

accurate. If the baseline seems incorrect on the Lissajous, the user can manually adjusts it. This can 

occurs if there is a lot of background noise or if there is a rapid change of material properties near 

the crack or if the cursors are set too tight around the crack signal.  

 
  

Figure 46 : The baseline level (dashed line). It can be too high (left), too low (middle), or spot on (right).  

IX) Click on “Add Entry” to add the analyzed indication in the report or click on “Cancel” to close the TECA 

Tune Calculations windows without adding indication to the report. 

Note1: If a datafile contains no defect indication, you can click  

Note2: To add or remove indication codes, go to Setup → Indication. 

Indication buttons 

Too high 
Too low 

Correct 
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MAINTENANCE 

If the component to be inspected is abrasive or rough, it is recommended to protect the probe with a tape 

(polyolefin, Teflon or other non-conductive abrasion resistant material). However, make sure to remove 

the tape before a full calibration (section 0) 
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Sharck-HR Application Guide 
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PROBE DESCRIPTION 

SHARCK HR 

1. Scan direction 

2. Buttons for curvature adjustment 

3. Paired encoded wheels 

4. Flexible shoe with protective 0.125 mm (4.9 thou) polyolefin tape 

5. Beginning of coverage mark (Y = 0.0 mm (0.0 in)) 

6. End of coverage mark (Y = 71.2 mm (2.80 in)) 

 

 

 

 

Figure 47. Sharck HR features 
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KEY CHARACTERISTICS 

Type of defect Short and shallow cracking 
 (longitudinal to scan axis) 
 
Conformability Conforms to curvature 
 From 254 mm (10 in) 
 
Coverage 71 mm (2.8 in) 
 
Channels requirements 64 
 
Resolution 1 to 2 mm (0.04 to 0.08 in) axially 
 3 mm (0.12 in) circumferentially 
 
Detection capabilities Axial only 
 From 1.5 x 0.25 mm (0.06 x 0.01 in) 
 
Sizing capabilities Axial only 
 From 6 x 0.25 mm (0.06 x 0.01 in) 
 Up to 3 mm (0.12 in) deep 
 Up to 2 mm (0.08 in) Lift-off 
 
Temperature 100 degC (212 F) 
 
Maximum probe speed Up to 600 mm/s (24 in/s) 
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MATERIAL COMPATIBILITY 

The User Mat calibration that will be discussed later in this User guide is mainly useful to compensate for 

permeability changes which may occur during scans, either along a same part being inspected or simply, 

between alloys having different properties. Permeability changes affect signal amplitude for a given flaw, 

this is then the reason why there is a need to compensate for it, assuring accurate depth sizing on each 

individual crack. The Sharck HR probe was primarily designed for the assessment of surface breaking 

cracks in alloy steels.  

Alloy steels 

• Reliable detection. 

• Reliable length and depth sizing. 

Note: It can currently be used on Grade B, X42, X46, X52, X56 and X60. 

 

 

MAGNIFI SETUP 

I)  Make sure to use Magnifi 4.4 or Magnifi GO 1.5 (or a more recent version). 

II)  If the probe is being used for the first time, click Open setup  and select the file SHARCK-HR-1048-
071 from the Default Master List. 

III)  Connect the 160-pin ECA probe connector to an Ectane® or Reddy®. 

IV)  Connect the 18-pin encoder to the Ectane I/O connector, or the 12-pin encoder to the Reddy I/O 
connector. 

V)  For Ectane only: connect the instrument to Magnifi .  
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DATA MANAGEMENT 

This section suggests a convenient way to manage and save automatically large amounts of datafiles 

during an inspection. The following steps can be done in advance in Magnifi (or Magnifi GO), before 

getting to the inspection site. 

X)  In the backstage of Magnifi, in the Inspection menu, select a project folder and an inspection folder 

. 

XI)  In the Acquisition menu, select the Prefix filename option. 

XII)  Click Create New List.  

XIII)  Select the prefix for the datafile list, the number of files in the list, the index for the first datafile 
and the index increment between each file. The example below shows an example of datafile list 

based on the following parameters:Selected parameters: 

Resulting datafile list:Prefix: SCC 

Number of elements: 4 

Element start number: 10 

Element increment: 2 

 

Prefix Index 

SCC 010 

SCC 012 

SCC 014 

SCC 016 

XIV)  Click Create 

XV)  In the frontstage, in the Layout menu, make sure the Data button is checked. The datafile list will 
be displayed on the left side of the screen. 

XVI)  At the bottom of the datafile list, click Acquisition preferences , and check the following two 
options: 

i)  Automatic file recording 

ii)  Automatic Next on Stop Acquisition 

When an acquisition is stopped, these two options allow to automatically save the datafile and 

select the next one in the list. The user can then start the next acquisition, without any other action 

required. 

XVII)  Once the setup parameters and preferences are settled and the probe has been calibrated (see 

section 4), uncheck Setup Mode  in the Home menu. 

XVIII)  In the datafile list, select the first file to be acquired. The inspection can then begin. 

A few more information about data management in Magnifi and Magnifi GO: 
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• The small icon beside each datafile indicates its current state: 

Icon Definition 

 The datafile was acquired and saved, but has not been analyzed yet 

 
The datafile was acquired, saved and analyzed, and it was reported as 

being defect-free 

 
The datafile was acquired, saved and analyzed, and defects have been 

reported 

 The datafile has not been acquired yet (empty file) 

   The datafile is tagged for further review 

 

For more information on data analysis, refer to section 7 of this user guide. 

• At any time during the inspection, the user can click Add data  or Delete data  at the 

bottom of the datafile list. Datafiles added with this button will keep the same prefix, and 

their index will be incremented by the number selected in the index menu . To create 

datafiles with a new prefix, go back to the backstage and click Create New List. 

• To re-scan a datafile that has already been acquired and saved, right-click on the datafile (or 

hold the Reddy’s touchscreen) and click Re-scan. To choose whether the original datafile 

should be kept or erased, select the corresponding option in Acquisition preferences . 
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LAYOUT 

1. Processed C-Scan: Visualization of the cracks with material permeability and lift-off compensations. 
Each horizontal line corresponds to a channel of the probe 

➔ Used to localize crack indications quickly 

2. Processed strip chart: Superimposed strip charts, each of them representing 1 of the probe’s 64 
channels 

➔ Used to display the profile of the cracks, measure their length and localize the strongest 
indications (deepest cracks) 

3. Lissajous window: Raw impedance signal of the channels underneath the cursor in the C-scan 

➔ Used for depth measurement of axial cracks. 

4. Compensated depth: Depth measurement of axial cracks, up to 3 mm (0.12 in), with compensation 
for lift-off and permeability 

5. Lift-off: Local lift-off measurement, up to 2 mm (0.08 in) 

 

Figure 48. Sharck HR acquisition and analysis layout 

Note: To change the settings of any of these windows, select it and go to the Current View menu. 

•  

1 

2 

3 

4 5 
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PROBE CALIBRATION 

The following calibration should be performed before beginning a new inspection: 

I)  Hold the probe in the air, and press on the 2 buttons for curvature adjustment to make sure the 
flexible shoe is completely flattened. 

II)  Hold the probe in the air, away from any metallic surface, and click Null . 

III)  In the Sharck menu, click Calibration . 

IV)  Keep the probe in the air and click  

V)  Put the probe in the middle of the aluminum plate supplied with the probe and apply pressure to 

ensure that all four wheels are in close contact with the surface. Click . 

VI)  Press the 2 side buttons to lock the spring-load mechanism. Then, hold the probe on the pipe’s 
surface by applying a very light pressure on it. This will curve the shoe to the OD of the pipe. 

VII)  Release the buttons. If the mechanism seems to block, try the last step again by applying a lighter 
pressure on the probe. Make sure the shoe is now curved correctly. 

VIII)  Put the probe on the carbon steel surface and apply pressure to ensure that all four wheels are in 

close contact with the surface. Click . 

IX)  Click . 

X)  Close the Sharck calibration window. 

 
Figure 49. The three probe calibration steps 
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ACQUISITION 

I)  Use the buttons on the probe to adjust the curvature of the flexible shoe according to the surface to 
inspect (see steps VI and VII in section 6). 

II)  Null the probe in air. 

III)  Align the front surface of the probe with the beginning of the area to scan. 

 
Figure 50. Scan position x=0 aligned with the front of the probe 

IV)  Start the acquisition. 

V)  Move the probe in the direction indicated by the arrow on the casing. Apply enough pressure on 
the probe during the acquisition to make sure that all wheels are rolling at all time. Data acquisition 
will be disabled if the encoded wheels are not rolling. 

VI)  Stop the acquisition. 

Note: The total scan length can be changed in Setup → Scan. 

 

  

Start of scan 
X = 0 
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ANALYSIS 

The analysis is performed in three simple steps: user material calibration, detection and sizing. 

Note: The Sharck HR is designed specifically to detect and measure the depth of cracks oriented 
along the axis of the pipe. Other crack orientations can be detected, but the accuracy of their 
depth measurement will not be accurate.  

USER MATERIAL CALIBRATION 

To compensate for the magnetic permeability of the inspected material, a “user material calibration” 

should always be performed before analyzing data. This will help with the detection of defects and with 

the accuracy of the depth sizing. 

 

Note: If a C-scan contains multiple SCC colonies, a user material calibration should be performed 
locally for each colony, in order to always compensate for the local permeability. 

I)  Place the C-scan cursor on a “clean” area of the C-scan (i.e. area without any SCC, corrosion or major 
permeability variations). Open the horizontal cursor in a way to include only clean material on all 64 
channels of the C-scan. If possible, this clean area should be located near the SCC indications to 
analyze. 

Alternatively, place the cursor directly on the SCC indications to analyze, and extend the width of 
the cursor to include clean material on both sides of the SCC. 

The data points inside the horizontal cursor will be used to evaluate the material permeability on 
every individual channel. To compensate properly, it is very important that every channel contains 
more data from clean material than from SCC within the width of the horizontal cursor. 

Figure 13 on next page shows a few examples of correct and incorrect C-scan cursor positioning for 
the user material calibration.   

II)  In the Sharck menu, click on  
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Figure 51. Top: Good user material calibration, with the C-scan cursor located in a clean, defect-free area 
directly besides a SCC colony; Middle: Good user material calibration, with the cursor located on the SCC 
colony, and opened wide enough to include more clean material than SCC indications on all channels; 
Bottom: Bad user material calibration. The top half of the C-scan is calibrated correctly because the area 
within the width of the horizontal cursor is mostly clean, but the bottom half of the C-scan contains mostly 
SCC indications within this width. The white color in these channels is an indication of a bad user material 
calibration. 

In the rare situations where SCC indications cover most of the C-scan, it may be impossible to place the 

cursor in a way to have clean material on all channels. Figure 52 on next page shows an example of such 

a situation. 

In these cases, the ideal solution is to re-scan the area, this time including clean material before or after 

the SCC colonies. If re-scanning is not possible, the other alternative is to perform multiple partial user 

material calibrations: 

III)  Adjust the vertical cursor to cover only the channels on which to perform the partial user material 
calibration. Adjust the horizontal cursor to cover clean material on these channels. 

IV)  In the Calibration menu, select System . Then click C-scan, CursorUserMat, Click-on , and 
Calibrate. 
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V)  Repeat steps I and II in a different area, until the user material calibration has been performed on 
all channels: 

 

Figure 52. Example of data without any area with clean material on all channels. Three partial user 
material calibrations are required to calibrate all channels. 

DETECTION OF AXIAL CRACKS 

The detection of cracks is done mainly using the Processed C-Scan, in which the lift-off is automatically 

compensated. 

The green color represents the base material (amplitude close to 0.00 V). Cracks and crack-like defects 

are associated to a positive signal that is proportional to their depth (in increasing order of crack depth: 

yellow, orange, bright red, dark red). Areas of corrosion with missing material are generally associated to 

a negative signal and displayed in white in the C-scan: 

  

Partial user material calibration #1: clean 
material on channels 1 through 17 

Partial user material calibration #2: clean 
material on channels 18 through 26 

Partial user material calibration #3: clean 
material on channels 27 through 64 
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Figure 53. Processed C-scan used for the detection of cracks 

The color palette is a visual threshold directly related to the depth of the cracks. To enhance the contrast 

of the cracks, the color scale can be lowered manually. However, this will also enhance the noise caused 

by corrosion, permeability variations or other surface conditions. For most typical cases of stress corrosion 

cracking (SCC), the color scale should be adjusted between ±0.50 V and ±2.00 V for optimal results. 

    
Figure 54. Same crack displayed with 2 different color scales 

The strip chart below the C-scan represents a cross-section (side-view) of the C-scan. It can be used to 

visualize the depth profile of the cracks. The options to display a single channel, all channels inside the C-

scan vertical cursor, or all 64 channels are available in the Current View menu. 

 
Figure 55. Strip chart window displaying all 64 channels from the C-scan in Figure 14 

Axial cracking 
indications Deepest point (dark 

red) 

White area 
(corrosion) 

Color scale: ±0.50 V Color scale: ±1.50 V 
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DEPTH SIZING AND REPORTING OF AXIAL CRACKS 

Magnifi contains a powerful analysis tool that allows the automatic localization and depth sizing 

of the deepest crack within a given SCC colony. To facilitate its use, make sure the Defect Tuning 

button in the Sharck menu is left unchecked. 

The software uses the area delimited by the C-scan cursor as the region of interest for the 

detection of the deepest crack indication. Simply by changing the position and size of the cursor, the user 

can choose to localize and measure the deepest indication either in an entire SCC colony, or to focus only 

on a sub-area of a colony. The position of the deepest crack within the cursor area is automatically 

indicated by a double triangle : 

 
Figure 56. Magnifi will localize and measure the depth of the deepest crack within a) the entire SCC colony; 
b) only the lower-left section of the colony. For the situation in b), the analysis tool can be used multiple 
times to localize and measure individually the deepest cracks within the other sub-colonies. 

Before analyzing either an entire SCC colony or a smaller sub-colony, Magnifi needs to define a reference 

baseline in order to measure the maximum signal amplitude within the region of interest and convert it 

into a depth measurement. This reference baseline is displayed as a horizontal dashed line in the Lissajous 

and the strip chart windows. It is obtained from the “clean” (i.e. defect free) material surrounding the 

cracks. 

Defining the baseline correctly is key to obtain an accurate depth sizing of the cracks. To achieve this, 

Magnifi offers two different options: 

I) Automatic baseline calculation: 

To use this option, go to the Sharck menu and make sure the Lock Baseline button is 

left unchecked.  

The baseline calculation requires that the horizontal C-scan cursor is opened large 

enough to include clean material on both sides of the SCC colony. The signal from this 

clean material forms the “root” of the cracks signal in the Lissajous.  

The width of the cursor should be at least twice that of the colony. This will allow Magnifi to define 

the reference baseline with the data points from the clean surface. If the horizontal cursor is not 

Deepest 
indication 

Deepest 
indication 
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opened large enough, Magnifi will use signal from SCC to define the baseline, which will lead to an 

under-sizing of the crack’s depth. 

 

 
Figure 57. a) The horizontal cursor includes enough clean material on both sides of the SCC indication, 
allowing a correct baseline calculation and an accurate depth sizing of the crack (0.8 mm (31.5 thou)); b) 
Horizontal cursor too narrow, leading to an incorrect baseline calculation and major under-sizing of the 
crack’s depth (0.2 mm (7.9 thou)). 

II) Manual baseline adjustment: 

To use this option, go to the Sharck menu and make sure the Lock Baseline button is 

checked (grayed).  

The manual baseline adjustment is particularly useful to analyze large SCC colonies 

without much clean material surrounding the indications. Locking the baseline ensures 

that Magnifi never recalculates the baseline: it will stay at the same level in the Lissajous, 

independantly of the C-scan cursor’s position and size. The user is responsible of adjusting it by 

dragging it manually in the Lissajous window. 

 

a) 

b) 

Correct baseline 

Incorrect baseline 

(too high) 



650 

 

 

 
Figure 58. Step one: place the cursor on a clean area and adjust the position of the baseline on the “clean” 
signal by dragging it in the Lissajous; Step two: move the C-scan cursor on the indication to be measured. 
The baseline level will remain unchanged and the depth sizing will be accurate as long as the baseline is 
not moved again. 

To the more practiced users, Eddyfi recommends to always keep the baseline locked and adjust it 

manually before reporting an indication (option II). When analyzing a large area or a large SCC colony, it 

is important to make sure that the baseline level remains the same within the whole area covered by the 

C-scan cursor. For that reason, it is recommended to analyze smaller sub-colonies individually, and adjust 

the baseline manually each time. This will lead to more accurate depth measurements. 

Finally, the presence of corrosion or strong variations of permeability can make the baseline more difficult 

to adjust. In these cases, the stripchart below the C-scan can be of great help: 

 
Figure 59. Using the strip chart view can be useful to position the baseline at the right level. 

  

Step 1 

Baseline on clean signal 

Step 2 

Baseline level remains 

unchanged 

Baseline aligned with the base of the 
signal 
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In summary, the procedure to measure the depth of axial cracks and add them to the report goes as 

follows: 

I) Place the cursor on the SCC indication to be measured, and adjust its size to cover only the region 
of interest (either an entire SCC colony or a smaller sub-area); 

Note: If a datafile contains no defect indication, you can click  

II) Make sure the baseline is correctly adjusted (either automatically or manually); 

III) Use the indication code buttons in the lower right corner of the Lissajous 
window (for example “CRK” or “SCC”) to add the automatic analysis tool 
inside the region of interest. If the option “Take a screenshot with report entry” is checked in the 
backstage, a screenshot will be taken at this point. 

Note: To add or remove indication codes, go to Setup → Indication. 

In the backstage of Magnifi, make sure the selected Table Profile in the Report options is Sharck Array. 

With this option, the report will include the measured depth, position and local lift-off. See below an 

example of the information reported in the case of an analysis by individual SCC sub-colonies: 

 
Figure 60. Summary table displayed on the first page of the report, containing information about all the 
defects that were reported in the current inspection. This is usually followed by individual screenshots 
and information of all the reported defects. 
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LENGTH MEASUREMENT OF AXIAL CRACKS 

The Sharck HR does not automatically measure the length of the cracks. However, it can be measured 

manually: 

I)  In the C-scan, put the cursor on the axial crack to be measured 

II)  In the strip chart, adjust the width of the cursor to the length of the crack’s signal 

III)  The center position of the cursor (X and Y) is displayed at the bottom of the screen. It corresponds 
to the position of the crack relatively to the beginning of the scan. 

IV)  The aperture of the horizontal cursor (Δx) is also displayed at the bottom of the screen. It 
corresponds to the length of the crack. 

 
Figure 61. Position and length measurement of an axial crack 

In a similar way, the size of SCC colonies can be measured by opening the horizontal and vertical C-scan 

cursors around it: 

Figure 62. Measurement of a SCC colony 

Indication to measure 

Crack length (Δx) 

Correct cursor adjustment 

Crack X and Y position 

Colony’s length 

Colony’s width 



653 

 

MAINTENANCE 

To protect the probe from eventual damage and to ensure an accurate lift-off monitoring, the probe 

should always be used with a 0.125 mm (4.9 thou) thick polyolefin layer covering its shoe. 

When used on very rough surfaces, this protective polyolefin layer can wear out rapidly. Make sure to 

replace it before the probe gets damaged. 

Five replacement layers are provided with the probe. If a different material is used, it should be 0.125 mm 

(4.9 thou) thick. A layer with a different thickness will lead to inaccurate lift-off measurements, and 

possibly to signal saturation. 

 
Figure 63. Sharck HR with protective polyolefin layer and 5 spare parts 

Note: When storing the probe, it is recommended to set the probe shoe flat. 
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ENCODER CALIBRATION 

If the encoder resolution included in the Magnifi setup is different from its real resolution, the data in the 

C-scan will be slightly distorted (misalignment of indications and zigzag shapes, see Figure 33 below). The 

length measurement and defect positioning can be affected. 

In such a case, a simple calibration can be performed to apply a correction factor to the encoder 

resolution: 

I)  Start an acquisition. 

II)  Move the probe in a straight line and on a flat surface and stop the acquisition. 

Note1: A longer travel distance will lead to a more precise calibration. 

Note2: It is not required to scan a metallic surface for this calibration. 

III)  Measure precisely the traveled distance. 

IV)  In the Calibration menu, click on the Encoder  calibration button. 

V)  Enter the measured traveled distance and click Enter. 

VI)  Click Calibrate and click OK. The correction factor is now applied to the setup configuration. 

 
Figure 64. a) Before encoder calibration (small error on the encoder’s resolution); b) after 

 

 

Zigzag shapes due to wrong 
encoder resolution 

a) 

b) 


